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EKTRON, INC. SOFTWARE LICENSE AGREEMENT

** READ THIS BEFORE LOADING SOFTWARE**

YOUR RIGHT TO USE THE PRODUCT DELIVERED IS SUBJECT TO THE TERMS AND CONDITIONS SET OUT IN THIS LICENSE 
AGREEMENT. USING THIS PRODUCT SIGNIFIES YOUR AGREEMENT TO THESE TERMS. IF YOU DO NOT AGREE TO THIS SOFTWARE 
LICENSE AGREEMENT, DO NOT DOWNLOAD.

CUSTOMER should carefully read the following terms and conditions before using the software program(s) contained herein (the “Software”). 
Downloading and/or using the Software or copying the Software onto CUSTOMER’S computer hard drive indicates CUSTOMER’S acceptance of 
these terms and conditions. If CUSTOMER does not agree with the terms of this agreement, CUSTOMER should not download. 

Ektron, Inc. (“Ektron”) grants, and the CUSTOMER accepts, a nontransferable and nonexclusive License to use the Software on the following 
terms and conditions: 

        1.   Right to use: The Software is licensed for use only in delivered code form. Each copy of the Software is licensed for use only on a single 
URL. Each license is valid for the number of seats listed below (the “Basic Package”). Any use of the Software beyond the number of authorized 
seats contained in the Basic Package without paying additional license fees as provided herein shall cause this license to terminate. Should 
CUSTOMER wish to add seats beyond the seats licensed in the Basic Package, the CUSTOMER may add seats on a block basis at the then 
current price for additional seats (see product pages for current price). The Basic Packages are as follows: 

Ektron CMS100 — Licensed for ten seats (10 named users) per URL.

Ektron CMS200 — Licensed for ten seats (10 named users) per URL. 

Ektron CMS300 — Licensed for ten seats (10 named users) per URL. 

Ektron CMS400.NET — Licensed for ten seats (10 named users) per URL. 

Ektron eWebEditPro — Licensed for ten seats (10 named users) per URL. 

Ektron eWebEditPro+XML — Licensed for ten seats (10 named users) per URL.

For purposes of this section, the term “seat” shall mean an individual user provided access to the capabilities of the Software.

The CUSTOMER may not modify, alter, reverse engineer, disassemble, or decompile the Software. This software product is licensed, not sold.

        2.   Duration: This License shall continue so long as CUSTOMER uses the Software in compliance with this License. Should CUSTOMER 
breach any of its obligations hereunder, CUSTOMER agrees to return all copies of the Software and this License upon notification and demand by 
Ektron.

        3.   Copyright: The Software (including any images, “applets,” photographs, animations, video, audio, music and text incorporated into the 
Software) as well as any accompanying written materials (the “Documentation”) is owned by Ektron or its suppliers, is protected by United States 
copyright laws and international treaties, and contains confidential information and trade secrets. CUSTOMER agrees to protect the confidentiality 
of the Software and Documentation. CUSTOMER agrees that it will not provide a copy of this Software or Documentation nor divulge any 
proprietary information of Ektron to any person, other than its employees, without the prior consent of Ektron; CUSTOMER shall use its best efforts 
to see that any user of the Software licensed hereunder complies with this license.

        4.   Limited Warranty: Ektron warrants solely that the medium upon which the Software is delivered will be free from defects in material and 
workmanship under normal, proper and intended usage for a period of three (3) months from the date of receipt. Ektron does not warrant the use 
of the Software will be uninterrupted or error free, nor that program errors will be corrected. This limited warranty shall not apply to any error or 
failure resulting from (i) machine error, (ii) Customer's failure to follow operating instructions, (iii) negligence or accident, or (iv) modifications to the 
Software by any person or entity other than Company. In the event of a breach of warranty, Customer’s sole and exclusive remedy, is repair of all 
or any portion of the Software. If such remedy fails of its essential purpose, Customer’s sole remedy and Ektron’s maximum liability shall be a 
refund of the paid purchase price for the defective Products only. This limited warranty is only valid if Ektron receives written notice of breach of 
warranty within thirty days after the warranty period expires.

        5.   Limitation of Warranties and Liability: THE SOFTWARE AND DOCUMENTATION ARE SOLD “AS IS” AND WITHOUT ANY 
WARRANTIES AS TO THE PERFORMANCE, MERCHANTIBILITY, DESIGN, OR OPERATION OF THE SOFTWARE. NO WARRANTY OF 
FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. EXCEPT AS DESCRIBED IN SECTION 4, ALL WARRANTIES EXPRESS AND 
IMPLIED ARE HEREBY DISCLAIMED.

NEITHER COMPANY NOR ITS SUPPLIERS SHALL BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF BUSINESS OR GOODWILL, LOSS 
OF DATA OR USE OF DATA, INTERRUPTION OF BUSINESS NOR FOR ANY OTHER INDIRECT, SPECIAL, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY KIND UNDER OR ARISING OUT OF, OR IN ANY RELATED TO THIS AGREEMENT, HOWEVER, 
CAUSED, WHETHER FOR BREACH OF WARRANTY, BREACH OR REPUDIATION OF CONTRACT, TORT, NEGLIGENCE, OR OTHERWISE, 
EVEN IF COMPANY OR ITS REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS.



         6.   Miscellaneous: This License Agreement, the License granted hereunder, and the Software may not be assigned or in any way transferred 
without the prior written consent of Ektron. This Agreement and its performance and all claims arising from the relationship between the parties 
contemplated herein shall be governed by, construed and enforced in accordance with the laws of the State of New Hampshire without regard to 
conflict of laws principles thereof. The parties agree that any action brought in connection with this Agreement shall be maintained only in a court 
of competent subject matter jurisdiction located in the State of New Hampshire or in any court to which appeal therefrom may be taken. The parties 
hereby consent to the exclusive personal jurisdiction of such courts in the State of New Hampshire for all such purposes. The United Nations 
Convention on Contracts for the International Sale of Goods is specifically excluded from governing this License. If any provision of this License is 
to be held unenforceable, such holding will not affect the validity of the other provisions hereof. Failure of a party to enforce any provision of this 
Agreement shall not constitute or be construed as a waiver of such provision or of the right to enforce such provision. If you fail to comply with any 
term of this License, YOUR LICENSE IS AUTOMATICALLY TERMINATED. This License represents the entire understanding between the parties 
with respect to its subject matter.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, THAT YOU UNDERSTAND THIS AGREEMENT, AND UNDERSTAND 
THAT BY CONTINUING THE INSTALLATION OF THE SOFTWARE, BY LOADING OR RUNNING THE SOFTWARE, OR BY PLACING OR 
COPYING THE SOFTWARE ONTO YOUR COMPUTER HARD DRIVE, YOU AGREE TO BE BOUND BY THIS AGREEMENT’S TERMS AND 
CONDITIONS. YOU FURTHER AGREE THAT, EXCEPT FOR WRITTEN SEPARATE AGREEMENTS BETWEEN EKTRON AND YOU, THIS 
AGREEMENT IS A COMPLETE AND EXCLUSIVE STATEMENT OF THE RIGHTS AND LIABILITIES OF THE PARTIES. 

Copyright 1999 - 2005 Ektron, Inc. All rights reserved.

LA10031, Revision 1.5

Trademarks

All terms in this manual that are known to be trademarks have been capitalized. Ektron, Inc. cannot attest to the accuracy of this information. Use 
of a term in this manual does not affect the validity of any trademark.

The following trademarks might appear in Ektron manuals:

Active Directory®, ActiveX®, Authenticode®, BackOffice®, ClearType®, Developer Studio®, FrontPage®, IntelliSense®, JScript®, Microsoft ®, 
MS-DOS®, SharePoint ® Visual C++®, Visual C#®, Visual InterDev®, Visual J++®, Visual J#®, Visual Studio®, Visual Web Developer TM, 
Win32®, Win32s®, Windows®, Windows NT®, Windows Server TM, Windows Server System TM, Netscape®, Netscape Navigator®, Mozilla TM, 
Firefox TM
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What’s New in the 5.1 Release

• The Workarea search now includes assets and library items. 
See ”Searching the Workarea” on page 54

• A new workflow report has been added. See ”Site Update 
Activity Report” on page 127. Also, you can now filter report 
data by folder and email workflow reports. See ”Selecting 
Content by Folder” on page 112 and ”emailing Reports” on 
page 115.

• Improvements to HTML forms:

- A wizard makes it easier to create HTML forms. See 
”Creating a New Form” on page 141.

- New field types and validation give you more flexibility when 
creating forms. See ”Inserting Form Fields” on page 147 
and ”Validation Options” on page 155.

- You can assign a task to a form. See ”Assigning a Task to a 
Form” on page 170

• The Library search results can include a thumbnail of any 
images found. See ”Displaying Search Results” on page 194

• Macintosh support has been improved. See ”Macintosh 
Support for Ektron CMS400.NET Clients” on page 529
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Introduction to Ektron 
CMS400.NET

Using Ektron CMS400.NET to manage Web content is easy once 
you know the basics of setting up and maintaining your site. This 
documentation explains how to maintain an Ektron CMS400.NET 
site from a user’s point of view. By reading this documentation, you 
will gain an understanding of how Ektron CMS400.NET works.

This section introduces basic concepts that you should understand 
when beginning to work with Ektron CMS400.NET through the 
following subtopics.

• ”What is a Content Block?” on page 1

• ”Workflow in Ektron CMS400.NET” on page 5

• ”Editing Content” on page 6

• ”The Lifecycle of Content” on page 7

What is a Content Block?
Any Web site consists of several pages. Each page is made up of 
one or more blocks of content. For example, the home page of the 
sample Web site that is installed with Ektron CMS400.NET is below.
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After you sign in, notice that, as you move the cursor, colored 
borders appears around one or more areas of the page. Each 
surrounded area is content that can be edited independently. The 
border disappears when you move the cursor out of the area. Your 
system administrator controls the design of each page and 
determines where the content appears.

NOTE The colored borders appear when you are not in site preview mode. See Also: 
”Site Preview” on page 11. Also, your administrator can set up your system so that 
the borders always appear on a page, instead of appearing only when you move 
the mouse over them.
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The advantage of this feature is that you can see a Web page as it 
will appear to visitors to your site. Continue editing until you are 
satisfied with its appearance.

To learn what the border color indicates, see ”Appendix A: Content 
Statuses” on page 540.
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The Floating Toolbar
When content’s border is visible, you can right click the mouse to 
display a floating toolbar (an example is in the green box below).

Toolbar buttons let you act on the displayed content and view 
important information about it. The toolbar buttons change 
depending on the content’s status or your permissions for the 
content. For example, one toolbar button lets you edit the content, 
while another lets you view previous versions of it.

If granted permission by your administrator, you can create new 
content, and edit or delete existing ones. Most of your work with 
Ektron CMS400.NET involves working with content.

Buttons on the Menu

The following table describes each button that may appear.

Button Name Description More Information

Approve Approve or decline a request to 
publish or delete content

”Approving/Declining Content” 
on page 85

Add Task Assign a task to a user ”Managing Tasks” on page 335
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NOTE Your administrator can set up your system to have borders always appear on a 
page. In that case, the toolbar always appears in the content -- you don’t need to 
click the mouse to make it appear. For information on the classic user interface, 
see the Administrators Manual > “Introduction to Ektron CMS400.NET” > “Getting 
Started” > “Recognizing Content” > “Returning to the Classic User Interface” 

Workflow in Ektron CMS400.NET
Organizations typically want a Web site that is updated frequently 
with the latest information. They also want to decentralize the 
updating process, so that non-technical users from any department 
can make changes. Further, organizations want oversight over 
those changes to ensure the accuracy of the information, that the 
content adheres to corporate guidelines, etc.

Delete Open View Content page. From it, 
you can delete the content.

”Viewing Content” on page 40

Edit Check out content for editing ”Editing Content” on page 49

Logout Log out of Ektron CMS400.NET  
view of Web site

”Logging Out of the Sample 
Site” on page 13

Preview Preview content before it is published

Properties Open content’s View Content page ”Viewing Content” on page 40

View 
Content 
Difference

Display differences between a 
previous and published version of 
content

”Comparing Versions of 
Content” on page 95

View History Open View History screen, where you 
can view previous versions of content

”Viewing and Restoring 
Previous Content” on page 102

Workarea Opens Workarea, from which you can 
perform all Ektron CMS400.NET  
tasks

”The Workarea and Smart 
Desktop” on page 15

Button Name Description More Information
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Ektron CMS400.NET manages the lifecycle of content, from 
creation through approval and publication. It helps your 
organization set up a process for overseeing changes to a Web 
site, indicate content’s status within that lifecycle, and inform the 
next approver that it is their turn to review the content.

Editing Content

Finding Content
Much of your work involves editing existing content or creating new 
content. Ektron CMS400.NET provides three methods for finding 
content to be updated. You can use whichever method is easiest.

• Navigate through your Web site to the content you want to edit

• Find the content through the Workarea, which resembles 
Windows Explorer and lets you find content by navigating 
through a folder tree. See Also: ”The Workarea and Smart 
Desktop” on page 15

• Use the Search button ( ), which appears on many screens. 
When clicked, a screen prompts you to enter keywords and 
then finds content containing the keywords.

The Editing Process
After you find content, click the Edit button ( ) to open it in an 
editor. Below is an example of content within the editor.
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The editor resembles popular word processing software. You can 
enter text, then select it and click a button to change its display 
properties. For example, you can make text bold, change the color, 
or copy and paste it. You can also insert images, tables, links to 
other Web pages, and check spelling, 

The Lifecycle of Content
After you edit content, you typically submit it for approval to one or 
more individuals who oversee changes to your Web site. These 
people can review, edit and approve the change. When the last 
approver signs off, the new content becomes available on the Web 
site.

In some cases, you are one of the content approvers. In this case, 
you receive an email notifying you that content needs approval. 
You look it over, change it as needed, then pass it on to the next 
approver. If you do not agree with the changes, you can decline the 
request. In this case, the user who made the edits is informed that 
the change is not approved.

The following graphic illustrates the content approval cycle.
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To help track content’s position in this workflow, Ektron 
CMS400.NET assigns a status to each content item. The status 
determines what you can do with it, and indicates what must occur 
in order for it to get published to the Web site. For more 
information, see ”Appendix A: Content Statuses” on page 540.
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Logging In and Out

This section explains how to log in and out of Ektron CMS400.NET, 
and to use the site preview feature through the following subtopics.

• ”Prerequisites” on page 9

• ”Logging into the Sample Web Site” on page 9

• ”Site Preview” on page 11

• ”Logging Out of the Sample Site” on page 13

Prerequisites
Once your Webmaster or administrator installs Ektron 
CMS400.NET, you need the following items before you can use it.

• URL (Web address) of Ektron CMS400.NET Web site 

• Username and password

Once you acquire both, you can log into Ektron CMS400.NET and 
begin managing Web site content.

NOTE This documentation uses the Ektron CMS400.NET sample Web site to 
demonstrate the product.

Logging into the Sample Web Site
To access the Ektron CMS400.NET sample site, follow these 
steps.

1. In your Web browser, navigate to the URL of your Ektron 
CMS400.NET Web site. Your system administrator provides 
this.
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2. Click the Login button on the screen. 

3. The Login dialog box appears.

4. Enter your username and password.
If you are using one of Ektron’s sample sites, you can use any of 
three standard users that demonstrate Ektron’s flexible user-
permissions model. The table below lists the username and 
password needed to log in as each user type, as well as the 
permissions assigned to each user.

5. Click the Login button.
6. The Web page appears.

User Type Username Password Permissions

Administrator admin admin All

Standard user jedit jedit Basic (for example, add/edit content, 
manage library files, etc.)

Membership user jmember jmember Read-only permission to private content



Logging In and Out

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 11

You can navigate around your Web site as you could before 
signing in. But now, the content is surrounded by a colored box 
when you move the cursor over it (illustrated below).

Site Preview
While logged into Ektron CMS400.NET, you can preview the Web 
site as it would appear to visitors, or view it in regular view.

Button 
Appearance

Status Description

Preview 
Mode

Content appears as last edited. The advantage of this mode is 
that you can see a Web page as it will appear when published 
to your site. Continue editing until you are satisfied with its 
appearance.
In Preview mode, click the Preview button to switch to regular 
mode.
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Toggling Site Preview
To toggle site preview on and off, follow these steps.

1. Navigate to a page that includes the login/logout button.

2. Click the Preview button.

Regular View The most recently published version of content appears.
In this mode, colored borders surround content when you 
move the cursor over it.
In regular view, click the Preview button to switch to preview 
mode.

Button 
Appearance

Status Description
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3. The Web site is now in preview mode.

4. To turn preview mode off, click the ( ) button on the 
login screen.

Logging Out of the Sample Site
To log out of Ektron CMS400.NET, follow these steps.

1. Click the Logout button ( ) in the content’s floating toolbar, 

or click the Logout button ( ) on the Web page.
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2. The Logout confirmation box appears.

3. Click the Logout button.
4. You return to the Web page from which you logged out. 

However, it is in standard view, not Ektron CMS400.NET view.
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The Workarea and Smart 
Desktop

The Workarea is a central screen from which you can perform all 
activities within Ektron CMS400.NET. From it, you can 

• access the Smart Desktop

• view the system’s top level folders

• navigate through the folder structure

• perform actions on content

This chapter describes using the Workarea and Smart Desktop 
through the following subtopics.

• ”Accessing the Workarea” on page 15

• ”Understanding the Smart Desktop” on page 20

• ”Navigating Within the Smart Desktop” on page 22

• ”Sending Instant Email” on page 28

Accessing the Workarea
To access your Workarea, follow these steps.

1. Click the Workarea button at the bottom of the screen 
( ) or the Workarea button ( ) in the content’s 
floating toolbar.

2. The Workarea appears.
3. The following illustrates one of several screens that may 

appear in the Workarea. Your system administrator determines 
which screen appears for you.
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Closing the Workarea
To close the Workarea, click  in the upper right corner of the 
window. When you close the Workarea, you return to the Ektron 
CMS400.NET view of your Web site. You do not exit Ektron 
CMS400.NET.

Installing the Document Management Functionality
If the version of Ektron CMS400.NET that you are using includes the 
optional Document Management functionality, the first time you 
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access the Workarea, the following screen appears. It prompts you 
to install the Document Management software onto your computer.

Follow these steps to install the Document Management software.

1. Read the screen above.
2. At the bottom of the screen, click Install Now.
3. The following screen appears. The line at the top of the screen 

(circled in red) may appear, depending on your browser 
security.
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4. If that text appears, click it. The following menu appears. 

5. Click Install ActiveX Control.
6. The following screen appears. Click Install.
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7. The following screen appears. Close it when you see Ektron 
Asset Control in the top left corner of the screen (circled in red 
below).
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Understanding the Smart Desktop
The Smart Desktop is one of Ektron CMS400.NET’s main screens. 
To access it from wherever you are working in Ektron CMS400.NET, 
click the button in the top left corner (circled below).

The Smart Desktop consists of three sections, illustrated below.
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• The right frame displays 

- Content awaiting approval - content that you need to 
approve before it proceeds to the next approver or is 
published if you are the final approver. See Also: 
”Approvals Reports” on page 118

- Content currently checked out - all content in a checked-
out status. This content cannot be edited by other users 
until the user who checked it out or the system 
administrator checks it in. See Also: ”Checked Out Report” 
on page 120

- A list of tasks assigned to you See Also: ”Managing Tasks” 
on page 335

- Any form submission tasks assigned to you See Also: 
”Assigning a Task to a Form” on page 170

- The Content to Expire Report - see ”Content to Expire 
Report” on page 125

NOTE The number to the right of each category lists the quantity of content items in that 
category for you. When you click an item, up to five content items in a category 
appear. To perform tasks on that content, and to view additional content in that 
category, click the category.

If you select a folder from the left frame, the right frame 
displays content in that folder. If you select content from the list, 
information about it fills the right frame.

• The top left frame displays the folder tree for the Smart 
Desktop folder, which has two subfolders

- Tasks (See ”Managing Tasks” on page 335)

- Content Reports (see ”Content Workflow Reports” on 
page 108)

• The bottom left frame displays the top-level folders in Ektron 
CMS400.NET. Your display may be different depending on 
whether you are an administrator.

- Content folder (see ”Working with Folders and Content” on 
page 32)

- Forms folder (see the Ektron CMS400.NET Administrator 
Manual chapter “Working with HTML Forms”)

- ”Library Folder” on page 188
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- Modules (see ”Working with Collections” on page 254, 
”Working with Menus” on page 274, ”Working with 
Calendars” on page 312, and “Private Content & 
Memberships” section of the “Managing Users & User 
Groups” chapter of the Ektron CMS400.NET Administrator 
manual)

- Settings folder, which includes ”Updating Your User Profile” 
on page 358 and ”Accessing Online Help” on page 363

Navigating Within the Smart Desktop
Ektron CMS400.NET’s top level folders appear in the lower left 
corner of the Smart Desktop. Use them to access all other folders.

To open any top level folder, click it. When you do, it appears in the 
frame above. Typically, you would a click top-level folder to see its 
subfolders, then click a subfolder to see its content.

The following graphic illustrates the location of Ektron 
CMS400.NET’s major features from the Smart Desktop.



The Workarea and Smart Desktop

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 23

From the Smart Desktop, you can also:

• ”Modify the Display of Top Level Folders” on page 23

• ”Hide the Left Panel of the Workarea” on page 25

Modify the Display of Top Level Folders
The display of top level folders can appear in two formats.
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The full display is easier to see, but the icon format allows more 
space for the folder structure. You can decide which option best 
suits your needs.

Switching Between Full Buttons and Icons

By default, top-level folders appear as full buttons. To switch the 
display of all folders to icons, double click the down arrow circled 
below.

To switch back to full buttons, double click the up arrow circled 
above.

You can also switch the display of folders one at a time by clicking 
the up or down arrow. 

As an alternative method of switching the display, you can

1. Place the cursor on the bar above the display of top-level 
folders. (The bar has several dots in the middle.)

Format Illustration

A full button with an icon and text

An icon on the bottom of the left frame
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2. When the cursor turns to a double headed arrow, drag it to the 
bottom bar.

To return the display to full buttons, drag the same bar above.

Hide the Left Panel of the Workarea
You can hide the left frame of the Workarea to provide more space 
for working in the right frame. Below is an example of the 
Workarea with a minimized left frame. Note that you cannot see 
the folder display in the left frame.
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To minimize the left frame, click the white X near the top of the left 
frame.

The left frame remains minimized until you move the cursor to the 
left of the bar circled below.
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Using Auto Hide

The Workarea screen also provides an autohide feature, which 
quickly switches between full right frame view and combination 
right-left frame view.

When autohide is turned on, the left frame is minimized unless you 
place the cursor to the left of the bar circled above. If you place the 
cursor there, the left frame appears. As soon as you move the 
cursor back to the right frame, the left frame disappears.

To turn on the autohide feature, click the push pin icon near the top 
of the left frame. 

When you do, the push pin turns 90 degrees to indicate autohide is 
on.
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To turn off autohide, move the cursor to the left frame and click the 
push pin icon. When you do, the push pin returns to its original 
position.

Sending Instant Email
Ektron CMS400.NET lets you send email instantly to a user or user 
group from many screens available from the Smart Desktop. Your 
ability to send instant mail is indicated by a small mail icon next to 
a user or group name (indicated in red below).

When you click a user/group name or email icon, the email screen 
appears, as shown below. Once you complete the screen and click 
Send, an email is sent to designated users.
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The following sections explain how to set up and use Instant email.

• ”Conditions for Instant eMail” on page 29

• ”Where Instant email is Available” on page 30

• ”Modifying Instant eMail” on page 30

Conditions for Instant eMail
• You must have a valid email address set up in the user profile. 

If not, email icons do not appear in Ektron CMS400.NET. See 
Also: ”Updating Your User Profile” on page 358

• Your system administrator must enable the feature.



The Workarea and Smart Desktop

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 30

Where Instant email is Available
Instant email is available from several screens that display users 
and user groups. Typically, you click a user name or the email icon 
to launch an email. Screens in the following Ektron CMS400.NET 
features support instant email.

• Smart Desktop

• Tasks

• Approvals

• Reports

• User and user group setup

Wherever instant email is available, one of the email icons 
appears.

Modifying Instant eMail
When the email screen appears, the following information is 
copied from Ektron CMS400.NET into the email.

Field Source of Default Information Editable?

To User you selected to receive the email. If the user does 
not have valid email address, an error message appears 
on the screen (see below). If you then insert a valid 
email address, the email is sent.

If you specify a group to receive the message, as long 
as one group member has a valid email address, all 
group members with valid addresses receive the email.

Yes.
If desired, you 
can add 
recipients by 
typing them 
into this field.

From You No

Subject If the email message is linked to content, its title 
appears.

Yes
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Body of 
message

If the email message is linked to content, a link to the 
content appears.

Yes

Field Source of Default Information Editable?
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Working with Folders and 
Content

Every content item resides in the Content folder or one of its 
subfolders. So, to work with existing content or create a new 
content, you must first navigate to its folder.

A typical content folder screen appears below. It consists of three 
sections:

• The top left frame shows the folder structure. You can click any 
folder to display its content in the right frame, while its 
subfolders appear below it.

• The right frame shows content in the currently selected folder. 
Above the right frame is a toolbar of buttons that represent 
tasks you can perform on selected content.

• The lower left frame shows Ektron CMS400.NET’s top level 
folders
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In this chapter, you learn about adding, editing, publishing, and 
deleting content through the following subtopics. (Permissions and 
Approvals are explained in the Ektron CMS400.NET Administrator 
manual.)

• ”Workarea Toolbar Buttons” on page 34

• ”Viewing a Folder” on page 37

• ”Viewing Content” on page 40

• ”Expanding the Content Area” on page 44

• ”Adding Content” on page 46

• ”Editing Content” on page 49

• ”Adding Content” on page 46

• ”Searching the Workarea” on page 54

• ”Adding Subfolders” on page 62

• ”Deleting Folders” on page 65
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Workarea Toolbar Buttons
The top of many Workarea screens feature a toolbar that contains 
buttons for performing actions. This section explains the buttons’ 
functions.

Button Name Description

Add Adds items in several places.

Add Calendar Event Accesses the add calendar event screen in the 
Workarea.

Add Content In a content folder, opens the editor and allows you to 
create new content.
See Also: ”Adding Content” on page 46

Add Content Folder In a content folder, allows you to create a subfolder to 
further organize your content.
See Also: ”Adding Subfolders” on page 62

Add Library Item In the library folder, allows you to upload an image or file, 
or add a hyperlink or Quicklink to use in content.
See Also: ”Library Folder” on page 190

Add Task Assign task to a user. See Also: ”Managing Tasks” on 
page 331

Approvals View approval chain for folder or content.
See Also: ”Approving/Declining Content” on page 86

Approve Approve content that awaits your approval.

Approve All In the approvals folder, approves all content awaiting 
your approval with one click.

Archived Content If current content is being displayed, switch to display 
archived content. 
If archived content is being displayed, switch to display 
current content. See Also: ”Setting Archive Options” on 
page 71
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Back Return to previous screen.

Calendar Lets you choose when content will go live.
See Also: ”Working with Calendars” on page 309

Cancel Cancels action you are performing without saving the 
information.

Check-in Saves and checks in content you are working on.
See Also: ”Checked-In Content” on page 525

Check-out Checks out content to edit; prevents others from 
simultaneously working on it.
”Checked Out Content” on page 527

Collection Accesses the collection area for content; lets you create, 
edit, and delete collections. See Also: ”Working with 
Collections” on page 256

Decline Declines an approval request submitted to you.

Delete Deletes selected item.

Delete Content Deletes multiple content items at once.

Delete Folder Deletes current content folder.

Do Not Apply XSLT Removes XSLT applied to XML content viewed in the 
content history area.

Edit Edits content or specific criteria in the Workarea.

Insert Library Item Inserts selected library item into content.
See Also: ”Library Folder” on page 190

Button Name Description
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Link Check Identifies content with a hyperlink to the current content. 
You would typically use this feature to remove the links 
before deleting content.
If you do not remove the links, they are inoperative after 
the content is deleted.

Overwrite Replaces an image or file with a newer version.
See Also: ”Overwriting Files” on page 203

Preview Previews item that was or will be added.

Publish Save and publish the content. 

Remove Removes items from folders and lists in the Workarea.

Reorder Changes the sequence of links in a collection. 
See Also: ”Working with Collections” on page 256

Restore Restores previously published content.
See Also: ”Viewing and Restoring Previous Content” on 
page 103

Save Saves content that was modified.

Search Searches content and library folder screens.
See Also: ”Searching the Library” on page 194

Show Calendar Displays the calendar in the Workarea.

Submit Saves and submits content to next approver in the 
approval chain.

Update Changes are saved and content is updated.

View Date View all calendar events for a selected day. 

Button Name Description
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Viewing a Folder
To view any folder under the content folder, follow these steps.

1. Access the Workarea, as described in ”Site Preview” on 
page 12.

2. Click Content from the left lower side of the Workarea.

View Difference Opens the View Content Difference feature.
See Also: ”Comparing Versions of Content” on page 96

View History View history of selected content.
See Also: ”Viewing and Restoring Previous Content” on 
page 103

View Published Displays currently published version of content.

View Staged Displays staged content.
See Also: ”Staged Content” on page 530

 Select language

Selects the language of the content being displayed.

Select file type

Select the type of files to work with

Button Name Description
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3. All content in the content folder and the selected language 
appear on the right side of the screen. Subfolders appear in the 
upper left frame.

4. To work with any folder or its content, click the folder. When you 
do, its content appears in the right frame.

NOTE You can only view folders for which your system administrator has granted 
permission.

5. If your system supports more than one language, you can 
select content for a particular language or all languages using 
the language dropdown list (illustrated below).

Each folder lists the following information about its content.

Field Description

Title The name of the content.



Working with Folders and Content

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 39

Each folder also provides the following toolbar options.

NOTE Depending on your permissions, you may not see all toolbar buttons.

 

Language The language of the content.

ID The number assigned to the content by Ektron 
CMS400.NET. It is used to retrieve the content from a 
database.

Status The status of the content. See Also: ”Appendix A: 
Content Statuses” on page 523

Date 
Modified

The most recent date the content was added, edited, or 
published.

Last Editor The last user who accessed the content.

Field Description

Button Name Description More Information

Add Content Opens the editor and creates new 
content in the current folder

”Adding Content” on 
page 46

Add several 
content items

Open a new window that lets find and 
transfer non-CMS files to Ektron 
CMS400.NET .

”Using the Document 
Management 
Functionality” on 
page 227

Add Folder Adds a subfolder to the current folder ”Adding Subfolders” on 
page 62

Archived 
Content

If current content is being displayed, 
switch to display archived content. 
If archived content is being displayed, 
switch to display current content. 

”Setting Archive 
Options” on page 71

Delete Folder Deletes the current folder

Note: You cannot delete the Content 
folder.

”Deleting Folders” on 
page 65
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Viewing Content
You can view all content in your Ektron CMS400.NET Web site. 
Viewing content allows you to see the content, metadata, 
summaries, and other information. To view content in Ektron 
CMS400.NET, follow these steps.

Viewing Content from a Web Page
To view content from a Web page, follow these steps.

1. Sign in.
2. Browse to the content whose history you want to view.

3. Click the Properties button ( ).
4. Continue reading from ”The View Content screen appears.” on 

page 41.

Viewing Content from the Workarea
1. Navigate to the folder that contains the content, as explained in 

”Viewing a Folder” on page 37.
2. If your system supports more than one language, you can 

select an edition of the content in a particular language via the 
language dropdown list (illustrated below).

Collections View and work with collections 
assigned to this folder

”Working with 
Collections” on 
page 256

Menus View and work with menus assigned 
to this folder

”Working with Menus” 
on page 273

Search Look for content in the folder ”Searching the 
Workarea” on page 54

View 
Properties

View the folder’s properties

Button Name Description More Information
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3. Click the content.
4. The View Content screen appears.

After you select the content, you have the following options.

NOTE Your options may vary according to your permissions and the status of the 
content.

Button or 
Tab

Name Description For more information, see

Properties Content 
Properties

View the content’s properties ”Properties” on page 43

Content View Content Displays content
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Summary Edit Summary Edit content’s summary. ”Adding a Content Summary” 
on page 74

Metadata Edit Metadata Edit content’s metadata ”Adding or Editing Metadata” on 
page 78

Comment View Comment View comments on changes 
made when editing content.
This comment also appears on 
the View Content and Content 
History screens.

Tasks Add/edit tasks Add or edit tasks for this content ”Managing Tasks” on page 331

Web Alerts Add/edit Web 
Alerts

Add or edit Web Alerts for this 
content

Ektron CMS400.NET  
Administrator manual chapter 
“Web Alert Feature”

Edit Content Open content for editing ”Editing Content” on page 49

View History View older versions of content; 
restore older version

”Viewing and Restoring 
Previous Content” on page 103

View Staged Displays staged content ”Staged Content” on page 530

View Difference Compares current and earlier 
versions of content

”Comparing Versions of 
Content” on page 96

Delete Delete content ”Adding Content” on page 46

Move/Copy 
Content

Move or copy content to another 
folder

This button is only available to 
administrators. To learn more 
about it, see the Ektron 
CMS400.NET  Administrator 
Manual.

Check for 
content linked to 
this content

Identify all content with 
Quicklinks to this content

”Checking for Broken 
Quicklinks” on page 53

Button or 
Tab

Name Description For more information, see
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Properties
The content properties screen contains information about the 
content.

Add Task Attach a task to content ”Task Module Toolbar” on 
page 354

Properties View and modify settings
XML Configuration

The “Managing XML” chapter of 
the Ektron CMS400.NET  
Administrator manual

Content Searchable Check this box if the content 
should be found when someone 
searches your Web site.

Return Go back to previous menu

View 
(language)

View If you can view content in more 
than one language, select a 
language from the drop down 
list.

Add
-select 
language-

Add
-select 
language-

Lets you copy current content 
into a new item and translate it 
to selected language.

”Translating Content to Another 
Language” on page 50

Button or 
Tab

Name Description For more information, see

Field Description

Content Title The title assigned to the content

Content ID The ID number assigned to the content. The ID number is used to retrieve 
content from a database.

Content language The content’s language 

Status The current status of the content
See Also: ”Appendix A: Content Statuses” on page 523
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Expanding the Content Area
It is possible to expand the content area of the screen vertically. 
This gives you more space to work on content. You can expand the 

Last User to Edit The last user to edit this content

Last Edit Date When the content was last edited

Start Date When the content will go live on the Web site

End Date When the content will be removed from the Web site

Action on End Date What happens to the content when its end date and time are reached. See 
Also: ”Setting Archive Options” on page 71

Date Created When the content was created

Approval Method Whether all approvers must sign off on content before it is published; 
managed by your system administrator. 

Approvals The users in the approval chain for this content. See Also: ”Approving/
Declining Content” on page 86

XML Configuration The XML Configuration applied to the content. This is typically managed by 
your system administrator. See Also: ”Managing XML” on page 718

Path The folder path to the content’s folder. A slash (\) represents the Content 
folder.

Content Searchable Yes appears if the content will be found when someone searches your Web 
site. 

Field Description



Working with Folders and Content

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 45

content portion of the Workarea by clicking the up arrow ( ). The 
arrow’s screen location is shown below.

Once the content area is expanded, the top row of buttons and title 
are not visible.

Click the down arrow ( ) to return the content area to normal 
size. The top row of buttons and title also return to the screen.



Working with Folders and Content

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 46

Adding Content
If you have permission to add content to a folder, you can create 
content for that folder. After you create the content, your system 
administrator must insert in onto a page on your Web site.

The following flowchart illustrates a typical sequence of events 
when working with content.

To add content, follow these steps.

1. Browse to the folder where you want to create the new content.
2. Select a language from the language dropdown list.

3. Click the Add button ( ).

4. The Add Content window opens.
5. Create content in the editor using the following table.
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Responding to the Fields on the Add Content Screen

After you respond to the above fields, the following options are 
available.

Buttons on the Add Content Screen

Field Description

Title Enter a title for the content.

Add to 
Quicklinks 
Table

Check if you want to save a Quicklink to this 
content.
See Also:  ”A quicklink is a special kind of hyperlink 
that jumps to another content item on your Web 
site. (A regular hyperlink jumps to a Web page on 
the internet.)” on page 191

Content 
Searchable

Check this box if the content should be found when 
someone searches your Web site. 

Button Name Description

Submit Submit the content into the approval chain. This action also 
returns the changed content to the database and exits the editor.
See Also: ”Approving/Declining Content” on page 86

Publish Publish the content to the Web site.

Note: Only the last approver in the approval chain sees this button.

See Also: ”Approving/Declining Content” on page 86
This action also returns the changed content to the database and 
exits the editor.

Check In Save and check-in the document. This action returns the changed 
content to the database and exits the editor. It does not submit the 
content into the approval chain. Rather, it allows you and other 
users to continue changing it.
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Tabs on the Add Content Screen

Save Save the content without leaving the editor. It is a good idea to 
save your work frequently.

Cancel Close the editor without saving changes.

Button Name Description

Tab Name Description

Content Add/edit content Insert content. For more information about using Ektron 
CMS400.NET ’s editor, see ”Introduction to eWebEditPro+XML” 
on page 365.

Summary Edit Summary Enter or edit the summary for the content.
See Also: ”Adding a Content Summary” on page 74

Metadata Edit Metadata Enter or edit this content’s metadata.

Note: All required metadata must be added before the content can 
be submitted into the approval chain.

See Also: ”Adding or Editing Metadata” on page 78

Comment Add Comment Briefly describe the content, or comment on changes made when 
editing content.
The history comment appears on the View Content and Content 
History screens.

Schedule Add Start and 
End dates

If you do not want to submit the content to the approval chain 
immediately, enter when it will be submitted.
See Also: ”Scheduling Content to Begin and End” on page 67
If appropriate, enter a date when the content will no longer be 
viewable on the Web site.
See Also: ”Setting an End Date on Content” on page 70

Web Alerts Add or modify 
Web Alert 
Information

See the Ektron CMS400.NET  Administrator Manual chapter 
“Web Alert Feature”
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Editing Content
Ektron CMS400.NET content can be in any of several statuses, as 
described in ”Appendix A: Content Statuses” on page 523. You can 
only edit content for which you have permission and in one of the 
following statuses:

• published

• checked in

• checked out by you

• submitted for your approval

NOTE Once you check out content, it cannot be checked out by other users until you 
check it in.

Steps in Editing Content
Accessing the Edit Content screen from a Web page

To access the Edit Content screen from a Web page, follow these 
steps.

1. Sign in.
2. Browse to the content that you want to edit.

3. Right click the mouse and select  Edit.
4. Continue reading at ”From the Edit Content window, you can” 

on page 49.
Accessing the Edit Content screen from the Workarea

To access the Edit Content screen from the Workarea, follow these 
steps.

1. Access the View Content screen for the content block you want 
to edit, as described in ”Viewing Content” on page 40.

2. Select the language whose content blocks you want to view.

3. Click the Edit button ( ).
4. The editor opens with the content block inserted.
5. From the Edit Content window, you can
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•edit content

•create or edit a summary

•specify metadata for the content

•enter or update a comment

•enter or update start and end dates

•review and update Web Alert information (To learn more, see 
the Ektron CMS400.NET Administrator manual chapter “Web 
Alert Feature”)

•save changes

•check in content

•submit content for approval

•publish content to the Web site

•access the library

6. Make the necessary edits to the content. See Also: ”Table of 
Toolbar Buttons and Drop-Down Lists” on page 372
Or, you can choose a toolbar option or tab from the top of the 
Edit Content window. These options are described in ”Buttons 
on the Add Content Screen” on page 47 and ”Tabs on the Add 
Content Screen” on page 48.

Translating Content to Another Language

NOTE The following procedure only works with HTML or XML content. You cannot 
translate other file types as described below.

Use this procedure when you want to initialize a new foreign 
language content item with content from a source language. This 
copying should facilitate the translation.

For example, an editor is translating content from French to 
German. The editor copies the French edition to new content 
whose language is German. As the editor translates the French 
edition into German, he deletes the French content. Any images in 
the content would usually remain, and all formatting (tables, 
bullets, etc.) is retained.

To copy content into new content block of a different language, 
follow these steps.
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1. Go to the View Content screen for the content you want to 
translate.

2. From the View drop-down list, select the original language.
3. Use the Add drop down list in the upper right corner to select 

the language into which you want to translate the content.

4. The Edit Content screen appears with original language 
content. Translate into the new language then delete the 
original content.

If desired, you can click the Translate button ( ). If you do, a 
new screen prompts you to identify the original language, new 
language, and the glossary to use. Then, the content is 
translated. If you like the translation, click Paste Content, and 
the translated content replaces the original.
Once the translated content is inserted into the editor, you can 
edit it as needed.

5. When you save the content, it is saved as the edition of that 
content in the selected language.

Deleting Content
NOTE The ability to delete content is a privilege granted by the system administrator. If 

you do not see a Delete button ( ) on the screen, you do not have permission 
to do so.

The Delete command lets you permanently delete obsolete 
content from your Web site. You can only delete content if its status 
is Approved.

Like publishing, deleted content must go through the approval 
chain before it is removed. If you are the last approver in the 
approval chain, the content is deleted immediately. See Also: 
”Approving/Declining Content” on page 86
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You can delete a single content item or several content items in a 
folder. Both procedures are explained below.

Deleting a Single Content Item
To delete one content item, follow these steps.

Deleting Content from a Web page

To delete content from a Web page, follow these steps.

1. Sign in.
2. Browse to the content you want to delete.

3. Click the Delete button ( ).

4. The View Content screen for the selected content appears. 
(See ”Viewing Content” on page 40.)

5. Click the Delete button ( ).
6. The following message appears.

7. Click OK to delete the content.
Deleting Content from the Workarea

1. Access the View Content screen for the content you want to 
delete, as described in ”Viewing Content” on page 40.

2. Click the Delete button ( ).
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3. The following message appears.

4. Click OK to delete the content.

Deleting Several Content Items in a Folder
On the View Content Folder screen, you can delete several 
content items at one time. To do so, follow these steps.

1. Access the content folder that contains the content you want to 
delete.

2. Click the Delete Content button ( ).

3. The Delete Contents of Folder screen is displayed.
4. Check boxes next to content items you want to delete.

NOTE Check off the box in the header cell to select all or deselect all.

5. Click the Delete Content button ( ).

6. A confirmation message is displayed.
7. Click OK to continue.

Checking for Broken Quicklinks

The Check Links button ( ) locates all content that includes a 
Quicklink to the displayed content. This feature is useful before 
deleting content, because it informs you of every content item that 
will include a “dead” link after you delete the selected content. You 
should then edit that content and remove or change the obsolete 
Quicklinks.

To use the link checker, follow these steps.
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1. Access the View Content page for the content whose links you 
want to check, as described in ”Viewing Content” on page 40.

2. Click the Check Links button ( ).

3. A page lists each content item that links to the current content.
Click the title to access the View Content page for the selected 
content. From there, you can remove or change the Quicklink.

Searching the Workarea
You can search any folder to easily and quickly locate within your 
Web site. The following sections explains how to use the content 
search.

Selecting a Folder to Begin the Search
To search your entire site, start with the top level (Content) folder.

If you want to limit the search to any folder (and its subfolders), 
select it then select the search criteria. All folders under the starting 
folder are included in the search. 

Accessing the Search Content Page
To access the search content page, follow these steps.

1. Navigate to the folder at which you want to begin the search.

2. Click the Search button ( ).

3. The Search Content Folder screen appears.
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The Search Screen
The search screen helps you find Ektron CMS400.NET content by 
specifying the following criteria. 

• the kind of content you want to search (for example, HTML 
content)

• a search word or words

• how the search words must match the content in order for a 
document to be found by the search

• whether the search words are matched against the content 
item’s title

• whether the search words are matched against the content’s 
comments

• an optional range of created or modified dates. Only content 
created or updated within a date range is found by the search.
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• the last name of the editor who updated the content most 
recently

• the status of the content

• any metadata criteria assigned to the folder

• if the content includes Microsoft Word documents, the size of 
the documents

• If the content includes Powerpoint presentations, the number of 
slides in the presentation

Each feature is explained below.

NOTE To help track words and phrases site visitors are entering on the search screen, 
the Search Phrase Report provides a count of all phrases searched within a date 
range. In Ektron CMS400.NET, this report is available from the Smart 
Desktop > Reports. For documentation of this report, see ”Search Phrase 
Report” on page 134.

Specifying the Kind of Content to Search
Near the top of the screen, check boxes let you determine the 
kinds of content to search.

NOTE Assets only appears if your organization has implemented Ektron’s Document 
Management feature.

Check this box To search

Content HTML content

Forms HTML forms

Assets Office documents and managed files. See Also: 
”Using the Document Management Functionality” 
on page 227
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IMPORTANT! The search only considers content, forms, and assets whose Content 
Searchable box is checked. The Content Searchable box appears on the item’s 
View Properties screen.

Specifying a Search Word or Phrase
In the Search Text field, enter one or more words that you want to 
find within content, forms and assets. The search returns content 
that includes these words.

Entering one or more words here is optional. That is, you can use 
fields on the lower portion of the screen to find content without 
knowing any words contained in the content. For example, you can 
find every piece of HTML content that was modified by a certain 
user within the last 30 days.

If you check off HTML and Form content, you can enter no search 
criteria and get a list of all HTML and Form content on your site.

However, if you enter search text, the search only finds items that 
include the search text and satisfy other criteria on the screen.

See Also: 

• ”The Noise Files” on page 57

• ”Specifying Match Criteria” on page 58

• ”Adding or Editing Metadata” on page 78

The Noise Files

If you are searching for assets, Windows has a noise file that 
screens from the search every single letter of the alphabet as well 
as common words. Examples of common words are about, after, 
all, and also. Avoid entering such words into the Search Text field, 
because the search ignores them.

Include Archived Content, forms and assets that have been 
archived. See Also: ”Setting Archive Options” on 
page 71

Check this box To search
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To find the list of noise words, search your computer for files 
named noise.xxx, where xxx is a three-letter abbreviation for the 
language. For example, noise.eng lists English noise words.

You can open a noise file with a simple word processor program, 
such as Notepad, to view any language’s noise words. You can 
also edit the file. For example, you can remove words that users 
should be able to search on.

Specifying Match Criteria

NOTE This field is only applicable if you entered one or more words in the Search Text 
field.

From this dropdown list, select criteria for how the search word or 
words must appear within the content of the files being searched.

Your choices are described below.

 Match Criteria Examples

Choice A search returns content that has For more information, 
see

All Words all words in the search field ”All Words” on page 59

Any Word any word in the search field ”Any Word” on page 59

Exact Phrase all words in the order specified in the search field ”Exact Phrase” on page 59

Contains (match partial 
words)

any part of any word in the search field ”Contains (Match Partial 
Words)” on page 59
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The examples below assume you entered these words into the 
Search Text field.

• partners

• content

• Monday

• employee

• green
All Words

All Words works like an “and” function. The search returns only 
content that has the words partners and content and Monday and 
employee and green. The words can be in any order within the file.

Any Word

Any Word is almost the opposite of All of the Words. It works like 
an “or” function.

When you select this option, the search returns all files that have at 
least one of the words entered in the search text field. In other 
words, it returns files with the word partners or content or Monday 
or employee or green.

Exact Phrase

Exact Phrase returns content that have all five words in the order 
specified in the search text field.

A better example would be to search for a phrase, such as Content 
Management Solution. The search yields only content with that 
exact phrase.

Contains (Match Partial Words)

Although you cannot search for wild cards, the Match Partial 
Words option does almost the same. For example, enter at into the 
search text field, then select Match Partial Words. The search 
returns all content with the letters at, finding words such as At, Bat, 
Chatter, Atoll, ATM, etc.
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Additional Search Criteria
The next section of the search screen lets you choose one or more 
customized search criteria. Note that if you enter more than one 
criterion, only content satisfying all criteria appears on the search 
results screen.

Fields that Apply to Content, Forms and Assets

Search criterion Description

Title The title of the content, form, or asset. 
You can enter a partial word. For example, entering Part 
yields the following results.

• Multi-Hospital Nurse Executive Participation

• Ektron Partners and Customers

You can also enter more than one word or phrase as long 
as they are in the correct sequence.

Comments The content or form’s comments, which can be inserted via 
the Comment tab.

Date Created The file’s creation date. You can enter a single date or a 
range of dates. 
The search returns all items with that creation date that 
satisfy all other criteria.

Date Modified The late date when the file was modified. You can enter a 
single date or a range of dates. 
The search returns all items with that edit date that satisfy 
all other criteria.

Last Editor’s Last Name The last name (surname) of the user who most recently 
changed the content or form. This is taken from the Last 
Name field on the User Information screen.
The search returns all items last edited by that user that 
satisfy all other criteria.
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Custom Fields
Custom fields are defined by your system administrator and 
applied to content by its author or editor. They are custom-defined, 
so would be different for every site.

The custom search fields appear below the Status field.

Fields that Apply to MS Office Files Only

Result Display Options
At the top of the search screen, a pull-down list lets you choose the 
how to display the search results.

Status The content status. See Also: ”Appendix A: Content 
Statuses” on page 523

Note: Although you can search for content by any status, 
the search results display only the most recently published 
version. If a version has never been approved, nothing 
appears.

Search criterion Description

Search criterion Description

Size of Document As displayed on the read-only Size field on the File 
Properties window’s General tab.

 Number of slides 
(PowerPoint)

As displayed on the read-only Statistics: Slides field on 
PowerPoint’s File Properties window’s Statistics tab.
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Adding Subfolders
To further organize content in your Ektron CMS400.NET Web site, 
you can create subfolders to store related content.

View 
option

Description Example

Mixed If the item is an 
image, display the 
image in the left 
column. If not, 
display its title.
To the right, 
display the item’s 
Description.

Note: Mixed 
search results 
require the 
Internet Explorer 
browser, version 6 
or greater.

Text Display item’s title 
in the left column. 
To the right, 
display the file 
type and folder 
name.
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NOTE The ability to add a subfolder is a privilege granted by the system administrator. If 
you do not see an Add Folder button ( ) on the View Contents of Folder 
screen, you do not have permission to do so.

To add a subfolder, follow these steps.

1. Navigate to and click the folder under which you want to create 
a subfolder.

2. The contents of the folder appear in the main section of the 
Workarea.

3. Click the Add Folder button ( ).

4. The Add Subfolder screen appears.

5. Enter the required information in the fields. Use the following 
table to assist you.

Field Description

Folder name Enter a name for the subfolder.

Description Enter a full description of the folder

Style Sheet Specify the style sheet that the content in the folder will 
use. If left blank, the folder inherits the style sheet from 
the parent folder.
Your system administrator should be able to assist you 
in choosing a style sheet.
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6. Click the Save button ( ).

Template File 
Name for this 
Folder

Specify a template for the content in this folder. The 
template is used when Quicklinks are generated for the 
content.
See Also:  ”A quicklink is a special kind of hyperlink that 
jumps to another content item on your Web site. (A 
regular hyperlink jumps to a Web page on the internet.)” 
on page 191
A drop-down list of templates already being used by 
your Web site appears below this field. You can select 
any template from the list.
If you leave this field blank, the template from the parent 
folder is inherited.

Important!: If you change a folder’s template, that action 
does not update quicklinks for existing content in the 
folder. It only affects new content, created after the 
template is changed.

Your system administrator should be able to assist you 
in choosing a template.

XML 
Configuration

By default, content and folders inherit XML configuration 
settings from their parent folders. To “break” or restore 
inheritance, place or remove a check in the checkbox 
next to Inherit XML Configuration.
For more information, see the “Managing XML” chapter 
of the Ektron CMS400.NET Administrator’s manual.

Should Office 
documents 
added to this 
folder be 
published as 
PDF?

Specify if Office documents in this folder are published 
to the Web as PDF files. This property appears when 
the Publish as PDF property is checked in Settings > 
Configuration > Setup.
See Also: ”Updating Setup Information” on page 22

Note: This property only appears if Ektron’s Document 
Management functionality is installed. For more 
information, see ”PDF Generation” on page 849.

Metadata tab See ”Entering Custom Metadata” on page 79

Web Alerts tab See the Ektron CMS400.NET  Administrator Manual 
chapter “Web Alerts Feature”

Field Description
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Deleting Folders
You can delete folders that are no longer needed.

NOTE The ability to delete a folder is a privilege granted by the system administrator. If 

you do not see a Delete Folder button ( ) on the View Contents of Folder 
screen, you do not have permission to do so.

CAUTION! Deleting a content folder permanently deletes its content, quicklinks and 
subfolders.

To delete a content folder, follow these steps.

1. Navigate to the content folder you want to delete.

2. Click the Delete Folder button ( ).
3. A confirmation message appears.
4. If you are sure you want to delete the content folder, click OK.
5. The screen is refreshed, and the folder is deleted.
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Scheduling Content to Begin and 
End

Scheduling content lets you control when content becomes visible 
on the Web site. Similarly, you can remove content on a 
predetermined date and time. When used together, a start and end 
date can relieve you of much work by managing how long content 
is viewable on your Web site.

You can also set options for what happens to content after 
reaching its end date.

How Does It Work?
When you create or modify content, you can select a “go live” date 
and time. If you do, and the content makes it through the approval 
chain, Ektron CMS400.NET publishes the content to the live site at 
that time.

For example, your company is having a sale of the century in a 
month, and everything is ready except the announcement. You 
decide to update your Web site to let the public know about the 
sale. With this feature, you create the Web content now and set it 
to go live a week before the sale.

This topic is explained through the following subtopics:

• ”Setting a Start Date” on page 66

• ”Setting an End Date on Content” on page 69

• ”Setting Archive Options” on page 70

Setting a Start Date
To set a start date, follow these steps.
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1. Access the editor by adding new content or editing existing 
Content.

2. If adding new content, enter a title and the content.
3. Click the Schedule tab.

4. Click the calendar button next to the Start Date field.

5. A calendar pops up.
6. Select the date and time when the content will become visible 

on the Web site.
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7. Click the Done button.
8. The date and time appear in the Start Date field

NOTE When you select a time for content to go live, that time depends on the server’s 
system clock. If the clock is incorrect, the content will not go live at the intended 
time.

What Happens After I Set a Start Date?
After you save the content, it appears on the Content Pending Start 
Date report, which helps you keep track of content with a future 
start date. See Also: ”Content Pending Start Date Report” on 
page 123

After you set a go live date and the content completes the approval 
chain, two scenarios may occur: 

• The content is new

• The content already exists
Each scenario is now explained.
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Setting the Go Live Date on New Content

When you set a go live date on new content, it becomes viewable 
on the specified date and time as long as it completes the approval 
chain. If a user accesses the page that contains the content before 
then, he sees only the template. This occurs within Ektron 
CMS400.NET and when the content is viewed on the Web site.

Setting the Go Live Date on Existing Content

When you set a go live date for changes made to existing content, 
and it completes the approval chain, the content has a grey border 
within Ektron CMS400.NET until the date specified.

When you view content on the Web site, you see the previously 
published version. When the go live date occurs, the new content 
replaces the previously published version, and the content‘s status 
changes to Active.

Setting an End Date on Content
To set an end date for content, follow these steps.

1. Access the editor by adding new content or editing an existing 
one.

2. If adding new content, enter a title and content.
3. Click the calendar button next to the End Date field.
4. A calendar pops up.
5. Select the date and time you want the content to be removed 

from the Web site.
6. Click the Done button. 
7. The date and time appear in the End Date field

NOTE When you select a time for content to go live, that time depends on the server’s 
system clock. If the clock is incorrect, the content will not be removed at the 
intended time.
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What Happens After I Set an End Date?
If you set an end date to content, and it gets published to your Web 
site, the content is visible on the Web site. When content reaches 
its end date, you have three choices for what to do with it. These 
are explained in ”Setting Archive Options” on page 70.

If your choice means the content will not appear on the Web site, 
Ektron recommends having another content item ready to replace 
it. If not, and a site visitor goes to the page containing the content, 
he sees the template without the content.

Appearance on Content Reports
After content reaches its end date, it appears on the Expired 
Content report, which helps you keep track of expired content. See 
Also: ”Expired Content Report” on page 125

Also, the Content to Expire report lists all content whose end date 
will occur within a number of days that you specify. See Also: 
”Content to Expire Report” on page 125

Setting Archive Options
After setting an End Date, you can specify content’s archive 
options, which determine what happens upon reaching its end 
date/time.

To be eligible for any option, the content must reach its end date/
time, progress through its approval chain, and be published. Until 
those events occur, the content remains visible both within its 
content folder and on the site.

The archive options (illustrated below) appear below the Start 
Date and End Date fields on the content’s Schedule screen.
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Each option is explained below.

Archive Options

Restoring Content from Archived to Active State
To restore content from archived state to active, follow these steps.

1. Navigate to its folder.
2. If necessary, click the Archive button to view it. (See ”Archive 

Options” on page 71).

3. Click the Edit button ( ).

4. Click the Schedule tab.

Option Can site visitors view 
content upon expiration?

Can users view and edit 
content within Ektron 
CMS400.NET upon 
expiration?

Archive and remove from site 
(expire)

No Yes, within its folder by clicking 
the archive button ( ).

Note: If this option is assigned to 
content, it only moves into the 
archived area of its folder after a 
site visitor accesses the host Web 
page.

Archive and remain on Site Yes
The content will not appear on a 
page that uses the ListSummary 
function but will appear wherever 
the ArchiveListSummary function 
is used.

Yes, within its folder by clicking 
the archive button ( ).

Note: If this option is assigned to 
content, it only moves into the 
archived area of its folder after a 
site visitor accesses the host Web 
page.

Add to CMS Refresh Report Yes Yes, in the active area of its folder 
and on the Refresh Report.
See Also: ”Refresh Reminder 
Report” on page 124



Scheduling Content to Begin and End

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 72

5. Remove the End Date or change it to a future date.
6. Submit the content for publishing. When the content is 

published, it will no longer be archived.
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Adding a Content Summary

A summary provides a short description of content to supplement 
the title when displaying a list of content on a Web page. When you 
create or edit content, you can create a summary. Then, your Web 
site developer can create Web pages that contain just the 
summaries to attract readers to the full story.

A good example is a news Web site. A page on that site could list 
the titles of the top stories followed by a summary of each 
(illustrated below).

Like content, summaries can include images and files as well as 
different font styles and sizes. This chapter explains how to create 
summaries and how they can help navigation within your site. Your 
system administrator determines how to display the summaries on 
your site.

TOP STORIES
Ektron Named a Rising Star (08-15-2003)
August 15, 2003, Amherst, New Hampshire, USA — 
Ektron, Inc., an innovator in Web content 
management and authoring, has been named 
a Rising Star as part of the prestigious 
New England Technology Fast 50 Program.

Ektron Launches International Distribution Program (08-
08-2003)
August 8, 2003, Amherst, New Hampshire, USA — 
Ektron, Inc., an innovator in dynamic Web 
content authoring and management with 
over 350,000 users, today announced the 
launch of its international distribution 
program.
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Creating Summaries
There are two ways to create summaries:

• for a new content (see ”Creating a Summary on New Content” 
on page 74)

• for an existing content (see ”Creating a Summary for Existing 
Content” on page 75)

Creating a Summary on New Content
1. Navigate to the folder in which you want to create the content.
2. Click the Add Content button. The Add Content screen 

appears.

3. Insert a Title and content. See Also: ”Adding Content” on 
page 46

4. Click the Summary tab. 
5. Enter summary information for the content. The summary can 

include images, files, and hyperlinks. Its length can be 
restricted by your system administrator in the configuration 
setup screen.
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6. When done, click the appropriate button. 

Creating a Summary for Existing Content
1. Navigate to the folder that contains the content.
2. Click the content. 
3. The View Content screen appears.
4. Click the Summary tab to enter or edit summary information 

for the content. The summary can include images, files, and 
hyperlinks. Its length can be restricted by your system 
administrator in the configuration setup screen.

5. When done, click the Save button ( ). 

6. The View Content page reappears. The status of the content 
changes to “checked out” to you.

NOTE When you enter or edit existing content’s summary, its status changes to checked 
out. After you create the summary, click the Check-In button to check the content 
in. From that point, you need to submit or publish it.

Editing a Summary
NOTE You can only edit the summary of content that is published, checked in, or 

checked out by you.

To edit the a content’s summary, follow these steps.

1. Access the View Content page for the content whose summary 
you want to edit, as described in ”Viewing Content” on page 40.

2. Click the Summary tab.
3. The Edit Summary window opens.
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4. Click the Edit button. The summary opens within the editor.
5. Make the necessary changes.

6. Click the Save button ( ).

7. The summary is saved, and the View Content page is 
displayed with a status of checked out.

NOTE When you edit an existing content summary, it goes into a checked out state. After 
creating the summary, check the content back in. From that point, you must 
submit it or publish it.
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Adding or Edit ing Metadata

You can add two kinds of metadata to Ektron CMS400.NET content:

• Metadata that can appear on your Web site’s search page 
(below the standard search fields) to help site visitors find 
content on your Web site (illustrated below). 

This kind of metadata also appears on the Search screen used 
to find content within the Workarea. For more information, see 
”Entering Custom Metadata” on page 78.
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• Metadata that resides in the source code of a Web page. 
Examples include the title and meta tags. This data makes it 
easier for search engines to find your Web page (illustrated 
below).

For more information, see ”Entering Title and Keywords” on 
page 80.

Entering Custom Metadata
Your system administrator defines the metadata that can be added 
to content. The metadata being collected can be customized for 
each folder. When you create or update content, you can define 
metadata using fields that the administrator specified.

NOTE In order to add metadata to content, an administrator must have created 
definitions for it in the language of the content.

For example, each document stored in the Document 
Management functionality has a unique part number. Your system 
administrator adds a custom search field called Part Number, and 
specifies that only numbers can be inserted into the field.

When you add a document to Ektron CMS400.NET, you access the 
content’s metadata and insert the correct part number for the 
document (illustrated below).
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Then, anyone visiting your Web site can find that document by its 
part number (or a range of part numbers) using the field on your 
Web site’s search screen (illustrated below).
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See Also: ”Entering or Editing Metadata” on page 82

NOTE When your system administrator sets up metadata, he determines whether or not 
is it “publicly viewable.” 
If it is, the search field appears on the search screen that site visitors use along 
with the search screen in the Ektron CMS400.NET Workarea. If the data is not 
publicly viewable, it only appears on the Workarea search screen.

Entering Title and Keywords
After you create or update content, it is typically published to the 
World Wide Web (WWW). Programs that search the Web (such as 
Google) look at a page’s title and keywords to determine if they 
should return your Web page with their results.

To improve search results, Ektron CMS400.NET provides two fields 
within Metadata by default. 

NOTE Your system administrator may enable or disable these fields for each folder.

• Title - appears on the search results screen to further define 
your Web page
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• Keywords - are searched by leading search programs, along 
with the page’s title



Adding or Editing Metadata

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 82

After content is published to the Web site, you can view the page 
source to see its metadata. Below is the source of a sample Web 
page.

On this Web page, notice the keywords are included in the meta 
tag, and the title is in HTML tags. These appear according to how 
the administrator sets up the metadata definitions.

Entering or Editing Metadata
To enter or edit content’s metadata, follow these steps.

WARNING! You may only edit metadata of content that is published, checked in, or checked 
out by you.

1. Access the Edit Content screen for the content whose 
metadata you want to enter or edit, as described in ”Editing 
Content” on page 49.

2. Click the Metadata tab.
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3. The Edit Metadata screen opens with the current metadata 
displayed. In order to add metadata to content, an 
administrator must have created definitions for it in the 
language of the content.

NOTE Your screen may differ from the example below. Your system administrator 
determines the appearance of the Edit Metadata screen.

4. Edit the metadata. Note that



Adding or Editing Metadata

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 84

• Required fields are red and marked with an asterisk (*). You 
must place at least one response in such fields before the 
content can be saved.

• Your system administrator may prevent you from editing a field. 
In this case, the field has a gray background, and you cannot 
place the cursor there.

• Fields may appear in two columns. In this case, the system 
administrator provides a list of terms that you can apply to the 
content. You can only select terms from the list -- you cannot 
enter free text.
One column is labeled Not Included and the other Included. 
Move terms between lists by clicking the arrow (>> and <<). Or, 
move all terms between lists by clicking All >>.

• You may see a semi-colon (;) as a separator character. Use the 
separator character to separate items in a field.

• If default metadata is defined for a specific data type, you can 
click the Default button at the bottom of each field to restore it.

• Below each field is a Characters Left field, which counts the 
number of metadata characters. You cannot exceed the 
maximum (500 characters).

5. Click the Save button ( ).

6. The View Content screen reappears.
The content is now in a checked out state to you. For the changes 
to take effect on the Web site, check in the content and submit it to 
the approval chain.

See Also: ”Approving/Declining Content” on page 85
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Approving/Declining Content

Your site administrator establishes an approval chain for each 
folder, or even specific content items. The approval chain is a list of 
people or groups who must approve new or edited content before it 
is published to the Web site. If a user group is part of an approval 
chain, any member of the group can approve the content.

The administrator also determines the sequence of approvers in 
the chain.

When a new or edited content is submitted to the approval chain, it 
is reviewed by users who may

• change it

• approve or decline it

• publish it to the Internet (it is published when the last user 
approves it)

The chart below illustrates the approval process.
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You can approve and decline all content that has been submitted 
to you from the approval folder. The following topics guide you 
through the approval or decline of this content.

• ”Approve/Decline One Content Item” on page 86

• ”Approve/Decline Several Content Items” on page 88

• ”Example of an Approval Chain” on page 89

Approve/Decline One Content Item
1. Click the Smart Desktop button (circled in red below).

2. Click Reports.
3. Click Approvals.
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4. Click the content you want to approve or decline.

To select all displayed content, click Select All at the top of the 
screen.

5. The content appears. You can view the content, summary, 
metadata, etc.
A toolbar at the top of the screen lists tasks you can perform on 
the content.

Button Name Result of Clicking

Publish Accept changes to the content and publish it to the site.

Note: If there is another approver in the approval chain for the content, 
this is replaced by a SUBMIT button.

If you click Publish but the content item has an incomplete task assigned 
to another user, the content cannot be published. Instead, the following 
error message appears.

The user to whom the task is assigned must complete it before you can 
publish the content.
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Approve/Decline Several Content Items
To approve several submitted content items without reviewing 
them, follow these steps.

1. Select the submitted content you want to approve, as 
described in ”Approve/Decline One Content Item” on page 86.

2. Click the Approve All button ( ).

3. The following message appears.

4. To continue, click OK.

Decline Reject changes and keep current version of content live on the Web site.

Edit Check out content and change it if desired.

View 
Published/
Staged

Toggle between the currently published version and submitted version of 
content. This can help you compare versions. See Also: ”Staged Content” 
on page 547

View Diff View differences between the version awaiting approval and the currently 
published content.
See Also: ”Comparing Versions of Content” on page 95

Back Return to previous screen.

Button Name Result of Clicking
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5. The approved content is either submitted to the next publisher, 
published immediately to the Web site, or deleted, depending 
on the approval chain set for the content.

Example of an Approval Chain
The approval chain begins when a content contributor submits a 
new or edited content. If email is enabled, an email is sent to the 
next approver in the approval chain.

The following example follows a typical content block from creation 
to publication. Three users make up this approval chain.

• Sports Writer - creates sports content

• Sports Editor - edits and publishes all sports articles

• Editor In Chief - edits and publishes all articles
Each user has different permissions that correspond to their roles.

The example uses the following topics to explain a typical approval 
chain.

• ”Creating Content” on page 89

• ”First Approver” on page 90

• ”Second Approver” on page 92

Creating Content
The first step is to create content. To create new content, follow 
these steps.

1. Log in to Ektron CMS400.NET as a SportsWriter.
2. Create content, as described in ”Adding Content” on page 46.

3. Click the Submit button ( ) at the top of the window.

4. The content is in the approval chain. The next user in the chain 
receives an email saying the content is ready for approval.
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NOTE Emails are only sent if your Administrator enables them.

The content contributor, Sports Writer, has completed his role in 
the approval chain but continues to receive emails notifying him of 
changes in the content’s status.

First Approver
After Sports Writer submits the content, the first user in the 
approval chain, Sports Editor, receives an email stating content 
needs his approval. He can change and approve the content or 
decline it.
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Sports Editor logs into Ektron CMS400.NET, navigates to his 
desktop, where he sees a link Content Awaiting Approval.

He clicks the link and sees all content awaiting his approval.

The approvals folder window displays information such as title, 
who submitted it, go live date, etc. The Sports editor clicks the 
submitted content.

The View Content Awaiting Approvals window appears listing all 
information necessary to decide whether to approve or decline the 
content.
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At the approval window, the Sports Editor has several options.

For demonstration purposes, we‘ll choose Approve.

Second Approver
After the content is approved, the next approver in the approval 
chain receives an email saying that the content is ready for 
approval.

Button Result

Approve 
Send content to next approver in approval chain.

Decline 
1. Send email to creator, notifying him/her that 

content was declined.

2. Remove content from approval chain.

Edit 
Invokes the editor. From here, the approver can 
change the content.
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EditorInChief logs in to Ektron CMS400.NET and accesses his 
Workarea. The Workarea has an Approval folder with the content 
awaiting his approval. EditorInChief navigates through the 
Approval folder until he finds the content Red Sox win World 
Series.

From this window, EditorInChief can view information about the 
content, including title, go live date, user who created it, etc. He 
then clicks the content he wants to approve.

This window is similar to the previous approver’s but includes a 
Publish button at the top of the screen. The EditorInChief has a 
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publish button (instead of a submit button) because he is the last 
approver in the approval chain. When he approves the content, it is 
published to the Web site. 

Like the Sports editor, the EditorInChief has the following options.

After reviewing the content, the EditorInChief decides it is great 
and publishes it. At this point, the content becomes live on the Web 
site, and the approval chain is complete.

The user who created the content receives an email notifying him 
that it was published.

Button Description

Publish 
Publish the content.

Decline 
1. Sends an email to the creator, notifying him/her 

that content was declined.

2. Removes content from the approval chain.

Edit 
Invokes the editor. The approver changes the 
content.
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Comparing Versions of Content

The View Content Difference feature highlights changes that were 
made to selected content. Below is an example of the View 
Content Difference screen, showing two versions of content. The 
changes are indicated by 

• redlining deleted content

• highlighting in yellow added content

Within the View Content Difference feature, you can perform 
several tasks, as well as view different versions of the content 
separately, or compared.

When Can I Compare Content?
The View Content Difference feature is only available when

• you are viewing an historical version of content

• a staged version of the content is available (See Also: ”Staged 
Content” on page 530)
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The following table explains when you can use the feature, and 
which versions are compared.

If content can be compared with another version, the View 

Difference button ( ) appears in the content history area or the 
Web page view.

The Compare Content Window
NOTE The first time the View Content Difference feature is opened, a simple installation 

program runs. See Also:  ”First Use of the View Content Difference Feature” on 
page 101.

The Compare Content window consists of the following:

• ”Toolbar” on page 97

• ”Content Area” on page 100

• ”View Tabs” on page 100

Content Status Compares current published 
version with

Published Historical version stored in the content 
history area

Checked-In Most recently checked-in version

Submitted Submitted version

Pending Start Date Scheduled version pending start date

Checked Out Not available
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Each area is explained below.

Toolbar
The content comparison toolbar has five buttons, explained below.

Button Name Description

Print Sends content to local or network printer.

Note: This option prints the currently displayed content, 
whether it is the compared, published, or staged content.

Save Saves a copy in HTML format on your local machine or 
network. When saved as a physical file, the HTML may be 
edited. However, the changes are not saved to the Web 
Server.

Note: The save option saves the version of the content you 
are viewing.
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Setup

Click the Setup button ( ) to open the setup dialog box. 
Typically, a system administrator would edit these settings.

You can change the setup options to better suit your needs. The 
following table explains each option.

Setup Opens setup dialog box to configure the settings. Typically, 
only an administrator would use this.
For more information, see ”Setup” on page 98.

Help Displays additional information about the compare feature.

Exit Closes the window.

Button Name Description

Option Description

Compare Options

Compare visual 
aspect

Compares content as it would appear on a 
Web page.
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After updating setup information, click OK to save changes.

Compare source 
code

Displays compared content as source HTML.

Whitespace Options

Ignore All Blank (whitespace) characters are ignored.

Smart Detect One or more consecutive whitespace 
characters are treated as a single separation 
sequence. That is, multiple whitespace 
characters are ignored.

Detect All Blank (whitespace) characters are treated as 
any other character.

Other Options

Ignore Case Determines whether comparison is case 
sensitive. For example, if you check this box, 
the strings “Bob” and “BOB” are not 
highlighted because their only difference is 
the case of the characters.

Ignore Format 
Attributes

Determines whether comparison ignores 
changes in text-formatting attributes (HTML 
Visual Analysis only).

Option Description
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Content Area
The content area displays the content comparison.

The following table describes the change indicators.

View Tabs
When viewing content in the View Content Difference feature, 
there are three view modes, explained below.

Symbol Example Content state

Plain black text Unchanged

Yellow highlighted text Added

Red, struck-through text Deleted

View Description

Diff Compares published version of content to staged 
version

Published Displays currently published version
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To switch between views, click the corresponding View tab.

First Use of the View Content Difference Feature
The first time the View Content Difference screen is used on a 
client machine, a simple installation program is performed.

Click YES when the following screen appears.

When the installation program completes, close and reopen the 
View Content Difference feature.

Staged Displays the staged version of content. See Also: 
”Staged Content” on page 530

View Description
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Viewing and Restoring Previous 
Content

Past versions of published content are available unless your 
system administrator purged them. Your ability to view a content 
item’s history is determined by your user privileges.

After viewing a previous versions of content, you can replace the 
current version with any previous version.

NOTE This section explains how to view and possibly restore older versions of content. 
To see a change-by-change comparison of two content items, use the View 
Content Difference feature, explained in ”Comparing Versions of Content” on 
page 96.

NOTE The Purge History feature deletes historical versions of content according to user-
defined criteria. Therefore, some previous versions may be unavailable. See Also: 
Ektron CMS400.NET Administrator manual > “Managing Content Folders” > 
“Folder Properties” >”Purge History”

The View and Restore features are explained through the following 
subtopics.

• ”Accessing Content History” on page 102

• ”The Content History Window” on page 104

• ”Restoring a Previous Version” on page 105

• ”Comparing Historical Versions” on page 106

• ”Removing Applied XSLT” on page 106

Accessing Content History
By default, all users can view the history of Ektron CMS400.NET 
content. You can access content history from two places:

• The Workarea’s View Content page



Viewing and Restoring Previous Content

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 103

• The icon menu for content on a Web page
Once you access the history, the functionality is identical.

The following sections explains how to access the content history 
from both places.

Accessing the Content History from the Workarea
To access the history from the Workarea, follow these steps.

1. Navigate to the View Content page for the content whose 
history you want to view.

2. Click the View History button ( ).

Accessing the Content History from a Web page
To access the history for content from a Web page, follow these 
steps.

1. Sign in.
2. Browse to the content whose history you want to view.

3. Click the View History button ( ).

4. The Content History window opens.
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The Content History Window

The View Content History window lists every version of the content 
available in Ektron CMS400.NET. The window displays the following 
information for each version.

• version number See Also: ”The Content Version Number” on 
page 104

• a green circle appears next to any version that was published. 
On dates without a green circle, the content was checked-in 
but not published.

• date and time when a version was checked in or published

• title of content

• last user who edited content

• comments entered by user to describe nature of changes 
made

To view any version, click its title. When you do, the Content 
History window appears for the selected content.

The Content Version Number
Ektron CMS400.NET assigns a unique number to each saved 
version of a content block. The number is increased by one tenth if 
the content is checked in but not published. If the content is 
published, the next whole number is assigned.
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For example, if the current version is 1.0 and you check in that 
content, the new version is numbered 1.1. If the next user who 
edits that content publishes it, the new version number is 2.0.

If the content is purged, the numbering scheme restarts with the 
content that remains in the database.

The Detail History Window
After viewing the View Content History window, you can click any 
version to see the detail for it. The detailed History window has two 
sides:

• The left side redisplays the information in the content history 
window. See Also: ”The Content History Window” on page 104

• The right side displays the selected version of the content. 
After viewing a version of content, you can perform these 
actions on it.

Actions are explained below.

Restoring a Previous Version
NOTE The ability to restore content is a privilege granted by the system administrator. If 

you do not see a Restore button ( ) on the View Content History screen, you 
do not have permission to do so.

Action Button Description More Information

Restore Restore historical version of 
content

”Restoring a Previous 
Version” on page 105

View Difference Compare historical version to 
current version

”Comparing Historical 
Versions” on page 106

View History 
Report

View summary list of all versions ”The Content History 
Window” on page 104

Remove XSLT
XML Content Only

Remove XSLT applied to XML 
content

”Removing Applied XSLT” on 
page 106
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1. Select an historical version of the content that you want to 
restore from the left pane.

2. Click the Restore button ( ).

3. The content history window closes, and you return to the View 
Content page or the Web page, with the content in a checked 
in status.

4. If desired, check out the content to make additional changes.
5. Select the workflow to perform on the content.
6. When the historical version is placed in the approval chain and 

approved, it is published to the Web site.

Comparing Historical Versions
After you select an historical version of content, you can view the 
differences between it and the current version. To compare an 
historical version, follow these steps.

1. Select an historical version of the content from the left pane.

2. Click the View Differences button ( ).

The historical and the current versions are compared. To learn 
more about the comparison, see ”Comparing Versions of Content” 
on page 96.

Removing Applied XSLT
You can only remove an applied XSLT when viewing historical 
versions of XML content. If you remove the applied XSLT, you can 
view the content without the irrelevant XML tags.

The following table compares the views.
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With XSLT

Without XSLT
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Content Workflow Reports

The reports folder contains several reports to help you manage the 
workflow of content through Ektron CMS400.NET. In most cases, 
you choose a report that corresponds to the content’s status, then 
view all content in that status. If appropriate, you can perform tasks 
on selected content. For example, you can check in checked-out 
content.

This chapter explains how to access the reports folder in your 
Workarea, set criteria that determine the information on the 
reports, and actions you can perform on them.

See Also: 

• ”Accessing the Reports Folder” on page 108

• ”List of Standard Reports” on page 109

• ”Common Report Topics” on page 110

Accessing the Reports Folder
To access the Reports folder, follow these steps.

1. Log in to your Ektron CMS400.NET Web site and access the 
Workarea.

2. To access the Smart Desktop from anywhere in Ektron 
CMS400.NET, click the button in the top left corner (circled 
below).

3. Click the Reports folder.



Content Workflow Reports

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 109

4. A list of available reports appears.

NOTE The Approvals, Checked Out, and Content to Expire Reports are also available 
from the Workarea.

The reports are described below.

List of Standard Reports

Report Displays content in this 
status

For more information, see

Approvals Requiring your approval ”Approvals Reports” on page 118

Checked In Content Checked in ”Checked In Report” on page 120

Checked Out Content Checked out ”Checked Out Report” on page 120

New Content New (that is, created and saved 
but never published)

”New Content Report” on page 121

Submitted Content Submitted for publication ”Submitted Report” on page 122
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Common Report Topics
The following topics apply to the reports.

• ”Information on the Reports” on page 111

• ”Report Toolbar Options” on page 111

• ”Selecting Content by Folder” on page 112

• ”Selecting Content by Type” on page 113

• ”Sorting and Filtering Content Reports” on page 113

• ”Performing an Action on Several Content Items” on page 114

• ”Viewing/Editing Content on the Report” on page 115

• ”emailing Reports” on page 115

Pending Content Approved and pending a start date ”Content Pending Start Date Report” 
on page 123

Refresh Reminder Report End date has been reached ”Refresh Reminder Report” on 
page 124

Expired Content Expired date has been reached ”Expired Content Report” on page 125

Content to Expire Will expire within specified number 
of days

”Content to Expire Report” on 
page 125

Site Update Activity 
Content Report

Content created or updated in 
selected folders and within a 
selected date range

”Site Update Activity Report” on 
page 127

Asynchronous Log File 
Report

A log report of the Asynchronous 
process

Ektron CMS400.NET  Administrator 
manual > “Web Alert Feature” > 
“Setting Up the Message Queue and 
Asynchronous Processor” > 
“Asynchronous Log File Reporting”

Search Phrase Report Frequency of search terms ”Search Phrase Report” on page 132

Report Displays content in this 
status

For more information, see
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Information on the Reports
Each report displays the following information about its content.

Report Toolbar Options

Field Description

Title Title of content.

ID Internal number assigned to content by Ektron 
CMS400.NET .

Date Modified If a Start Date was assigned to the content, it 
appears here.

Last Editor The user who last edited the content.

Path Folder location of content.

Toolbar Button Description For more information, see

email this report to selected users ”emailing Reports” on page 115

Select a folder whose content appears on 
the report. Content in other folders is 
ignored.

”Selecting Content by Folder” 
on page 112

 Go to previous screen

 

Select the language of the content you 
want to see on the report
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Selecting Content by Folder
After viewing a report, you can select a folder and only view the 
content in that folder that satisfies the other report criteria. For 
example, the Checked in Content Report can show only content 
whose status is checked in and which resides in the Contacts 
folder.

Only content in the selected folder appears. The report does not 
include content from subfolders of the selected folder.

To select content by a folder, follow these steps.

1. From the Smart Desktop, select a report.

2. Click the Select a Folder button ( ).

Select the type of the content you want to 
see on the report

Toolbar Button Description For more information, see
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3. The top level folders appear.
4. If the folder you want is on the list, click the corresponding 

checkbox.
If the folder you want is a subfolder, click the parent folder’s 
name. A new screen appears, showing the selected folder’s 
subfolders. Click the corresponding checkbox.

5. Click the Save button ( ) to finalize your folder selection.

6. The screen displays all content items in the selected folder that 
satisfy all report criteria.

Selecting Content by Type
After viewing any report, you can select a content type and only 
view the content of that type that satisfies the other report criteria. 
For example, the Checked in Content Report can show only Office 
documents.

To select a content type, follow these steps.

1. From the Smart Desktop, select a report.
2. Use the file types pull-down to select a file type. 
3. The screen refreshes and only displays files of that type.

Sorting and Filtering Content Reports
Upon viewing a report’s content, you have additional options for 
filtering report data by user and content folder.



Content Workflow Reports

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 114

The filtering options for each content report are identical. The 
following section uses the Checked-In Content report as an 
example.

Filter by User

To display only content that was checked in by a user, click the 
name of the user in the report display. When you do, the report 
redisplays, showing only content which that user checked in.

Filter by Content Folder

To display only content checked in to a selected folder, click the 
folder on the report display. When you do, the report redisplays, 
showing only content in that folder.

NOTE You can also select a folder and view reports in that folder only. See Also: 
”Selecting Content by Folder” on page 112

Performing an Action on Several Content Items
You can perform the following actions on several or all content 
items in the Approvals, Checked in, and Checked out reports.

To select several reports, check the relevant checkboxes 
(illustrated below). To select all reports, click Select All.

Report Action you can perform

 Approvals Approve

Checked in Submit for publication

Checked out Check in
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Then, click the button at the top left to perform the action on the 
selected content items.

Viewing/Editing Content on the Report
To view (and possibly edit) any content on a report, click it. It 
appears on the View Content screen (illustrated below).

The View Content screen provides several toolbar options that you 
can perform on the content. These options are explained in ”After 
you select the content, you have the following options.” on 
page 41.

emailing Reports
You can email any report. You might do this, for example, to notify 
a user that several content items are checked out to him. All 
information in the report appears in the email. A sample appears 
below.
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You can click any content item on the report and proceed to that 
page of your Web site.

To email any report, follow these steps.

1. Display the report that you want to email.

2. Click the email button ( ).

3. A list of all users and user groups in your Ektron CMS400.NET 
appears.

NOTE Users appear fIrst in alphabetical order (by username), followed by user groups. 
The icon for user groups has two heads (see below).
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4. Click inside the checkbox of every user or group to receive a 
copy of the report.

Searching for Report Recipients

If you cannot easily find a user, a search of all users and groups is 
available. To use it, follow these steps.

1. Display the report that you want to email.

2. Click the email button ( ).

3. A list of all users and user groups in your Ektron CMS400.NET 
appears.

4. Click the Search for User button ( ).

5. The following screen appears.

6. Enter whatever information you know about the users.
7. Click the Send email button.
8. All users that satisfy the search criteria appear on a new 

screen.
9. Click the checkbox of every user or group to receive the report.
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Approvals Reports
Each content item awaiting your approval appears on this report. 
Thus, you can quickly find all such content without searching 
through every folder.

The View All Content Awaiting Approval screen displays the 
following information about this content.

Below is an example of the View All Content Awaiting Approval 
screen.

Approving/Declining Content
From the approvals report, you can approve or decline content that 
was submitted to you. The steps below explain how to do so.

Field Description

Title Title of content.

Request Type Request made for the content. Either Publish or 
Delete.

Start Date Start date, if any, assigned to the content. 
Determines when content will go live on Web 
site.

Date Modified Date the content was most recently changed

Submitted By User who submitted content for approval.

ID The ID number if the content.

Language The language of the content.

Path Path to content folder where content resides.
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Approve/Decline One Content Item

1. Access your Approvals report in the Workarea (see ”Approvals 
Reports” on page 118).

2. Click the content you want to approve or decline.
3. The View Content Awaiting Approval page is displayed.
4. Perform an action using the following table as a reference.

Approving Multiple Content Items

Button Name Description

Publish Accept changes to content and publish it to site.

Note: If there is a subsequent approver in the content’s approval chain, this 
button is replaced by a Submit button.

If you click Publish but the content item has an incomplete task assigned to 
another user, the content cannot be published. Instead, the following error 
message appears.

The user to whom the task is assigned must complete it before you can 
publish the content.

Decline Reject changes and keep current version of content live on Web site.

Edit Check out content and make changes to it if desired.

View 
Published/
Staged

Toggle between published and submitted versions of content. This can help 
you compare differences.

Back Go back to previous screen.
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See ”Performing an Action on Several Content Items” on page 114.

The selected content is either submitted to the next publisher, 
published immediately, or deleted, depending on the content’s 
approval chain.

Checked In Report
The Checked In Content report displays all the content currently in 
a checked-in status.

The report displays the following information.

Submitting Multiple Content Items
After selecting content, use the submit toolbar option ( ) to 
submit it for approval or publication, depending on your position in 
the approval chain.

Checked Out Report
The Checked Out Content report displays all content currently in a 
checked out status. 

The report displays the following information.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Date 
Modified

Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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After selecting content, check it in using the Checkin button ( ).

New Content Report
The New Content report displays content in a new state, that is, it 
was created and saved but never published. The new content 
report contains the following information.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Date 
Modified

Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web 
site.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Date 
Modified

Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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Submitted Report
The Submitted Content report displays all content in a submitted 
state. 

The report contains the following information.

Viewing Position in Approval Chain
While viewing the Submitted Content report, you can view the 
content’s position is its approval chain. You can use this 
information to contact the individuals in the chain and ask them to 
complete their approval. To do so, follow these steps.

1. From the Submitted Content Report, click the content’s title.
2. The View Content page is displayed. 
3. Click the Properties tab.
4. The content’s position in the approval chain is indicated by red 

text on the Approvals line.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Date 
Modified

Date and time content was last edited.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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Content Pending Start Date Report
The Pending Start Date Report displays all content that was 
approved, but whose start dates haven’t occurred. 

Each content item on the report contains the following information.

Editing Content with a Pending Start Date
You may edit content on the Pending Start Date Content report. To 
do so, follow these steps.

1. Click the content you want to view.
2. The View Content page is displayed.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Start Date Date and time content will go live on Web site.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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3. Using the toolbar at the top of the page, perform any action 
available.

Refresh Reminder Report
The Refresh Report displays all content whose end date has 
passed and whose archive option is set to Refresh Report. This 
content is still visible on the Web site. Its appearance on this report 
indicates that it is due for review. See Also: ”Setting Archive 
Options” on page 70

Each item on the report contains the following information.

Removing Expired Content from Site
If you review content and decide it should no longer appear on 
your site, follow these steps to remove it. The content will be visible 
if you browse to it through the Workarea, but won’t appear to site 
visitors.

1. From the Expired Content Report, click the content.

2. From the View Content screen, click the Edit button ( ).

3. Click the Schedule tab.
4. Under Action on End Date:, click Archive and remove from 

site (expire).

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

Date 
Modified

Date and time the content was last updated.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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Expired Content Report
The Expired Content report displays all content whose end date 
has passed. Such content is no longer visible on the Web site.

Each item on the list contains the following information.

Editing Expired Content
You may edit any content on the Expired Content report. To do so, 
follow these steps.

1. Click the content you want to view.
2. The View Content page is displayed.
3. Using the toolbar at the top of the page, perform any action 

available.

Content to Expire Report
The Content to Expire report lists all content whose end date will 
occur between today and a number of days that you specify. For 
example, if today is January 1 and you select 10 days, the report 
lists all content whose end date is January 1 through January 10.

After viewing the report, you can click any content and proceed to 
the View Content screen for it. From there, you can edit information 
about it, including its end date if desired.

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

End Date Date and time the content expired.

Path Folder location of content in Ektron CMS400.NET Web 
site.
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Each item on the list contains the following information.

Selecting the Report’s Date Range
To select the report’s date range, you have two options:

Column Description

Title Title of content.

ID ID number assigned to content by Ektron CMS400.NET.

Last Editor Last user to edit the content.

End Date Date and time the content expired.

Path Folder location of content in Ektron CMS400.NET Web 
site.

Option Illustration

Enter a number in the Days field. 
Then click the View Reports button 

( ).
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After selecting a number of days, click the view icon ( ) to see all 
content that will expire within that time frame.

Site Update Activity Report
The Site Activity Report provides a snapshot of the freshness of 
the content on your Web site. Specifically, it lists

• how many content items were created or updated within a date 
range you select, broken down by folder

• how many content items were not created or updated during 
that time

• the percentage of stale content (percentage of content items 
that were not created or updated during that time)

Select a number from the dropdown 
list below the Days field

Option Illustration
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A sample report appears below.

Selecting Information to Appear on the Report
To choose which content items will appear on the report, follow 
these steps.

1. By default, only content in the default language will appear on 
the report. To change the language, use the language pull-
down near the top of the screen.

2. Choose a Start Date by clicking the calendar icon ( ).
3. A calendar appears. You can move to another month or year by 

clicking it. When you get to the desired month, click inside the 
day. The selected date turns red (see below).
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4. Click Done.
5. If desired, select an End Date using the same procedure.

NOTE If you do not select an end date, the report uses today for the end date.

6. To include all content, proceed to the next step. To include only 
content in a selected folder (and possibly its subfolders), click 
Content Folder, then select any folder. See Also: ”Selecting 
Content by Folder” on page 112

7. Choose whether you want the report to display in a horizontal 
or vertical format. A horizontal format is shown in the screen 
sample above. A vertical format is below.
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8. If you want to include all subfolders under the selected folder, 
click Include Subfolders.

9. Click Get Result.

The Display of Information on the Report
The Site Activity Update Report displays the following information 
for the content that satisfies the selection criteria.

• Folder Name - the top level folder appears first, in blue, 
followed by any subfolders

- following the top-level folders are the first-level subfolders in 
alphabetical order. Their subfolders do not appear, but their 
content affects the totals for each subfolder.

• Updated Count - number of content items in each folder that 
have been created or updated within the selected date range. 
For every folder other than the top-level folder (which appears 
in blue), the count includes content items in their subfolders.
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• Non Updated Count - number of content items in each folder 
that have not been created or updated within the selected date 
range. For every folder other than the top-level folder (which 
appears in blue), the count includes content items in their 
subfolders.

• Percentage of Stale Content -The percentage of content 
items that have not been either created or updated within the 
selected date range.

• Total - Each column is summed at the bottom, except 
Percentage of Stale Content, which provides an average of 
the percentage of all folders.

Graphing the Report Data

After viewing the report results, you can display that data as a 
graph (illustrated below). The graph’s orientation is vertical or 
horizontal, depending on your response to the Report Display 
field.

To graph the results, click the graph toolbar button ( ).
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Search Phrase Report
This report displays all terms that were entered into the Search 
Text Field within a selected range of dates. You can use it to 
discover the kind of information site visitors are searching for.
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Selection Criteria
You can narrow down the search by selecting any combination of 
these criteria.

• language - the language of the search page (either Workarea 
or site search). The user performing the search can choose a 
language before inserting the search text. If he does not 
explicitly choose a language, the search uses the default one. 
This report can show results from all languages or any one that 
you select.

• a minimum number of occurrences of the word or phrase to 
return. For example, you only want words or phrases entered 
into the Search Text field at least 10 times during the last 
month.

• whether to include words or phrases entered into the site 
search (the search page that site visitors use)
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• whether to include words or phrases entered into the Workarea 
search (accessed from the View Contents of Folder screen, 
this search page is used by authorized CMS users to find 
content)

• date range

Display of Search Results
The search results show the number of times each word or phrase 
that satisfies the selection criteria appears. They are arranged in 
this order.

• words or phrases with the most occurrences appear first

• if several words or phrases have the same number of 
occurrences, they are arranged alphabetically
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Working with HTML Forms

WARNING! The functionality described in this section is not supported when using an Apple 
Macintosh for editing content. 

Ektron CMS400.NET provides powerful online form capabilities, 
allowing you to create an online dialog with visitors. Now anyone in 
your organization – not just a developer or Webmaster– can create 
and deploy Web forms to capture visitor information. Support 
marketing strategies by getting feedback on their needs. Follow up 
on their interest in your products and services. Register people for 
events.

Form capabilities include

• Creating a form and its postback message

• Adding validation criteria to form fields

• Automatically assigning tasks for follow-up activities to form 
submissions

• Reporting on form information

• Exporting results to Microsoft Excel

A sample form appears below.
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This chapter explains how to perform all form actions through the 
following topics.

• ”Overview of Form Processing” on page 137

• ”The Structure of Form Data” on page 137

• ”Accessing the Forms Folder” on page 139

• ”Creating a New Form” on page 141

• ”Creating a Form’s Content” on page 144

• ”Form Validation” on page 150

• ”Form Fields” on page 151

• ”Implementing a Form on a Web Page” on page 170

• ”Assigning a Task to a Form” on page 170

• ”Viewing Form Reports” on page 173

• ”Exporting Form Reports” on page 177
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• ”Viewing Form Information” on page 177

• ”Editing a Form” on page 183

• ”Deleting a Form” on page 185

• ”Form Module Toolbar” on page 185

Overview of Form Processing

The Structure of Form Data
Forms reside within the Forms folder or one of its subfolders (see 
example below).

Step For more information, see

1. Create a form ”Creating a New Form” on page 141

2. Assign it to a Web page ”Implementing a Form on a Web Page” on page 170

3. Site visitor goes to your Web site 
and completes form. Form is mailed 
to an email address, saved to a 
database, or both.

4. View submitted form data and 
download it to a spreadsheet.

”Viewing Form Reports” on page 173
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A form consists of the following components:

• Form (title, ID number, whether the form data is sent as email, 
and/or saved to a database, etc.)

• Content information (title, start and/or end date, status, 
postback message, etc.)

• Form fields (plain text field, password field, text area, hidden 
text, choices, checkbox, select list, calendar, submit button, 
etc.)

Form Folders and Content
Before creating a form, select the Forms folder then select an 
existing folder or create a new folder. (The ability to create a new 
folder is a permission.) If you create a new subfolder, a 
corresponding folder is automatically created in the Content folder.

IMPORTANT! Technical note for developers: Any folder that contains forms must use a template 
that contains the formblock server control or function. For more information, see 
the Ektron CMS400.NET Administrator Manual section ”Working with HTML 
Forms” > “Forms Must Use Template with FormBlock Server Control.”
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Within the folder, you create the form, and then content within it. To 
work with the form later, return to the Forms folder and select it.

You cannot see or update the form from the corresponding content 
folder. However, your Webmaster uses the corresponding content 
folder to assign permissions and an approval chain. See Also: 
Ektron CMS400.NET Administrator Manual section ”Working with 
HTML Forms” > “Form Permissions”

Accessing the Forms Folder
To access the Forms folder, follow these steps.

1. Navigate to the Workarea.
2. Click the Forms button in the left frame.
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3. Navigate to the folder whose forms you want to work with, or in 
which you want to create a new form.

IMPORTANT! The folder’s template must use a formblock server control or function. See Also: 
”Form Folders and Content” on page 138

4. The View Forms of Folder screen appears. Note that its folder 
structure matches the Content folder.

The screen has the following toolbar buttons. Click one to begin 
that action.

See Also: ”Working with HTML Forms” on page 135

Button Name Description More Information

Add form Create new form ”Creating a New Form” on page 141

Add folder Create new subfolder beneath 
current one. This folder ‘s template 
must use a Formblock server control 
or function. See Also: ”Form Folders 
and Content” on page 138

”Adding Subfolders” on page 63

Search folder Look for forms in current folder that 
satisfy user-specified criteria

”Searching the Workarea” on 
page 55

Archive View archived forms in this folder ”Setting Archive Options” on 
page 71
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Creating a New Form
The screen you use to create a new form is broken down into five 
simple steps. After you complete all steps, you will have a new 
form that’s ready to collect whatever information you need. To 
make the task even easier, Ektron CMS400.NET provides sample 
forms that you can start with then customize.

As explained in ”Mailto or Database Form” on page 184, form data 
can be emailed and/or saved to a database. Forms created using 
the procedure described below are saved to a database by default, 
but not emailed. To change either setting, use the Edit Properties 
screen. See ”Editing a Form’s Properties” on page 184.

To create a new form, follow these steps.

NOTE You can also create a new edition of a form in another language by copying an 
existing form and translating it. For more information, see ”Translating Content” 
on page 923.

1. Access a Forms folder, as described in ”Accessing the Forms 
Folder” on page 139.

2. From the language drop-down, select the language in which to 
create the form.

3. Click the Add Form button ( ). The New Form screen 
appears.
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4. Choose the form that you want to begin with. You can click the 
preview icon ( ) next to any sample form to preview it before 
choosing it.
You should select the sample that most closely matches the 
form you want to create. After you create it, you can add fields, 
remove fields, modify possible responses, etc.

5. Click the Next button.
6. Enter or edit the form’s Title and Description.

• Title - used to reference the form within the Workarea 
(required)

• Description - an extended description of the form

7. The next screen lets you assign a task to a user or user group. 
If you do, a task will be created every time a site visitor submits 
this form. See Also:  ”Assigning a Task to a Form” on page 170

8. A new screen lets you determine what happens after the site 
visitor completes the form. The choices are:

• Display a message - See ”Composing the Postback 
Message” on page 143
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• Redirect to a file or page - Identify a file or a page on your 
Web site that is launched when the visitor completes the 
form

- An example of a file is a white paper (a common file 
format is .PDF) that the visitor requested

- An example of a page is one that lets the visitor 
download your product

• Redirect to an action page and forward form data - Use 
this option to redirect posted form data to an action page. The 
action page must satisfy these criteria:

- its extension must be .aspx

- it must reside in the current domain

- its path must not be fully qualified
The posted data is saved to the database before it goes to the 
action page.

9. Now that you have completed information about the form, you 
can enter the form’s content. This procedure is described in 
”Creating a Form’s Content” on page 144.

Composing the Postback Message
The postback message can contain text or graphics, just like any 
other HTML content. Typically, it acknowledges the site visitor’s 
completion of the form.

For most sample forms provided, sample text appears in the editor. 
Modify it as you wish, using Ektron CMS400.NET’s editor to change 
the font size, style, color, insert library items, etc.

You can also insert fields that retrieve form information upon its 
submission. Use the Insert Fields pull-down to do this (illustrated 
below).
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All form fields appear on the list. In addition, the following fields can 
be used to insert form information into the postback message, 
although they’re not completed by the person submitting the form.

• Form title

• Form description

• Date form was submitted by site visitor

For example, your postback message may be

Thank you «Full Name» for completing the «[Form Title]».

When the postback message appears, it looks like this.

Thank you Jay Kohler for completing the breakroom survey.

Creating a Form’s Content
Here is an example of form content that you can create.
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Note that some fields are required, and some provide a dropdown 
list of choices. You can learn how to create such a screen by 
following the directions below.

The Form Toolbar Options
Creating form content is similar to creating a standard content 
item. (See ”Adding HTML Content” on page 578). The big 
difference is a special toolbar (illustrated below) to make it easier 
to insert form elements.
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All toolbar options except the Select Button pull-down also appear 
on a vertical toolbar to the left of the editor. You can use whichever 
toolbar you prefer -- all options are the same.

Adding a Field to the Screen

The major difference between the toolbars is how you add a field to 
the screen. If you are using the horizontal toolbar, place the cursor 
where you want field, and click the toolbar button.

When using the vertical toolbar, drag a button to the desired 
screen location.

Note that a context-sensitive menu, available by right clicking the 
mouse, is also available to perform these actions. You can right 
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click the mouse then select Insert Field to display a context-
sensitive menu of all commands.

Inserting Form Fields
The final screen of the Forms setup lets you arrange the screen so 
that it collects exactly the information you want. To create the 
screen, you insert fields that prompt a site visitor to enter 
information. Then, add buttons that let the user submit the data on 
the screen.

If you chose a sample form at the beginning, the screen includes 
fields. If you did not, the screen has only a Submit button.

NOTE In addition to inserting fields, you can add explanatory text, lines, images, etc. 
onto the form screen. If you want to place fields in columns, insert a table and 
place the fields within table cells.

The table below explains each field type you can enter.
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10. After you complete the form, you have the following options.

Button Inserts this 
kind of field

Description For more information, see

Checkbox User’s response is either checked or 
unchecked

”Inserting a Checkbox Field” on 
page 151

Hidden Text 
Field

Information a site visitor doesn’t 
need to know about

”Inserting a Hidden Text Field” on 
page 152

Text Field Free text field; user cannot format 
text

”Inserting a Text Field” on page 153

Password A password field ”Inserting a Password Field” on 
page 157

Text Area Same as Text Field except field 
scrolls vertically to accept more text

”Inserting a Text Area Field” on 
page 159

Choices Several choices appear on screen. 
User checks any number of 
appropriate boxes.

”Inserting a Choices Field” on 
page 161

Select Same as Choices except options 
appear in a drop-down box, and site 
visitor can only select one choice

”Inserting a Select List Field” on 
page 165

Calendar Lets user insert a date by clicking a 
calendar

”Inserting a Calendar Field” on 
page 168

Button or Tab Description

Postback Message See ”Composing the Postback Message” on page 143

 Metadata Edit the metadata for the content. See Also: ”Metadata” on 
page 601

Schedule Assign start or end dates, or both, for when content is published to 
Web site See Also: ”Scheduling Content to Begin and End” on 
page 67
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Next, click the Save and Submit or Publish button ( ). The form 
only appears on your Web site after it is published.

After that, the form may need to go through the approval process. 
When that is complete, add it to the site by assigning it to a page 
template. See ”Implementing a Form on a Web Page” on 
page 170.

Comment Enter history comment to indicate changes made to content

Web Alerts Assign or update Web Alert information for the form. See the 
Ektron CMS400.NET  Administrator Manual chapter “Web Alert 
Feature.”

 Submit
Submit content into approval process.

 Publish
Publish content to Web site.

Note: If the content has any active tasks, a comments window 
pops up. You can insert comments to describe how approving or 
declining the content affects the task.

Note: Only the last approver in the approval chain sees this button.

 Check In
Save and check-in content. This button does not submit the 
content into the approval process, but rather lets other users 
change it.

 Save
Save the content without submitting it into the approval process.
If a user clicks save and then closes the editor, other users cannot 
edit the content.

 Decline
This buttons appears if you are the next approver in the approval 
list. Click it to decline the changes made to the content.

Note: If content has any active tasks, a comments window pops 
up. You can insert comments to describe how approving or 
declining the content affects the task.

 Cancel
Close the editor without saving changes.

Button or Tab Description
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Form Validation
You can apply validation rules while creating or editing the 
following field types:

• text

• password

• textarea

• calendar

Validation rules ensure that the form information entered by site 
visitors meets your criteria. For example, a validation rule can 
specify that a site visitor’s response to the Telephone field 
conforms to a standard format (for example, 7 or 10 digits). If the 
response does not conform, an error message informs the site 
visitor of the problem. The input must conform before the form can 
be submitted.

For a list of validation rule types, see ”Validation Options” on 
page 155.

When Validation Rules are 
Applied

Validation rules are applied when a site visitor submits an entire 
form, not as soon as the input is entered. If invalid input is found, 
the error message that you define appears.

The site visitor must change his response to conform to the 
validation rule. When he does, the next field is checked and, if that 
is invalid, its error message appears, etc.

TIP! If you apply validation rules to more than one field, include the field name in the 
error message. For example, enter The name field only allows text. This is 
good practice because error messages only appear after the form is submitted 
and, if the message does not identify the field, the user may not know which field 
needs correction.



Working with HTML Forms

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 151

Form Fields

Inserting a Checkbox Field
A Checkbox field is only one character wide and accepts one of 
two possible values: checked or unchecked. For example

To insert a checkbox field, follow these steps.

1. Place a checkbox type field  onto the screen. See Also: 
”Adding a Field to the Screen” on page 146

2. The following dialog appears.

Fields on the Checkbox Dialog

Field Description

Name Enter the name of the field.
Note that you cannot enter spaces nor most special 
characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field.
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Inserting a Hidden Text Field
When the form is submitted, this field can pass information that the 
site visitor doesn’t need to know about, such as a tracking number. 
This is typically data to be stored in the database and/or emailed 
along with the rest of the data.

To insert a hidden text field, follow these steps.

1. Place a hidden text field  onto the screen. See Also: 
”Adding a Field to the Screen” on page 146

2. The following dialog appears.

Tool Tips Enter text that appears when a site visitor hovers the 
cursor over this field (circled in red below).

Default 
value

If you want this field to be checked when the screen first 
appears, click True.
Otherwise, click False.
Regardless of the default value, the site visitor can 
change it while completing the screen.

Field Description
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Fields on the Hidden Text Field Dialog

Inserting a Text Field
Use a plain text field when you want the user to enter an 
unformatted, free text response. 

To insert a plain text field, follow these steps.

1. Place a plain text field  onto the screen. See Also: ”Adding 
a Field to the Screen” on page 146

2. The following dialog appears.

Field Description

Name Enter the name of the field.
Note that you cannot enter spaces nor most special 
characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field.

Tool Tips Enter text that appears when a site visitor hovers the 
cursor over this field.

Value Enter the value that will be saved with this field when the 
form is submitted.
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Fields on the Plain Text Field Dialog

Field Description

Name Enter the name of the field.
Note that you cannot enter spaces nor most special 
characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field.

Tool Tips Enter text that appears when a site visitor hovers the 
cursor over this field.

Default 
value

If you want to set a default value for this field, enter it 
here. For example, if this field collects a city, and most 
users enter New York, enter New York as the value.
Regardless of the default value, the site visitor can 
change it while completing the screen.
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Validation Options

NOTE Your Web developer can customize validation options. For details, see the 
Ektron CMS400.NET Developer’s Guide section “Customizing Validation.”

Validation Select the kind of validation to apply to this field. See 
”Validation Options” on page 155
If you assign to this field any value other than No 
validation, the field is initially surrounded by red dashes 
in Data Entry mode. If the user’s response does not 
meet the validation criterion, the field remains 
surrounded by red dashes. The system administrator 
determines whether or not the user can save an invalid 
document.

Error 
Message

Enter text that appears on the screen if the site visitor‘s 
response to this field does not satisfy the validation 
criterion. 
For example, if the validation criterion is telephone 
number, the error message could be Please enter 7 or 
10 digits. It would appear if the user entered, for 
example, S061882.
By default, the error message is the same as the 
validation criterion you choose. You can use this field to 
customize its text.

Field Description

Option Characteristics of Valid Response

No validation Response is not checked.

Cannot be blank Response is required. The format of the response is not checked.

Non-negative whole number or 
blank

 A positive whole number or no response.

Non-negative whole number 
(required)

 A positive whole number.
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Decimal number or blank A decimal number (for example, 12.345 or 12) or blank . A leading 
minus sign “-” is allowed. The decimal point must be a period (.), 
even in locales that normally use a comma (,).

Decimal numbers include whole numbers because the decimal point 
is implied. That is, 12 is 12.0000.

Decimal number required A decimal number (it cannot be blank) of none, one, or two decimal 
places. 
A leading minus sign “-” is allowed. The decimal point must be period 
(.), even in locales that normally use a comma (,).

Decimal numbers include whole numbers because the decimal point 
is implied. That is, 12 is 12.0000.

Percent: (0-100) required A whole number from 0 to 100.

email address a@a.a, where a is one or more characters.

email address list Several email addresses. Each address’s format is a@a.a, where a 
is one or more characters. The user must separate each address 
with a semicolon (;).

Zip code (US) 5 (nnnnn) or 9 digits separated by a dash after the fifth (nnnnn-nnnn).

Zip code (US) required 5 (nnnnn) or 9 digits separated by a dash after the fifth (nnnnn-nnnn). 
A response is required.

Social Security (US) Nine digits in this pattern: nnn-nn-nnnn.

Social Security (US) required Nine digits in this pattern: nnn-nn-nnnn. A response is required.

Postal Code (Canada) ana nan, where a is an alphabetic character and n is numeric.

Postal Code (Canada) - 
(required)

ana nan, where a is an alphabetic character and n is numeric. A 
response is required.

Social Insurance Number 
(Canada)

A nine digit number in the format: nnnnnnnnn.

Social Insurance Number 
(Canada) Required

A nine digit number in the format: nnnnnnnnn. A response is 
required.

Option Characteristics of Valid Response
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Inserting a Password Field
Use a password field when you want the user to enter a password. 
A password is like a text field but the user’s entry appears as dots 
instead of characters. This prevents an onlooker from seeing the 
password. A user’s password entry cannot exceed 18 characters.

To insert a password field, follow these steps.

1. Place a plain text field  onto the screen. See Also: ”Adding 
a Field to the Screen” on page 146

2. The following dialog appears.

Telephone number (US and 
Canada)

A seven or 10 digit number in the format nnnnnnn or nnnnnnnnnn.
The site visitor can insert separator characters, such as dashes (-), 
between numbers.

Telephone number (US and 
Canada) (required)

A seven or 10 digit number in the format nnnnnnn or nnnnnnnnnn.
The site visitor can insert separator characters, such as dashes (-), 
between numbers.
A response is required.

Option Characteristics of Valid Response
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Fields on the Password Dialog

Field Description

Name Enter the name of the field.
Note that you cannot enter spaces nor most special 
characters (!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field.

Tool Tips Enter text that appears when a site visitor hovers the 
cursor over this field.

Default 
value

If you want to set a default value for this field, enter it 
here. Regardless of the default value, the site visitor can 
change it while completing the screen.
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Inserting a Text Area Field
Use a text area field when you want the site visitor to enter an 
unformatted, free text response. A text area field is similar to a Text 
Field except it scrolls vertically to accept more text.

To insert a text area field, follow these steps.

1. Place a text area field  onto the screen. See Also: ”Adding a 
Field to the Screen” on page 146

2. The following dialog appears.

Validation Select the kind of validation to apply to this field. The 
choices are:

• No validation - response is not checked

• Cannot be blank - Response is required. The for-
mat of the response is not checked.

• Minimum of 8 characters with at least one digit - 
Site visitor’s entry must be at least 8 characters and 
include one digit.

If you assign to this field any value other than No 
validation, the field is surrounded by red dashes when 
it appears on your Web site. 

Error 
Message

Enter text that appears on the screen if the site visitor‘s 
response to this field does not satisfy the validation 
criterion.
For example, if the validation criterion is Minimum of 8 
characters with at least one digit, the error message 
could be Please enter at 8 or more characters with at 
least one digit.
By default, the error message is the same as the 
validation criterion you choose. You can use this field to 
customize its text.

Field Description
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Fields on the Textarea Dialog

Field Description

Name Enter the name of the field.
Note that you cannot enter spaces nor most special characters 
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field.

Tool Tips Enter text that appears when a site visitor hovers the cursor over this field.

Default 
value

If you want to set a default value for this field, enter it here. For example, if this 
field collects a city, and most users enter New York, enter New York as the 
value.
Regardless of the default value, the site visitor can change it while completing 
the screen.
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Inserting a Choices Field
Use a Choices field when you want the site visitor to select from a 
predetermined list of choices. You can allow the site visitor to 
select only one or more than one choice. You can also determine 
the list of choices and the appearance of the list.

To insert a choices field, follow these steps.

1. Place a choices field  onto the screen. See Also: ”Adding a 
Field to the Screen” on page 146

2. The following dialog appears.

Validation Select the kind of validation to apply to this field. The choices are:

• No validation - response is not checked

• Cannot be blank - Response is required. The format of the response is 
not checked.

• Allow maximum of 1000 characters - Site visitor’s entry cannot exceed 
1000 characters.

If you assign to this field any value other than No validation, the field is 
surrounded by red dashes when it appears on your Web site.

Error 
Message

Enter text that appears on the screen if the site visitor‘s response to this field 
does not satisfy the validation criterion. 
For example, if the validation criterion is Cannot be blank, the error message 
could be Please enter a response. 
By default, the error message is the same as the validation criterion you 
choose. You can use this field to customize its text.

Field Description
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Fields on the Choices Dialog

Field Description

Name Enter the name of the field.
Note that you cannot enter spaces nor most special characters 
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field.
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Tool Tips Enter text that appears when a site visitor hovers the cursor over this field.

List Custom - You create your own set of choices. Use the Item and Item List 
fields to do this.

Note: If, after seeing the following predefined choices, you want to customize 
the choices available to site visitors, return to this field, replace the value with 
Custom, then define the ranges you want in the Item field.

Age Ranges - Use the predefined choices for age ranges. You can see the 
ranges on the screen after you choose this option.
Numeric Ranges -Use the predefined choices for numeric ranges. You can 
see the ranges on the screen after you choose this option.
Gender -Use the predefined choices for gender. You can see the values on 
the screen after you choose this option.
Marital Status - Use the predefined choices for marital status. You can see 
the values on the screen after you choose this option

Allow 
Selection

Click More than one to allow the site visitor to select more than one item on 
the data entry screen. Otherwise, click Only one.
For example, if you click More than one, and the choices are: music, art, 
sports, the user could select all three choices.
If you click Only one, the user could only select one choice.
A selection is required - Check this box if the user must select at least one 
item in the list.

Field Description
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Appearance Click Vertical List to arrange the choices vertically.

Click Horizontal List to arrange the choices horizontally.

Click List Box to display all choices in a box. The box lengthens to display all 
entries.

Item:
Value

Enter the value that is collected when the data entry user selects this item.
For example, if Interests appears in the Name field, and you want music to be 
collected when the data entry user selects this item and saves the page, enter 
music here.

Item:
Text

Enter text to describe this item on the data entry screen.
After you insert this field onto the screen, you can use eWebEditPro+XML ’s 
formatting capabilities to modify its size, font, color, and other attributes.

Item List This section of the screen displays the items that you enter in the Value and 
Text fields.
Buttons near the bottom of the screen let you remove items from this list as 
well as rearrange them.

Place a check in the box of any item to be checked by default on the data 
entry screen. If you do, the user can accept the default or uncheck the item by 
clicking in the checkbox. Note that if Only One is selected under Allow 
selection (above), only one item can be selected.

Field Description
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Inserting a Select List Field
Use a Select List field when you want the site visitor to select from 
a predetermined list of choices. Although similar to the choices 
field, when you insert a Select List field, the site visitor only sees 
the first option in a drop down box.

He must click the down arrow to see the remaining values and 
select one.

So, the Select List field occupies less room on the screen than a 
choices field. Also, the site visitor can only choose on item on the 
list. In contrast, you can allow a visitor to select several choices if 
you use a choices field.

To insert a Select List field, follow these steps.

1. Place a Select List field  onto the screen. See Also: 
”Adding a Field to the Screen” on page 146

2. The following dialog appears.
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Fields on the Select List Field Dialog

Field Description

Name Enter the name of the field.
Note that you cannot enter spaces nor most special characters 
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field.

Tool Tips Enter text that appears when a site visitor hovers the cursor over this field.
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Customizing a Standard List

List Custom - You create your own set of choices. Use the Item and Item List 
fields to do this.
See Also: ”Customizing a Standard List” on page 167
Languages - list of languages supported by Windows
Countries - list of all countries in the world
U.S States and Territories - list of all states and territories that make up the 
U.S.
Canadian Provinces - list of all Canadian provinces
Age Ranges - Use the predefined choices for age ranges. You can see the 
ranges on the screen after you choose this option.
Numeric Ranges -Use the predefined choices for numeric ranges. You can 
see the ranges on the screen after you choose this option.
Years - list of calendar years, ranging from 2004 to 2014

Item:
Value

Enter the value that is collected when the data entry user selects this item.
For example, if Interests appears in the Name field, and you want music to be 
collected when the data entry user selects this item and saves the page, enter 
music here.

Item:
Text

Enter text to describe this item on the data entry screen.
After you insert this field onto the screen, you can use eWebEditPro+XML ’s 
formatting capabilities to modify its size, font, color, and other attributes.

Item List This section of the screen displays the items that you enter in the Value and 
Text fields.
Buttons near the bottom of the screen let you remove items from this list as 
well as rearrange them.

Place a check in the box of any item to be checked by default on the data 
entry screen. If you do, the user can accept the default or uncheck the item by 
clicking in the checkbox.

First item is 
not a Valid 
Selection

Check here if the first item on the list is not a valid value but instead text that 
prompts the user to respond to the field. An example of such text for a list of 
states would be Select a state.
If you check this box and the user selects the first value on the list (most likely 
by default), an error message appears when he tries to save the screen.

Field Description
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You can customize any list of predefined choices. For example, 
you can change the calendar years so they begin in 1995 and run 
through 2020. 

To do this, follow these steps.

1. Choose the standard list that you want to customize.
2. Change the value of the List field to Custom.
3. All of the predefined choices appear in the Item List box.
4. To 

• add new items, use the Item Value and Text fields

• delete an existing list item, select it and click Remove
• rearrange the list, use the Move Up and Move Down 
buttons

• edit a list item, select it and press the Change button

Inserting a Calendar Field
To insert a field that lets a site visitor select a date, use a Calendar 
Field. To do that, follow these steps.

1. Place a Calendar field ( ) onto the screen. See Also: 
”Adding a Field to the Screen” on page 146

2. The following dialog appears.
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Field Description

Name Enter the name of the field.
Note that you cannot enter spaces nor most special characters 
(!@#$%^&*()+=<>,.:;’"{}[]|‘~) into this field.

Tool Tips Enter text that appears when a site visitor hovers the cursor over this field.

Default 
value

If you want to set a default value for this field, enter it here. For example, if this 
field collects a city, and most users enter New York, enter New York as the 
value.
Regardless of the default value, the site visitor can change it while completing 
the screen.

Validation Select the kind of validation to apply to this field. The choices are:

• No validation - response is not checked

• Cannot be blank - Response is required. The format of the response is 
not checked.

If you assign Cannot be blank, the field is surrounded by red dashes when it 
appears on your Web site.
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Implementing a Form on a Web Page
After you create the form, you need to link it to another page on 
your Web site. You would insert the link as you would any form link. 
See ”Adding a Library File to Content” on page 206

Next, open your Web Site, navigate to the host page, and click the 
hyperlink to access the form. Now, you can test the form and make 
sure it works as you expected. If needed, you can return to edit 
mode, change the form, and test it again until you are happy with it.

Assigning a Task to a Form
While tasks typically help Ektron CMS400.NET users track content 
activities, you can also assign a task to users or user groups 
whenever a form is submitted.

For example, your Web site offers a free product demonstration to 
anyone who completes a form. Whenever a site visitor submits the 
form, a task is assigned to your sales department’s administrative 
assistant. He uses the information collected by the form to 
schedule a demonstration. The sales manager can review the task 
history to audit sales leads and ensure demonstration requests are 
being handled in a timely manner.

To set up a task that it is assigned to users or groups whenever a 
site visitor completes the form, follow these steps.

NOTE You should be familiar with tasks before beginning this procedure. See Also: 
”Managing Tasks” on page 331

1. If you are creating a new form, assign the task at Step 5 of the 
Forms Wizard.

Error 
Message

Enter text that appears on the screen if the site visitor‘s response to this field 
does not satisfy the validation criterion.
For example, if the validation criterion is Cannot be blank, the error message 
could be Please enter a response.
By default, the error message is the same as the validation criterion you 
choose. You can use this field to customize its text.

Field Description
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If you are editing a form, assign the task on the form’s Edit 
Properties screen.
In both cases, you identify only users and groups to whom the 
task will be assigned whenever a site visitor completes the 
form. Ektron CMS400.NET assigns the remaining task 
information.

2. You complete the form and make it available on your Web site.
3. A visitor to your site fills out and submits the form.
4. A task is created and assigned to users and groups you 

identified in Step 1.
5. Any Ektron CMS400.NET user can view all tasks created via 

form submission in the Smart Desktop. See illustration below. 
See Also: ”Understanding the Smart Desktop” on page 20
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Ektron CMS400.NET users and administrators can also view and 
update tasks assigned to them via the Task screens on the Smart 
Desktop. See ”Viewing a Task” on page 343 and ”Viewing a Task’s 
History” on page 353.

Task Information
The task created upon form submission has the following 
information.

email Automatically Generated Upon Form Submission
Also, an email is automatically sent to every user named in Step 1 
above who has a valid email address in the User Information 

Field Value

Title Form title, as entered by the author

Assigned to As set up by the user who created or edited the form 

Assigned by User who created or last edited form

Priority Normal

Task 
Category

Form Submission Task Category

Task type Form Submission Task

Created by User who created or last edited form

 State Not started

 Due date Not specified

Start date Not specified

Description Data from form “form name” was received on date time.
form description
Name of every field on the form: value submitted by 
user into that field
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Screen. The email’s subject line is the form name. The body of the 
email contains the following information for each field on the form.

• name

• value submitted by user

Viewing Form Reports
If a form is set to store data in the database, you can run a report 
that displays the submitted data. To view a form report, follow 
these steps.

1. Access the Forms folder, as described in ”Accessing the Forms 
Folder” on page 139.

2. Navigate to the folder for which you want to view the report.
3. The Form Modules screen appears.
4. Click the form you want to view.
5. The View Form screen appears.

6. Click the View Reports button ( ).

7. The View Forms Report screen appears.
8. Enter report criteria using the following table as a reference.

9. Click the Get Result button to display the report.

Field Description

Start Date If desired, specify a start date. The report displays 
only forms that were submitted on or after the start 
date.

End Date If desired, specify an end date. The report displays 
only forms that were submitted on or before the 
end date.

Report Display Choose to display the report horizontally or 
vertically.

Data Type Specify the data type to filter the report by.
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Display Formats
Table of Values

The table of values shows the following information for each 
completed form.

• a checkbox that lets you delete the response

• an internal identification number of the response

• date response was submitted

• descriptive name of each form field appears in the column 
header

- the value entered for each field appears below the header

List of Submitted Values

The List of Submitted Values format provides the same information 
as the Table of Values, but is formatted vertically rather than 
horizontally. See Also: ”Table of Values” on page 174
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Survey Results

Survey Results total, for choice and select type fields, the number 
of times each choice was selected. 
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Contact Information
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Exporting Form Reports
After you run a report, you can export its data to a Microsoft Excel 
spreadsheet file (.xls) for further analysis. If a form uses an XML 
structure, each XML tag becomes a column header in the 
spreadsheet.

To export form data, follow these steps.

1. Access the View Form Reports screen for the report you want 
to export, as described in ”Viewing Form Reports” on 
page 173.

2. Click the Export Reports button ( ).

3. A File Download dialog box is displayed. Choose the option 
that best suits your needs.

4. After the data is exported, you can analyze and modify the .xls 
file.

Viewing Form Information
You can view 

• information about a form

• information about a form’s properties

Viewing a Form’s Information
After a form is created, you can view its information in the Forms 
folder. To view a form, follow these steps.

1. Access the Forms folder, as described in ”Accessing the Forms 
Folder” on page 139.

2. Click the form you want to view.
3. The View Form screen displays. The following table explains 

the information on the screen.

Field Description

Form Title Title used to reference the form
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The View Form screen also contains several buttons to perform 
actions. To learn about the buttons, see ”Form Module Toolbar” on 
page 185.

Viewing and Editing a Form’s Properties
To see and update additional form information that does not 
appear on the View Form screen, view its properties. To do so, 
follow these steps.

FormID ID number automatically assigned to form

Status The form’s current status

Description Extended description for the form

Form Data The type of form data: Mail or Database. See Also: ”The 
Structure of Form Data” on page 137

Assign Task to Users and groups to whom a task will be automatically 
assigned whenever a site visitor completes the form. See 
Also: ”Assigning a Task to a Form” on page 170

Content 
Properties

Displays the properties of the form’s content

Content Title Title of content associated with form

Note: The content name is the same as the Form name. 

Content ID Content ID number assigned to content

Status The status of the content

Last Editor Last user to edit the content

Start Date Date and time when the content will go live on the Web site 
(if set for a future date)

End Date Date and time when the content will be removed from the 
Web site (if set for a future date)

Date Created Date and time when content was created

Field Description
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1. Navigate to the View Form screen of the form whose properties 
you want to view, as described in ”Viewing and Editing a 
Form’s Properties” on page 178.

2. Click the Form Properties button ( ).

3. The Form Properties screen displays a subset of form 
information.

• Title and Description

• Database or Mail - if form data is emailed whenever a site 
visitor submits it, enter mail property information below. See 
”Mail Properties” on page 179

• Assign task to - see ”Assigning a Task to a Form” on page 170

• Form block’s ID number

• Mail Properties - see ”Mail Properties” on page 179
Mail Properties

.

Field Description

To Email address to which the form is sent when submitted. 
See Also: ”Retrieving email Address from the Submitted 
Form” on page 180

From Text that appears in the email’s From field. See Also: 
”Retrieving email Address from the Submitted Form” on 
page 180

CC Text that appears in the email’s CC field. See Also: 
”Retrieving email Address from the Submitted Form” on 
page 180

Subject Text that appears in the email’s subject field. See Also: 
”Retrieving Form Data Into the Subject and Preamble 
Fields” on page 182

Preamble Beginning text of the email. See Also: ”Retrieving Form 
Data Into the Subject and Preamble Fields” on page 182
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Retrieving email Address from the Submitted Form

In the Mail Properties section of the Edit Form screen, you can 
select email addresses submitted on the form to be inserted into 
any of these Mail Property fields:

• To

• From

• CC

So, instead of entering a static email address, it can be 
dynamically retrieved from the user’s form submission. For 
example, you want to retrieve the “from” field of an email from the 
information the user enters when completing the form.

To do this, use the OR to addresses in field dropdown lists circled 
below. These lists contain fields that dynamically retrieve data from 
the submitted form.

Send data in XML 
Format

A green check means email data will be in a structured XML 
packet.
A red X means the email data will be in a standard mailto 
format.
For more information, see “Sending Data as XML” in the 
Ektron CMS400.NET Administrator Manual Forms chapter.

Field Description
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Note that the To and CC fields can accept fields whose validation 
type is email address or email address list. On the other hand, 
the From field can only accept fields whose validation type is 
email address (that is, a single email address).

To set this up, follow these steps.

1. Add a form field whose Validation type is Email address or 
Email address list . The field prompts the user completing the 
form to enter his email address. Label the field something like 
Enter your email address.

TIP! If the field allows more than one address, add on-screen instructions to separate 
each address with a semicolon (;).
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2. Go to the Edit Form screen > Mail Properties section.
3. Move to the field labeled From:.
4. At the dropdown list following OR to addresses in field, select 

the field you created in Step 1.
Now, when a user completes the form, the value he enters in the 
field created in Step 1 is used for the email’s From address.

Retrieving Form Data Into the Subject and Preamble Fields

You can retrieve data from a submitted form directly to the form’s 
Subject and Preamble fields. (The subject is a standard mail field, 
and the preamble is text that appears at the beginning of the 
email.)

For example, the form may provide a list of your products. While 
the user is completing the form, he selects a product that he is 
interested in. The product then becomes the subject line of the 
email.
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NOTE Since a Textarea field can span multiple lines, it can only be used with the 
preamble. However, a plain text field can be used with both the subject and 
preamble.

To retrieve data dynamically from a form field into the email’s 
subject line or preamble, follow these steps.

1. Add a form field that collects the information you want to insert 
into the email’s subject line or preamble. See Also: ”Inserting 
Form Fields” on page 147

2. Go to the Edit Form screen > Mail Properties section. See 
Also: ”Editing a Form” on page 183

3. Move to the field labeled Subject or Preamble.
4. At the dropdown list following OR use text in field, select the 

field you created in Step 1.

Editing a Form
After you create a form, it can easily be edited if information needs 
to be changed. You can update the following information by 
following the procedure below.

• the form fields

• post back message

• metadata

• schedule

• comments

• Web Alerts

However to edit a form’s Title, Description, form data, or task 
values, use the Edit Properties screen.

To edit a form, follow these steps.

1. Access the View Form screen for the form you want to edit, as 
described in ”Viewing and Editing a Form’s Properties” on 
page 178.

2. Click the Edit Form button ( ).
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3. The Edit Form screen is displayed. The screen is the same as 
the Add New Form screen. For documentation of individual 
fields, see ”Creating a New Form” on page 141.

4. Make the necessary changes to the form.

5. Click the Save button ( ).

See Also: ”Working with HTML Forms” on page 135

Editing a Form’s Content
You can edit the content associated with the form by a variety of 
methods, including:

• Accessing the content by the floating toolbar on the Web page

• Editing the content by the View Form screen

• Accessing the content by the View Form content properties 
screen

This section explains how to edit a form’s content from the View 
Form screen. To edit a form’s content, follow these steps.

1. Access the View Form screen for the content, as described in 
”Editing a Form’s Content” on page 184.

2. Click the Edit Content button ( ).

3. The Edit Content screen appears.
4. Make the necessary changes to the form’s content.
5. If needed, click the Postback Message, Metadata, Schedule, 

Comment or Web Alerts tab to edit that information.
6. Click a workflow button (Submit for Publication or Publish).

Editing a Form’s Properties
See ”Viewing and Editing a Form’s Properties” on page 178

Mailto or Database Form
The Forms feature lets you create a mailto or a database form to 
use on your Web site. When creating or editing a form, you must 
specify the type of form you are creating. The options are:



Working with HTML Forms

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 185

• Send it via email

• Store it in a database

• Send it via email and store in a database

See ”Viewing and Editing a Form’s Properties” on page 178 for 
information about toggling this option on and off.

Advantages of a Mailto Form

By creating a mailto form, any email generation is done on the 
server-side, not on the client. This means that site visitors can 
submit email whether or not the client has email software.

Storing Form Data in a Database

By storing form data in the Ektron CMS400.NET database, you 
can keep information submitted by site visitors and view reports on 
that information. You can also export the form data to a 
spreadsheet.

Deleting a Form
You can easily delete forms that are no longer needed.

NOTE Deleting a form also deletes its associated content and information.

To delete a form, follow these steps.

1. Access the View Form screen for the form you want to delete, 
as described in ”Accessing the Forms Folder” on page 139.

2. Click the Delete Form button ( ).

3. A confirmation message is displayed.
4. Click OK.

Form Module Toolbar
Several toolbar buttons and tabs help you work with forms.
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To learn about toolbar buttons available when creating or editing a 
form, see “Inserting Form Fields” on page 147.

Button or 
Tab

Name Description More Information

Edit Content Edit the form’s content, which 
contains the form fields

”Editing a Form’s 
Content” on page 184

View Staged/
Published Content

Click View Staged button to view 
content that has not yet been 
published.
Click View Published button to view 
content that is live on the Web site.

View History View (and possibly restore) older 
versions of a content block

”Content History” on 
page 594

View Difference Compare two versions of content ”Comparing Versions of 
Content” on page 96

Edit Form Properties Edit Form properties not available 
via the Edit Content button 

”Viewing and Editing a 
Form’s Properties” on 
page 178

Delete Form Delete a form ”Deleting a Form” on 
page 185

Check Links Check for other content that contains 
a link to this form

”Link Checking” on 
page 595

Add Task Add a task ”Managing Tasks” on 
page 867

View Task View task information

Add Form Add a new form ”Creating a New Form” 
on page 141

Export Report Download form data to a Microsoft 
Excel spreadsheet

”Exporting Form Reports” 
on page 177
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View Reports View submitted form data; can select 
range of dates

”Viewing Form Reports” 
on page 173

 or Form 
Properties

View Content 
Properties

Access view properties for the 
content

”Viewing and Editing a 
Form’s Properties” on 
page 178

View 
(language)

View If you can view forms in more than 
one language, select a language 
from the drop down list.

Add
-select 
language-

Add
-select language-

Lets you copy current form into new 
block and translate it to selected 
language.

”Translating Content” on 
page 923

Button or 
Tab

Name Description More Information
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Library Folder

The library folder stores images, files, quicklinks, and hyperlinks 
that can be inserted into editor content. Before you can insert them 
into content, you must copy them from your computer to a larger, 
file server computer that everyone editing your site can access.

This chapter explains how to copy such files and insert them into 
Web content through the following topics.

• ”Terms Used in this Chapter” on page 188

• ”Accessing The Library” on page 189

• ”Library Folder Properties” on page 191

• ”Searching the Library” on page 192

• ”Files” on page 195

• ”Hyperlinks” on page 208

• ”Images” on page 208

• ”Quicklinks and Forms” on page 210

Terms Used in this Chapter
• An image is any graphic file, which can include illustrations and 

photos. Common image file extensions are .gif., .jpg, .tiff, etc.

• A file is type of computer file that can be launched from a 
browser, such as Internet Explorer. Examples include a 
Microsoft Word document and a .PDF file.

• A hyperlink is a commonly used or hard to remember Web 
address (also known as a URL). After you add hyperlinks to the 
library, users can easily apply them to editor content.
So for example, if the editor content is “Contact Ektron,” the 
user can select the text, click the library button, select 
hyperlinks to find the Ektron hyperlink, and apply that 
hyperlink to the text.
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Once the page is published, a person reading it can click the 
text to “jump” to the Web address www.ektron.com.

• A quicklink is a special kind of hyperlink that jumps to another 
content item on your Web site. (A regular hyperlink jumps to a 
Web page on the internet.)
Whenever content is created, a quicklink is created for it.

• A form is a quicklink to HTML form content. Whenever content 
is created, a form link is automatically created for it.

Accessing The Library

1. To access the library, click the Workarea button ( ) 
or icon ( ).

2. Click the Library folder in the lower left corner of the Workarea.

3. The Library folder appears.
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4. The sub-folders appear in the left frame. Files in the root folder 
(library) appear in the right frame.

You can use the dropdown list (circled above) to change the type of 
library files that appear.

To work with any library file, click it. When you do, the View Library 
screen appears, providing additional information about the item. 
From here, you can

• edit its title, file name, or description

• overwrite it

• find content linked to it
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• delete it

For more information, see ”Viewing Files” on page 198.

Toolbar buttons are also available on the library screen. The 
following table explains them.

NOTE Your system administrator determines which library folders you can access, and 
which functions you can perform on library items within the folders.

Library Folder Properties
To view the library folder’s properties, follow these steps.

1. Click the Properties button ( ).

Button Description For more information, see

Search library ”Searching the Library” on page 192

View the library’s properties 
screen

”Library Folder Properties” on page 191

Add an image, file, quicklink, or 
hyperlink to the library

”Copying Files to the Library” on 
page 196

Select the type of Library file to 
work with
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2. The Library Management screen appears.

3. The screen displays the following settings.

Your system administrator controls these settings.

Searching the Library
You can search the library to find items when you only know some 
information about them. For example, you know that an image’s 
name includes Ektron but don’t know its filename or folder.

Field Description

Image Extensions File extensions of images that can be copied to the library 
folder. For example, .gif and .jpg.

Image Upload path/
Physical Path

The folder to which library images are moved when you 
insert them into Ektron CMS400.NET .

File Extensions Extensions of files that can be copied to this library folder. 
For example, .doc and .pdf.

FIle Upload path/
Physical Path

The folder to which library files are moved when you insert 
them into Ektron CMS400.NET .
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To search the library, first select the folder in which you want to 
begin the search. The search only considers files in that folder and 
its child folders. To search the entire library, begin by selecting the 
Library (root) folder.

Next, click the Search button ( ) from the library toolbar. When 
you do, a search screen appears with several fields that let you 
narrow your search. The fields are described below.

Field Description

Keywords Specify one or more keywords that the search will use. The search 
looks for keywords in the file’s title. (The title is assigned by the user 
when the file is added to the library.) If a file’s title matches the 
keywords, the file appears on the search results screen.
The search also uses keywords to search through the file’s

• internal name (for example, airplane.gif) if the Filename Search 
checkbox is checked

• description if the Description search checkbox is checked

A keyword can be a complete or partial word. But, you can only enter 
a partial term for one word. For example, you can enter Adv and 
have the search return the content titled “Adverse Drug Reactions.” 
But if you enter Adv Drug, the search returns nothing.
You can enter several complete search terms but they must be in the 
correct sequence. For example, to find the topic titled “Adverse Drug 
Reactions,” you can enter Adverse Reactions but cannot enter 
Reactions Adverse.
To find all files in a selected library folder, enter nothing in this field. 
Or, to find all files in a selected library folder of a type (for example, 
images), select the type and enter nothing in this field.

All Types The search considers all library asset types.

Images only The search only considers images.

Quicklinks Only The search only considers quicklinks.

Forms Only The search only considers forms.

Files Only The search only considers files.

Hyperlinks Only The search only considers hyperlinks.
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NOTE Some search field check boxes are circles while others are squares. If the box is a 
circle, you can only choose one option. If it is a square, you can choose as many 
as you want.

The search then displays all library items that meet the search 
criteria on the search results screen. See ”Displaying Search 
Results” on page 194

Displaying Search Results
Search results appear in this order.

• images

• files

• hyperlinks

• quicklinks

• form links

Result Display Options

At the top of the library search screen, a pull-down list lets you 
choose the how to display the results.

Filename Search If you check this box, the search considers the file name when 
returning search results. Otherwise, the file name is not considered 
by the search.
For example, if you enter ppt into the keyword field, the search 
returns all files that include that string (such as all Powerpoint 
presentations).

Only search items 
last edited by myself 

The search only considers library assets that were last modified by 
you.

One or more of the search criteria set by your system administrator in the Metadata 
Definitions screen.

Field Description
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Files
This section explains how to work with library files through the 
following subtopics:

View 
option

Description Example

Mixed If the item is an 
image, display the 
image in the left 
column. If not, 
display its title.
To the right, 
display the item’s 
Description.

Note: Mixed 
search results 
require the 
Internet Explorer 
browser, version 6 
or greater.

Text Display item’s title 
in the left column. 
To the right, 
display the file 
type and folder 
name.
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• ”Copying Files to the Library” on page 196

• ”Viewing Files” on page 198

• ”Editing a File” on page 200

• ”Overwriting Files” on page 201

• ”Library Link Searching” on page 203

• ”Adding a Library File to Content” on page 204
For a definition of the term “files,” see ”Terms Used in this Chapter” 
on page 188.

Copying Files to the Library
Files must be copied to the Ektron CMS400.NET library before 
users can insert them into content. To copy a file to the library, 
follow these steps.

1. In the Workarea, browse the library folder and select a folder to 
which you want to copy a file.

NOTE When you copy a file to a folder, only users with permissions to that folder can 
insert the file into content.

2. A list of files in that folder appears.

3. Click the Add Library button ( ).
4. The Add File screen appears.
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5. Enter the necessary information according to the following 
table.

Field Description

Title Enter a title for the file to be copied.

Filename Enter the folder path to the file to be copied. You can 
use the Browse button to find the file.

Description You can enter a full text description to help other users 
identify this file.
The Description appears on the View File screen.
It also accompanies the file on the Search Results 
screen if the user selects Mixed when viewing the 
search results.
See Also: ”Displaying Search Results” on page 194
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Below is a description of the buttons on the screen.

After you enter the necessary information and click the Save 
button, the file is copied. Now, users with permissions to the 
selected folder can insert the file into their content.

Viewing Files
Once a file is copied to the library, you may preview it. To preview a 
copied file, follow these steps.

1. Navigate to the library folder to which the file was copied.
2. Click the file you want to preview.
3. The View File screen appears.

Button Name Description

Preview View file to make sure it’s correct before uploading it.

Note: An application that can display the file must be 
installed on your computer.

Save Add file to the library.

Back Return to previous screen.
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The table below describes each field on the screen.

Field Description

Title Title assigned by user who copied or edited it.

Filename Filename and location on the server.

Library ID ID number assigned by Ektron CMS400.NET when file was originally 
copied.

Parent Folder File’s parent folder. Users need permissions to this folder to insert the file 
into content.

Last User to Edit Last user who changed file.

Last Edit Date When file was last edited.

Date Created When file was originally copied to library.

Description Optional, full-text description of file.
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If the file can be displayed in your browser, a preview of it appears 
at the bottom of the screen. If it cannot display in the browser, a 
link to preview it in its host application appears instead.

NOTE You may need to download some files before you can be view them (for example, 
.mdb, .mp3, .zip, etc.).

The following table describes the buttons on the View Library Item 
screen.

Editing a File
You can edit the title, filename and description of any file that was 
copied to the library. To do so, follow these steps.

1. Access the View File screen, as described in ”Viewing Files” on 
page 198.

2. Click the Edit button ( ).

3. The Edit File screen appears.

Button Description For more information, see

Edit the items title and description ”Editing a File” on page 200

Overwrite the library item ”Overwriting Files” on page 201

Find content linked to the library item ”Library Link Searching” on page 203

Delete library item See “Deleting Library Items” in the 
Ektron CMS400.NET  Administrator 
Manual 

Return to previous screen
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4. Change the title, file name, and/or description of the file.

5. Click the Update button ( ).

Overwriting Files
If a library file becomes out of date or the wrong version was 
copied, you may replace it with a new version. Overwriting files lets 
you minimize disk space and the number of library files.

NOTE The ability to overwrite a library file is a privilege granted by the system 

administrator. If you do not see an Overwrite button ( ) on the View Library 
Item in Folder screen, you do not have permission to overwrite.

NOTE You can only overwrite images and files. The new image or file must have the 
same file extension as the file being replaced.

Before You Overwrite an Image

When overwriting an image, the new image uses the same size 
dimensions and file extension as the older image. Be sure that the 
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two images have the same file extension and size or make the 
adjustments at each occurrence of the image.

Before You Overwrite a File

Remember, all links that point to the overwritten file now point to 
the new file. 

Overwriting Library Assets

To overwrite a library file, follow these steps.

1. Navigate to the View File screen for the file you want to 
overwrite, as described in ”Viewing Files” on page 198.

2. Click the Overwrite button ( ).

3. The Overwrite File screen appears.

4. Click the Browse button.
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5. A window lets you navigate to the new file.
6. Click the file, then click the Open button.
7. You return to the Overwrite File screen with the path to the new 

file in the Filename field.

8. If desired, enter a Description for the new file.
9. To preview the file before you copy it, click Preview file name. 

The file is previewed in a separate window. Click the X button 
in the top right corner of the screen to close it and return to the 
Workarea.

10. To overwrite the current version of the file with this version, 
click the Update button ( ).

11. The following message appears.

12. To overwrite the file, click OK.

Library Link Searching
Link searching indicates all content that includes a library link. It is 
useful when you want to delete a library item. With the click of a 
button, you see all content that you need to update to reflect the 
change you are making.

Performing a Library Item Link Search

To perform a library item link search, follow these steps.
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1. Access the View Library Item for any type of library item, as 
described in ”Viewing Files” on page 198.

2. Click the Link Search button ( ).

3. A list of all content that references the library item is displayed.
You should edit that content before deleting the item.

Deleting Library Items
You can delete obsolete items from the library. By deleting an item, 
you prevent users from adding it to their content. A deleted 
hyperlink, quicklink or form quicklink remains on your Web server, 
so any existing links to them are not broken.

On the other hand, if an item is a file or image, the delete window 
displays an additional prompt, Remove from the server, that lets 
you remove the item from the server. This feature is available to 
help reduce disk space taken up by these files. Before removing an 
image or file from your server, you should review all content with 
links to it and remove or update the link. 

To delete an item from the library, follow these steps.

1. Access the View Library Item for any type of library item, as 
described in ”Viewing Files” on page 198.

2. Click the Delete button ( ).

3. The Delete Library Item screen is displayed.
4. If appropriate, check the box next to Remove from the server 

(see above).

5. Click the Delete button ( ).

Adding a Library File to Content
After a file is copied to the library, users can add it to content. (See 
”Adding a Library File to Content” on page 205)

You can also insert an item into the library while adding it to 
content. (See ”Adding a File to the Library and Inserting it into 
Content” on page 206)
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If you insert an image file, it appears within the content. If you add 
any other type of file, the file name appears as a hyperlink within 
the content. When a site visitor viewing that page clicks the 
hyperlink, the inserted file is launched.

Adding a Library File to Content

1. Invoke the editor by adding or editing content in Ektron 
CMS400.NET.

2. Place the cursor within the content where you want the library 
file to appear.

3. Click the library button ( ).

4. The library opens.
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5. Navigate to the folder that contains the file you want to insert.

6. From the file types dropdown list, select the kind of file you 
want to insert. 

7. All library files of that type in the selected folder appear on the 
screen.

8. Click the file you want to insert.

NOTE You can preview the file by clicking the preview button (  ).

9. Click the insert button ( ) to insert the file.

10. A hyperlink to the file appears in your content.

You can click the link to open the file.

Adding a File to the Library and Inserting it into Content

Use this procedure to insert an image into content that has not yet 
been copied to the library. This procedure inserts the item into the 
library then into the content.
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1. Invoke the editor by adding or editing content in Ektron 
CMS400.NET.

2. Click the library button ( ).

3. The library opens.
4. Navigate to the folder that will contain the file after you insert it.
5. From the File types dropdown, select the type of file you want 

to insert.

6. Click the Add Library button (  ).

7. A new screen appears. Browse to the file you want to insert.

Or you can click the search button ( ) to search for a file to 
insert.

8. Enter a Description for the file.
9. If metadata is required for the library item, you must complete 

it. Metadata fields may appear in the lower section of the 
screen.

10. Click the Add Library button (  ).

11. The file is inserted into the selected library folder and the 
content.
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Hyperlinks
For a definition of the term “hyperlinks,” see ”Terms Used in this 
Chapter” on page 188.

Adding Hyperlinks
You must copy hyperlinks to the library before content creators can 
insert them into content. To copy a hyperlink to the library, follow 
the procedure described in ”Copying Files to the Library” on 
page 196. The only difference is that you insert a hyperlink instead 
of a file.

Viewing Hyperlinks
To view a hyperlink, follow the procedure described in ”Viewing 
Files” on page 198. The only difference is that you view a hyperlink 
instead of a file.

Editing Hyperlinks
To edit a hyperlink, follow the procedure described in ”Editing a 
File” on page 200. The only difference is that you edit a hyperlink 
title instead of a file title. You can also edit the URL.

Adding Hyperlinks to Your Content
Once a hyperlink is added to the library, users can add the 
hyperlink to their content.

To add a hyperlink to content, follow the procedure described in 
”Adding a Library File to Content” on page 204. The only difference 
is that you add a hyperlink instead of a file.

Images
For a definition of the term “images,” see ”Terms Used in this 
Chapter” on page 188.

Uploading Images
You must copy images to the library before content creators can 
insert them into content. To copy an image to the library, follow the 
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procedure described in ”Copying Files to the Library” on page 196. 
The only difference is that you add an image instead of a file.

Viewing Images
To view an image, follow the procedure described in ”Viewing 
Files” on page 198. The only difference is that you view an image 
instead of a file.

Editing Image Titles
To edit an image’s title, follow the procedure described in ”Editing a 
File” on page 200. The only difference is that you edit an image’s 
title instead of a file title.

Overwriting Images
When an image in the library becomes out of date, or if the wrong 
version of an image was copied, you may overwrite that image with 
a new or correct version. Overwriting images minimizes disk space 
and the number of copied library images.

NOTE Overwriting images is a permission that your system administrator may or may 
not assign to you.

To overwrite an image, follow the procedure described in 
”Overwriting Files” on page 201. The only difference is that you 
overwrite an image instead of a file.

NOTE You can only overwrite an image with another image of the same extension. (that 
is, .gif > .gif, not .jpg > .gif)

Adding Images to Your Content
Once an image is added to the library, users can add it to content.

To add an image to content, follow the procedure described in 
”Adding a Library File to Content” on page 204. The only difference 
is that you add an image instead of a file.

The image is placed into the picture properties dialog box, where 
you can change it before inserting it. For information about the 
picture properties dialog box, see ”Using the First Picture 
Properties Dialog Box” on page 411.
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Quicklinks and Forms
For a definition of the terms quicklinks and forms, see ”Terms Used 
in this Chapter” on page 188.

Adding a Quicklink or Form to Content
After new content is created, users can insert a quicklink or form to 
it into any other content. To do so, follow the procedure described 
in ”Adding a Library File to Content” on page 204. The only 
difference is that you add a quicklink or form instead of a file.

Be sure to place the cursor where you want the quicklink or form to 
appear before inserting it. When the quicklink or form is inserted, 
the title of the “jumped to” content appears in the content. To test 
the quicklink or form, select the newly-inserted title and double 
click it.

When the page is published, a reader can click the link to jump to 
the quicklink or form page.

Viewing Quicklinks or Forms
To view a quicklink or form, follow the procedure described in 
”Viewing Files” on page 198. The only difference is that you view a 
quicklink or form instead of a file.

The table below describes each field on the quicklinks display.

Field Description

Title Title given to the hyperlink or form by the user who added it, or last edited it.

URL Link URL link for the quicklink or form.

Library ID ID number assigned automatically by Ektron CMS400.NET when the 
quicklink or form was originally added.

Parent Folder Parent folder that the quicklink or form belongs to. Users need permissions 
to this folder to be able to access the quicklink or form.

Last User to Edit Last user that made changes to the quicklink or form.
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To preview a quicklink or form, click the link at the bottom of the 
page.

Updating Default Template for Multiple Quicklinks

NOTE This action can only be performed on quicklinks.

When content is moved in Ektron CMS400.NET, its quicklink does 
not get changed. After it is moved, you need to update the default 
template called in the content’s quicklink.

To update the default template for one or more quicklinks, follow 
these steps.

1. in the library, access the quicklinks folder containing quicklinks 
you want to update.

2. Click the Update Quicklinks button ( ).

3. The Update URL Link Template Quicklinks screen is displayed.
4. Check the quicklinks you want to update.

NOTE Check the box in the table header to select or deselect all.

5. In the To: text field, enter the name of the template you want to 
apply to the selected quicklinks.

6. Click the Update Quicklinks button ( ) to update the 
changes.
A confirmation message is displayed.

7. Click OK to continue.
The selected quicklinks are updated to use the specified template.

Last Edit Date The date the quicklink or form was last edited.

Date Created The date and time the quicklink or form was originally added to the Ektron 
CMS400.NET library.

Field Description
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Using Ektron Explorer

The Ektron Explorer lets you navigate through and view CMS 
content without signing in and using the Workarea. You can also 
use a search screen to find and view CMS content. So, even if you 
have no knowledge of Ektron CMS400.NET, Ektron Explorer 
provides a simple, recognizable way to find and view content.

Depending on how your system administrator has set up the 
Explorer, you may also have the ability to edit, add, and delete 
content.

The following is an example of the Ektron Explorer. The left frame 
lets you navigate through Ektron CMS400.NET’s folders. The right 
frame shows the content in a selected folder.
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A second tab in the left frame lets you search for content. When 
you do, the right frame displays search results.
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For more information, see ”Searching for CMS Content” on 
page 221.

Installing Ektron Explorer
Your system administrator provides a file for installing Ektron 
Explorer. When you have the file, click it and follow these steps to 
install it.

NOTE During the installation, you are asked to identify the folder that stores your Ektron 
CMS400.NET . If you don’t know, ask your system administrator for this 
information before beginning.

1. A welcome screen appears. Click Next.
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2. You are prompted to enter the location of Ektron CMS400.NET 
on your computer. The default folder appears. Press Next if 
that is correct, or enter a different path then press Next.
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3. You are prompted to select a setup type. Choose Complete.
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4. The installation copies the needed files to the specified folder 
and displays a final screen. Click Finish.



Using Ektron Explorer

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 218

Displaying Ektron Explorer
After you install Ektron Explorer, you can use it from both Windows 
Explorer and Internet Explorer. To use it, follow these steps.

1. Open Windows Explorer or Internet Explorer.
2. From the menu across the top of the screen, select View > 

Explorer Bar > Ektron Explorer.
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3. The Ektron Explorer replaces Windows Explorer. As you select 
a folder (or conduct a search) in the left frame, the related 
content appears in the right frame.

Once Ektron Explorer is enabled, a new toolbar button appears 
( ) for quick access to Explorer.

Display of Content
The right side of the screen displays all related content. The 
following graphic illustrates the information available on the right 
side.
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Changing the Thumbnail Size

You can change the size of the thumbnail images in the right 
frame. The default size is small. You can change it to medium or 
large.

NOTE You can only adjust the size of HTML or XML content. If the content is an external 
file (such as a Word document), you cannot adjust the thumbnail size.

Note that menu options allow you to change just the selected 
image or all images in the right frame. The new size is only used 
for the current viewing of the folder. Once you view other folders or 
return to this one, the default size is used.
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To display the menu for changing the thumbnail size, move the 
cursor to the text in the right frame and right click the mouse. Then, 
select View.

Removing Ektron Explorer from Display
To remove Ektron Explorer from display, click the X in the top 
corner of the left frame (see below).

Searching for CMS Content
The Explorer’s search feature lets you look for CMS content by 
entering some of the content’s title, or some of the its text.
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Selecting a Folder to Search in
You can also select a folder in which to begin to search. This 
reduces the time needed to complete the search if you are certain 
the content is within a folder or its subfolders.

NOTE The Advanced Search Options let you include or exclude a folder’s subfolders 
from the search. See Also: ”Advanced Search Options” on page 223
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Use the Look In dropdown to select a folder to search (illustrated 
below). The drop down box lists all folders that you opened since 
you signed on.

If the folder you want is not in the list, click Browse and a complete 
CMS folder display appears. Select a folder from that display.

Advanced Search Options
Advanced search options let you

• search just the current folder or that folder plus all of its 
subfolders

• include words that partially match the search string (for 
example, if you enter the word the, the search returns theater)

• find content that includes all words you enter, any of the words, 
or just the exact phrase. The options are explained in 
”Specifying Match Criteria” on page 58.

Inserting External Files into Ektron CMS400.NET
If you installed the Document Management functionality with 
Ektron CMS400.NET, you can add files using the drag and drop 
technique common in Windows. You can quickly and easily insert 
allowed file types into Ektron CMS400.NET.

See Also: ”Using the Document Management Functionality” on 
page 225 and ”Importing Files via Drag and Drop” on page 247

The user performing the drag and drop must have permission to 
add files to the selected folder.
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To drag and drop external files into Ektron CMS400.NET, follow 
these steps.

1. Open Ektron Explorer.
2. Resize it to half of the screen.
3. Open Windows Explorer and resize it to the other half of the 

screen.
4. From Windows Explorer, navigate to the folder that contains 

the file you want to insert into Ektron CMS400.NET.
5. From Windows Explorer, select the files you want to copy to 

Ektron CMS400.NET.
6. Hold down the left mouse button and drag the files to the 

desired Ektron Explorer folder in the left frame.

7. Release the mouse button. A file upload message appears.
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Using the Document 
Management Functionality

WARNING! The functionality described in this section is not supported when using an 
Apple Macintosh for editing content. 

The Document Management Functionality (DM) lets you import 
Microsoft Office documents and most other kinds of files into 
Ektron CMS400.NET. (Non-Office files are known as managed 
files.) Collectively, these files are known as documents.

After being saved in Ektron CMS400.NET, documents can be 
updated and tracked like HTML and XML content. If you’re 
familiar with how that content is handled, most of what you 
know also applies to documents. For example, documents

• can be stored in folders with other content, or in separate 
folders that you create just for them

• are assigned content ID numbers

• capture summary, metadata, comment, task, and schedule 
information

• inherit permissions and approvals from their folder 
properties

• progress through a workflow (check out, check in, publish)

• provide a history and let you restore an earlier version

• can be searched, including some Office document 
properties

• can have foreign language editions

• can have a task assigned to them

• appear on content reports

• update the Smart Desktop listing of files awaiting approval, 
checked out, tasks, to expire

When a file is imported to the CMS then saved, a copy of it is 
saved to the asset management server. Then, whenever a user 
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edits and saves the file, a new copy is stored. In this way, you can 
review and, if needed, restore a prior version.

This chapter explains the Document Management Functionality 
through the following topics.

• ”Supported Types of Documents” on page 226

• ”Security” on page 228

• ”Working with Office Documents” on page 228

• ”Working with Managed Files” on page 241

• ”Importing Files via Drag and Drop” on page 247

• ”Document Workflow” on page 250

• ”Viewing Documents within the CMS” on page 251

• ”Deleting a Document” on page 252

• ”Approving Documents” on page 252

• ”Adding Documents to Collections and Menus” on page 252

• ”Document Reports” on page 252

Supported Types of Documents
• Microsoft Office 2000 or later documents: Word, Excel, 

Powerpoint, Project, Publisher, Visio, etc.

• Managed files: any Windows-executable file such as .zip files, 
PDFs, .txt files, graphic files such as .gif and .jpeg, etc.

NOTE The file types that can be uploaded are determined by your administrator. If you 
try to upload the wrong type of file, the following error message appears.
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Office Documents
You can edit any Office document within the Content tab, just like 
an HTML content block. The host application’s toolbar appears 
below Ektron CMS400.NET’s tabs on the Edit Content screen.

You can insert summary, metadata, schedule, comment, and task 
information for the Office document. From the View Content 
screen, you can use standard toolbar buttons to perform actions 
such as view history, submit for publishing, and delete.

For more information, see ”Working with Office Documents” on 
page 228.

Managed Files
Ektron CMS400.NET can track and manage any non-Office type of 
file that runs on your computer (for example, .PDF, .gif and .zip). 
When editing these file types, the host application appears in a 
separate window. The Ektron CMS400.NET View Content screen 
remains in the background.
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You can use the host application to edit the file, then switch to the 
View Content screen to insert supporting information such as 
summary and metadata. Use standard toolbar buttons to perform 
actions like view history, submit for publishing, and delete.

For more information, see ”Working with Managed Files” on 
page 241.

Security
For the purposes of security, documents are treated like other 
content. Your system administrator applies security to each folder, 
determining which user groups can perform which tasks on the 
content in a folder. For more information, see the “Setting 
Permissions” chapter of the Ektron CMS400.NET Administrator 
Manual .

Working with Office Documents
This section explains how to work with MS Office documents 
through the following subtopics.
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• ”Notes on Working with Office Documents” on page 229

• ”Creating a New Office Document” on page 229

• ”Importing One Office Document” on page 234

• ”Importing Several Office Documents” on page 236

• ”Importing Files Individually vs. Several at Once” on page 238

• ”The Work Offline Option” on page 239

• ”Editing an Office Document” on page 239

Notes on Working with Office Documents
• If you have an Excel spreadsheet open outside DM then you 

open one within it, and navigate to another template page on 
your Web site, then return to the spreadsheet outside DM, a 
new, open worksheet appears. Close it.

• If you are working with an Excel spreadsheet, the File and 
Open toolbar buttons within Excel appear active (that is, not 
grayed out) but are not operable.

• If you access an Office document on a Web page, you must 
close that instance of the browser before proceeding to another 
Web page. If you do not close the browser and continue to add 
or edit documents, the original document continues to use up 
your computer’s resources.

Creating a New Office Document
To create a new Office document, follow these steps.

1. From the Workarea, select the Content folder.
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2. Select the folder in which you want to place the document. See 
Also: ”Working with Folders and Content” on page 32

3. Click the down arrow next to the add dropdown list to view a list 
of items you can add.

4. Select Office Documents.
5. The default language appears in the View: dropdown list. To 

save the document under a different language, click the 
dropdown list and select the language.

6. Click the Add Content button ( ).

7. The Insert New Document Object screen appears.



Using the Document Management Functionality

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 231

NOTE The list of object types is determined by the applications installed on your 
computer. For example, an MS Project file type only displays if MS Project is 
installed.

8. If the document does not yet exist, check the Create New 
button. Then, select the type of document you want to create 
and press OK.
If the document already exists, see ”Importing One Office 
Document” on page 234.

9. The application assigned to the document type appears within 
Ektron CMS400.NET.

10. Enter a Title and add content to the document. 
11. Decide whether the content should be added to the Quicklinks 

Table and if the content should be searchable.
12. If desired, add a summary, metadata, a schedule, and 

comments. See Also: 

•”Adding a Content Summary” on page 73 

•”Adding or Editing Metadata” on page 77

•”Scheduling Content to Begin and End” on page 66

13. If desired, you can edit the document’s properties. See Also: 
”Editing a Document’s Properties” on page 232
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14. Check in or submit the content for publishing as you would a 
content block. See Also: ”Save, Check in, and Publish” on 
page 232 and ”Adding Content” on page 46

Editing a Document’s Properties
If the host application (such as Microsoft Word) has a Properties 
screen, you can access it by clicking File > Properties or the 
Properties option on the host application’s Document 
Management menu.

NOTE CMS400.NET  installs the Document Management menu on the Office 
application.

Save, Check in, and Publish
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When you finish editing a document, you have four options for 
what to do next. They are explained in the following table.

You can carry out any option by clicking an Ektron CMS400.NET 
toolbar button.

or a Document Management menu option (illustrated below).

Action Document 
Management Menu 
Option

Toolbar 
button

Check document in so you and others 
can continue to edit it.

Check in
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Importing One Office Document
Your computer or network may have Office documents that you 
want to manage using DM. Follow these steps to import any 
document into Ektron’s Document Management functionality.

See Also: ”Importing Files Individually vs. Several at Once” on 
page 238 and ”Drag and Drop File Uploading Vs. the Add Content 
Buttons” on page 250

1. From the Workarea, select the Content folder.
2. Select the folder in which you want to place the document. See 

Also: ”Working with Folders and Content” on page 32
3. Click the down arrow next to the add dropdown list to view the 

document types you can add.

Submit document into approval chain. 
Upon approval, publish content to Web 
site.

Publish or submit for 
publishing

 or 

Save recent changes. Use to save latest 
changes before continuing.

Save to DocServer

Save file to local computer.
See Also: ”The Work Offline Option” on 
page 239

Work Offline

Discard changes made in current editing 
session.

Undo Check out

Action Document 
Management Menu 
Option

Toolbar 
button
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4. Select Office Documents.

5. Click the Add Content button ( ).

6. The Insert New Document Object screen appears.

NOTE The list of object types is determined by the applications installed on your 
computer. For example, an MS Project file type only displays if MS Project is 
installed.

7. Check the Create From File button.

8. Click the Browse button and browse to the file you want to 
import into DM. Click OK.

9. The document appears within the host application.
10. Enter a Title and add content to the document.
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NOTE If you want to retain the original document name, insert the full filename into the 
Title field. For example, you could enter mydocument.doc.

11. Decide whether the content should be added to the Quicklinks 
Table and if it should be searchable. 

12.  If desired, add a summary, metadata, a schedule, and 
comments. See Also: 

•””Adding a Content Summary” on page 73

•”Adding or Editing Metadata” on page 77

•”Scheduling Content to Begin and End” on page 66

13. If desired, you can edit the document’s properties. See Also: 
”Editing a Document’s Properties” on page 232

14. Check in or submit the content for publishing as you would a 
content block. See Also: ”Save, Check in, and Publish” on 
page 232 and ”Adding Content” on page 46 

Importing Several Office Documents
Your computer or network may have several Office documents that 
you want the Document Management functionality to manage. 
Follow these steps to import several Office documents at once.

See Also: ”Importing Files Individually vs. Several at Once” on 
page 238 and ”Drag and Drop File Uploading Vs. the Add Content 
Buttons” on page 250

1. Place all files to be imported in the same folder on your 
computer or network.

2. From the Workarea, select the Content folder. See Also: 
”Working with Folders and Content” on page 32

3. Select the CMS folder in which you want to place the 
documents being imported.

4. On the View Contents of Folder screen, click the down arrow 
next to the add dropdown list to view a list of items you can 
add.

5. Select Office Documents.

6. Click the Add Several Files button ( ).
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7. The View Contents of Folder screen splits into two sections, 
resembling Windows Explorer. The left side displays the folder 
structure of your PC and its network drives. The right side 
displays files in the selected folder.

8. In the left frame, navigate to the folder that contains the files 
you want import.

9. In the right frame, click the checkbox next to each file you want 
to import. You can only import files in the selected folder at this 
time.
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10. In the Title field, you can enter an optional title to apply to all 
imported documents. See Also: ”Importing Files Individually vs. 
Several at Once” on page 238

11. Decide whether the content should be added to the Quicklinks 
Table and if the content should be searchable. 

12. Click the Check in ( ) or Submit for Publishing button ( ). 
See Also: ”Save, Check in, and Publish” on page 232 and 
”Adding Content” on page 46. 

13. The selected files are imported into the Document 
Management functionality.

Importing Files Individually vs. Several at Once
If you import files one at a time, you can assign each file a unique 
title. Also, any summary, metadata, schedule, comment, and task 
information applies to that file only.

If you import several at once, you are not required to assign a title. 
If you do not assign a title, the file’s title is the same as its name, 
including the extension. For example, Proposal for Town 
Manager.PDF. 

If you do assign a title to several files, appended to the title, in 
parentheses, is the original file name including the extension. So 
for example, if you import three personnel forms at once, and 
assign them the title Personnel, the titles might look like this:

Personnel (Vacation Request.doc)

Personnel (Direct Deposit Form.doc)

Personnel (Absence Report Form.doc)

Also, any summary, metadata, schedule, comment, or task 
information you enter applies to all files. So, it would be efficient to 
enter this kind of information if it applies to all or even most of the 
files. For example, if you are importing 10 files and eight have the 
same metadata, insert the metadata before checking them in. 
Then, change the metadata for the remaining two.

After you check in or publish these files, you can edit the summary, 
metadata, schedule, comment, or task information by selecting the 
files individually.
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The Work Offline Option
After creating or editing a document, you can save it to your local 
computer instead of the document server. To do so, click the Work 
Offline button ( ).

If you do, the document remains in a checked-out state and only 
you or a system administrator can check it in to work on it again. 
When you check it in, the file on your local computer is loaded into 
the Workarea.

As a result, you can edit the document on your local computer 
anywhere, without a network connection. When you are ready to 
return it to the document server, check it in, save it, or submit it for 
publishing.

You must check the document in on the same computer on which 
you checked it out.

NOTE A system administrator can check in any checked-out document. If he does, the 
most recently published document gets checked in.

Editing an Office Document
After an Office document is saved, follow these steps to edit it.

1. From the Workarea, select the document’s folder. See Also: 
”Working with Folders and Content” on page 32

2. From the View Contents of Folder screen, click the document.
3. The View Content screen for the document appears. If the 

document is checked in, it appears on the Content tab in the 
Workarea but you cannot edit.

NOTE Your administrator controls the initial view of a document. The following table 
shows the different ways you can preview a document.
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Mode Image

Preview Turned on

Preview Turned off
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4. Click the Edit button ( ).

5. The document opens in the host application.
6. Edit the document as well as its summary, metadata, schedule, 

tasks, or comments.
See Also: 

• ”Adding a Content Summary” on page 73

• ”Adding or Editing Metadata” on page 77

• ”Managing Tasks” on page 335

• ”Scheduling Content to Begin and End” on page 66

7. If desired, edit the document’s properties. See Also: ”Editing a 
Document’s Properties” on page 232

8. Check in or submit the content for publishing, as you would any 
content block. See Also: ”Save, Check in, and Publish” on 
page 232

Working with Managed Files
This section explains how to work with managed files through the 
following subtopics.

• ”Creating a New Managed File” on page 241

• ”Importing One Managed File” on page 241

• ”Importing Several Managed Files” on page 243

• ”Editing a Managed File” on page 245

Creating a New Managed File
Unlike an Office document, you cannot create a managed file 
within Ektron CMS400.NET. Instead, you must create it on your 
computer using the host application. After creating the file, import it 
into DM.

Importing One Managed File
To import a managed file into DM, follow these steps.



Using the Document Management Functionality

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 242

See Also: ”Importing Files Individually vs. Several at Once” on 
page 238 and ”Drag and Drop File Uploading Vs. the Add Content 
Buttons” on page 250

1. From the Workarea, select the Content folder.
2. Select the folder in which you want to place the file. See Also: 

”Working with Folders and Content” on page 32
3. Click the down arrow next to the add dropdown list to view the 

document types you can add.

4. Select Managed Files.
5. The default language appears in the View: dropdown list. To 

save the managed file under a different language, click the 
dropdown list and select the language.

6. Click the Add Content button ( ).

7. The Edit Content screen opens, as shown below.
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8. Click the Browse button. 
9. Browse through your computer and network to the file you want 

to import. When you do, the file’s path appears within the File 
field.

10. Insert a Title.
11. Decide whether the content should be added to the Quicklinks 

Table and if the content should be searchable. 
12.  If desired, add a summary, metadata, a schedule, and 

comments. See Also: 

•”Adding a Content Summary” on page 73

•”Adding or Editing Metadata” on page 77

•”Managing Tasks” on page 335

•”Scheduling Content to Begin and End” on page 66

13. Click the appropriate button to either check in ( ) or publish 
( ) the file. See Also: ”Save, Check in, and Publish” on 
page 232 and ”Adding Content” on page 46.

14. A window appears, indicating that the file is being uploaded to 
the DM server.

Importing Several Managed Files
To import several managed files into DM, follow these steps.

See Also: ”Importing Files Individually vs. Several at Once” on 
page 238 and ”Drag and Drop File Uploading Vs. the Add Content 
Buttons” on page 250
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1. From the Workarea, select the Content folder.
2. Select the folder in which you want to place the files. See Also: 

”Working with Folders and Content” on page 32
3. Click the down arrow next to the add dropdown list to view the 

document types you can add.

4. Select Managed Files.
5. The default language appears in the View: dropdown list. To 

save the managed files under a different language, open the 
dropdown list and select the language.

6. Click the Add Several Files button ( ).

7. The View Contents of Folder screen splits in two, resembling 
Windows Explorer. The left section displays the folder structure 
of your PC and its network drives. The right section displays 
the contents of the current folder.
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8. In the left frame, navigate to the folder that contains the files 
you want import.

9. In the right frame, click the checkbox next to each file you want 
to import. You can only import files in the selected folder.

NOTE If you select both Office documents and managed files, the Office documents are 
imported as Office documents, and others are imported as managed files.

10. In the Title field, enter a title for all imported files. See Also: 
”Importing Files Individually vs. Several at Once” on page 238

11. Decide whether the content should be added to the Quicklinks 
Table and if the content should be searchable.

12. Click the Check in ( ) or Submit for Publishing button ( ). 
See Also: ”Save, Check in, and Publish” on page 232 and 
”Adding Content” on page 46.

13. The selected files are imported into DM.

Editing a Managed File
After a managed file is stored in DM, follow these steps to edit it.

1. From the Workarea, select the Content folder.
2. Select the managed file’s folder.
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3. From the View Contents of Folder screen, click the managed 
file.

4. The Content tab displays the file name and a button to let you 
view the file within its host application.

5. If you want to view the file before editing it, click the View read-
only Asset button. If you do, the file opens for display 
purposes only.

6. To edit the file, click the Edit button ( ). 

7. The following screen appears.

8. To open the managed file in the host application, click Edit in 
App. Then make your changes, save it in the host application 
and click either the Check in ( ) or Submit for Publishing 
button ( ).
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- If you want to save this version of the file to your computer, 
click Save to Local. If you do, a window appears. Navigate 
to the desired folder then click the Save button. 

- If you want to select another file on your computer or 
network and save it under this name in Ektron CMS400.NET, 
click Browse. If you do, a window appears. Navigate to the 
desired folder then click the Open button. The new file is 
saved under the old Ektron CMS400.NET name.

9. Edit the managed file as well as its summary, metadata, 
schedule, tasks, or comments.
See Also: 

•”Adding a Content Summary” on page 73

•”Adding or Editing Metadata” on page 77

•”Managing Tasks” on page 335

•”Scheduling Content to Begin and End” on page 66

10. Save the file within the host application.
11. Check in or submit the file for publishing, as you would any 

content block. See Also: ”Save, Check in, and Publish” on 
page 232

Importing Files via Drag and Drop
You can import files to DM using drag and drop. You can add one 
or several files using this method. It doesn’t matter whether the 
files are Office or Managed files.

NOTE If you upload a file using drag and drop whose type is not supported, the 
Document Management functionality ignores it and moves on to the next file. After 
the files upload, a dialog reminds you which files types are supported. See Also:  
”Supported Types of Documents” on page 226

When you drag and drop a file into DM, the file’s name becomes its 
title. The file is assigned a content ID and submitted to the 
approval process. If either of the following is true, the file’s status is 
set to checked in:

• you are required to complete metadata for the file

• the folder in which you are adding the file is set to create PDF 
documents when a file is published
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If you add more than one file with the same name or the same file 
twice, a number is assigned to the end of the title. For example, 
when adding a second test.doc file, the new file is named 
test.doc(1).

No information is added to Summary, Metadata, or Comments 
when a file is added via drag and drop. You can edit this 
information by clicking Edit ( ), then the appropriate tab.

Steps to Adding Files via Drag and Drop
1. In the Workarea, click the Content folder button.
2. Select the folder in which you want to place the files.
3. Open Windows Explorer.
4. Find the files you want to upload.

NOTE You cannot drag and drop folders. You can, however, grab all files in a folder and 
drag and drop them.
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5. From Windows Explorer, drag and drop the files onto the 
Workarea’s drag and drop window.

After you drag and drop the files, the following screen appears.

When DM uploads the files, they appear in the Workarea. 

If you do not see a file you selected to upload, check the following:

• your administrator allows the file type to be uploaded to DM
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• the Asset Types dropdown box is set to the type of file you are 
looking for. Files upload to the correct category regardless of 
what is selected when you drag and drop them.

Drag and Drop File Uploading Vs. the Add Content Buttons
• Drag and drop lets you add files quickly without having to fill in 

details. The details can be entered later.

• A file added via drag and drop is submitted into the approval 
process for that folder.

• Drag and drop requires fewer mouse clicks. You choose a 
folder, use Windows Explorer to find the files, and drag and 
drop them. The files are then added to DM.

Alternatively, by using the Add Content buttons ( )( ), you 
can add supporting information (summary, comment, and 
metadata) while uploading. When adding files using the Add 
Content buttons, you can choose whether the files are 
published (submitted to the approval chain), checked in, or 
saved. See Also: ”Save, Check in, and Publish” on page 232
This process requires more mouse clicks than drag and drop. 
You choose a folder, an document type, browse to the folder 
where the files are located, add the details, and publish the 
files. 

Document Workflow
An document proceeds through the same workflow as any other 
type of content. A diagram is below.
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See Also: 

• ”Viewing Documents within the CMS” on page 251

• ”Deleting a Document” on page 252

• ”Approving Documents” on page 252

• ”Adding Documents to Collections and Menus” on page 252

• ”Document Reports” on page 252

Viewing Documents within the CMS
To view a document, follow these steps.

1. From the Workarea, select the Content folder.
2. Select the document’s folder.
3. From the View Content screen, click the document.
4. The View Content screen for the document appears.
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Deleting a Document
You can only delete a document if its status is Checked In or 
Approved. To delete a document, follow these steps.

1. From the Workarea, select the Content folder.
2. Select the document’s folder.
3. From the View Content screen, click the document.
4. The View Content screen for the document appears.

5. Click the Delete button ( ).
Like any type of content, a document must go through the approval 
chain before it is removed.

Approving Documents
Documents are placed into the approval chain just like other types 
of content. For more information, see ”Approving/Declining 
Content” on page 85.

Adding Documents to Collections and Menus
You can add a document to a collection or a menu just as you 
would any other type of content. For more information, see 
”Working with Collections” on page 254 and ”Working with Menus” 
on page 274.

Document Reports
Ektron CMS400.NET provides several reports that track documents 
by status.

Report Displays documents in this 
status

For more information, see

Approvals Requiring your approval ”Approvals Reports” on page 118
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Checked In Content Checked in ”Checked In Report” on page 120

Checked Out Content Checked out ”Checked Out Report” on page 120

New Content New (that is, created and saved 
but never published)

”New Content Report” on page 121

Submitted Content Submitted for publication ”Submitted Report” on page 122

Pending Content Approved and pending a start date ”Content Pending Start Date Report” 
on page 123

Refresh Reminder Report End date has been reached ”Refresh Reminder Report” on 
page 124

Expired Content Expired date has been reached ”Expired Content Report” on page 125

Content to Expire Will expire within specified number 
of days

”Content to Expire Report” on 
page 125

Report Displays documents in this 
status

For more information, see



Working with Collections

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 254

Working with Collections

A collection provides a list of content that can be placed on a Web 
page to offer readers links to them. In the following illustration, the 
circled content is an example of a collection on a Web page.

You can also use a collection to display other listings, such as job 
postings, press releases, and knowledge base articles. The 
following graphic illustrates the use of a collection on the landing 
page of Ektron’s Knowledge Base.
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This section explains how to create collections. Your system 
administrator would then modify content to display the collections 
on your Web site using the ecmCollection function or server 
control.

NOTE Your system administrator must assign to you permission to work with collections. 
For details, see the Collections chapter of the Ektron CMS400.NET Administrator 
Manual.

This section explains how to find, create, and manage collections 
through the following subtopics.

• ”Finding Collections” on page 255

• ”Viewing a Collection” on page 258

• ”Creating a Collection” on page 260

• ”Editing Content in a Collection” on page 267

• ”Reordering Collections List” on page 268

• ”Editing Collection Information” on page 269

• ”Deleting a Collection” on page 270

• ”Working with Collections in a Multi-Language System” on 
page 270

• ”Comparison of Collections, Menus, and the List Summary 
Features” on page 272

Finding Collections
Every collection is assigned to a folder. If you want to find the 
collections assigned to any folder, navigate to it and click the 

Collection button ( ). For more information, see ”Finding a 
Collection by Navigating to its Content Folder” on page 256.

Since collections can be assigned to several content folders, the 
Modules folder provides a central Collections folder, which displays 
all collections on one screen, regardless of their content folder. For 
more information, see ”Finding a Collection Using the Collections 
Folder” on page 257.



Working with Collections

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 256

Finding a Collection by Navigating to its Content Folder
To access collections for a content folder, follow these steps.

1. Click the content folder that contains the collection.

2. The folder’s content appears in the right frame.
3. If you are using Ektron CMS400.NET’s multi-language support 

features, select the language. See Also: ”Working with 
Collections in a Multi-Language System” on page 270

4. Click the Collections button ( ).

5. The View Collections screen appears.

The screen displays each collection created for the folder. The 
following table explains each column.

Column Description

Title The title assigned to the collection by the creator.

ID The ID assigned to the collection by Ektron 
CMS400.NET. This number is used to store and retrieve 
the data to/from the database.
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To learn more about a collection and perform tasks on it, proceed 
to ”Viewing a Collection” on page 258.

Finding a Collection Using the Collections Folder
To access the Collections screen that displays all collections in all 
content folders, follow these steps.

1. From the top-level folders in the lower left frame of your 
Workarea, click Modules.

2. Click the Collections folder.
3. The Collection Report screen appears.

4. The screen has four columns, described below.

Date 
Modified

When the collection was last edited.

URL The default template used to display the content.

Column Description

Column Title Description

Title Title given to collection by user who created, or last edited, it.

ID ID number assigned by Ektron CMS400.NET. (Developers use this number to 
reference the collection in ecmCollection custom function.)

Description Description given to collection by user who created, or last edited, it.
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You can click any collection to view information about it and 
perform tasks on it. See ”Viewing a Collection” on page 258.

You can also add a new collection. See ”Creating a Collection” on 
page 260

Viewing a Collection
To view a collection, follow these steps.

1. Select a collection using the procedure described in ”Finding a 
Collection by Navigating to its Content Folder” on page 256 or 
”Finding a Collection Using the Collections Folder” on 
page 257.

2. The View Collection screen appears.

Path Folder location of the collection.

Column Title Description
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The screen displays each item in the collection. To learn more 
about a collection, click More Info. When you do, the lower section 
of the screen displays the following information about the 
collection.

• title

• description

• ID number

• template
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• last user who edited it

• last date when it was edited

• date it was created

• whether or not the content folder’s subfolders can be included 

• for each content item in the collection

- a link to the content (click this to view and edit the content)

- ID number

- quicklink

Collections Toolbar
The following table describes the collection toolbar buttons.

Creating a Collection
Creating a collection involves two steps:

• ”Adding a Collection” on page 261

Button Name Description More Information

Add Add new collection or add items to a 
collection.

”Creating a Collection” 
on page 260

Remove Remove items from a collection. ”Removing Content from 
the Collection” on 
page 268

Reorder Reorder items in a collection. ”Reordering Collections 
List” on page 268

Edit Edit collection information. ”Editing Collection 
Information” on page 269

Delete Delete a collection. ”Deleting a Collection” on 
page 270

Back Return to previous screen.
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• ”Assigning Content to the Collection” on page 264
The following sections explain each step.

Note This section explains creating a collection in a site that does not support multiple 
languages. If you want to create collections in several languages, see ”Working 
with Collections in a Multi-Language System” on page 270 

See Also: ”Working with Collections” on page 254

Adding a Collection
To add a new collection, follow these steps.

1. Navigate to the folder in which you want to create the 
collection.

2. If you are using Ektron CMS400.NET’s multi-language support 
features, select the language. See Also: ”Working with 
Collections in a Multi-Language System” on page 270

3. Click the Collections button ( ).

NOTE If you access the collection via the Collections folder, you cannot choose the 
collection’s folder. It is automatically placed in the Content folder.

4. Click the Add button ( ).

5. The Add Collection screen appears.
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6. Complete the screen using the following table.

7. Click the Save button ( ).
You can now assign content to the collection. See ”Assigning 
Content to the Collection” on page 264.

Default Template vs. Quicklinks

You can specify a template that determines the screen display for a 
collection when it is published on a Web page. (See your system 
administrator for information about Ektron CMS400.NET templates.) 
Or, you can disable the template and, instead, use Quicklinks to 

Field Description

Title Assign a unique title to the collection.

Template Enter the default template for the collection. This template is used to 
display the content of the links generated if no template is assigned in the 
custom function.
If left blank, the links use their respective Quicklinks.
See Also: ”Default Template vs. Quicklinks” on page 262

Description Add a more detailed description for the collection.

Include Subfolders Check if you want to add to the collection content in subfolders of the 
content folder.



Working with Collections

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 263

determine the page template. (See Also: ”Quicklinks and Forms” 
on page 210)

If you specify a template, all content in the collection uses the 
same screen elements other than the specific content. For 
example, the page header, footer and information in the right frame 
of the screen are all the same. On the other hand, if you use 
Quicklinks, every page in the collection uses its original template. 
As a result, the surrounding information may change for every 
content item in the collection.

Here is an example of links using Quicklinks. Notice that content 
uses several templates. As a result, when a user clicks content in 
the collection, the screen information around the content changes 
according to its template.

Here is an example of links when using a template named 
index.asp. In this case, all pages have the same information 
surrounding the content.

To toggle between a default template and Quicklinks, follow these 
steps.
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1. Access the Edit Collection screen for the collection you want to 
edit.

2. Modify the Template field.

3. Click the Save ( ) button.

Assigning Content to the Collection
After a collection is created, your next step is to assign content to 
it. To do so, follow these steps.

NOTE When viewing a Collection on the Web site, the last published version of content 
appears. If the content has never been published, nothing appears.

1. Access the collections screen for the content folder in which 
you want to add the collection, as described in ”Finding a 
Collection by Navigating to its Content Folder” on page 256.

2. Access the View Collection Screen, as described in ”Viewing a 
Collection” on page 258.

3. Click the collection to which you want to assign content.

4. The View Collection screen appears.
5. Accept or change the language.

6. Click the Add button ( ).

7. The Add Items to Collection screen appears, displaying 
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• all subfolders within the selected folder (Subfolders are 
available if the Include subfolders field is checked for the 
collection.)

• content in the selected folder that is not part of the collection.
Note that the file types selection remembers your most recent 
choice and may filter which files appear. You can change that 
selection if desired.

8. Check boxes next to content to add to the collection. You can 
only add content from the selected folder or possibly its 
subfolders. 
Subfolders are available if the Include subfolders field is 
checked for the collection. Click a subfolder to view its content. 
To return to the parent folder, click the folder with the up arrow 

( ).

NOTE If you select content from a subfolder, click the add button to add the selected 
content to the collection. Navigating between subfolders deselects content.
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9. Click the Add button ( ).
See Also: ”Creating a Collection” on page 260; ”Working with 
Collections” on page 254

Creating New Content for a Collection

You can create new content while adding content links to a 
collection. To add content, follow these steps.

1. Access the View Collections screen for the content folder in 
which you want to add the collection, as described in ”Finding a 
Collection by Navigating to its Content Folder” on page 256.

2. Access the View Collection Screen for a collection, as 
described in ”Viewing a Collection” on page 258.

3. If you are using Ektron CMS400.NET’s multi-language support, 
select the language of the collection.

4. Click the Add button ( ).

5. The Add Items to Collection screen appears.
6. If your collection includes subfolders and you want to add the 

content to one of them, navigate to that subfolder. Otherwise, 
proceed to the next step.

7. Click the Add Content button ( ).

8. The Add Content screen appears. If you are using Ektron 
CMS400.NET’s multi-language support, the content’s language 
appears next to the title. The language is derived from the 
collection’s language and cannot be changed.
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9. Create the content.

NOTE Refer to ”Adding Content” on page 46 for additional information about creating 
new content.

10. Click a workflow option in the Add Content screen.
11. The Add Content screen closes, and the new content link 

appears in the list of links available to the collection.
12. Check off the content you created and other content.

13. Click the Add button ( ) to add the content to the collection.

Editing Content in a Collection
After a collection is created, you can add or remove links to and 
from it.
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Adding Content to the Collection
For information about adding content links to a collection, see 
”Assigning Content to the Collection” on page 264.

Removing Content from the Collection
To remove a content link from a collection, follow these steps.

1. Access the collections screen for the content folder in which 
you want to add the collection, as described in ”Finding a 
Collection by Navigating to its Content Folder” on page 256.

2. Access the View Collection Screen, as described in ”Viewing a 
Collection” on page 258.

3. Click the Remove button ( ).

4. The Delete Items from Collection screen appears.

5. Click boxes next to links that you want to delete.

Click Select All to select all boxes.
Click Clear All to remove all check marks.

6. Click the Delete button ( ).

Reordering Collections List
After a collection is created, and more than one content item is 
assigned to it, you can reorder the collections list. To do so, follow 
these steps.
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1. Access the collections screen for the content folder in which 
you want to add the collection, as described in ”Finding a 
Collection by Navigating to its Content Folder” on page 256.

2. Access the View Collection Screen, as described in ”Viewing a 
Collection” on page 258.

3. Click the Reorder button ( ).

4. The Reorder Collection screen appears.

5. Click the content whose order you want to change.

6. Click the up or down arrow to move the content in either 
direction.

7. Repeat steps five and six until you set the desired order.

8. Click the Update button ( ).

Editing Collection Information
To edit information about a collection, follow these steps.

1. Access the collections screen for the content folder in which 
you want to add the collection, as described in ”Finding a 
Collection by Navigating to its Content Folder” on page 256.

2. Access the View Collection Screen, as described in ”Viewing a 
Collection” on page 258.

3. Click the collection whose information you want to change.
4. Change any of the field values. For documentation of the fields, 

see ”Complete the screen using the following table.” on 
page 262.



Working with Collections

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 270

Deleting a Collection
When you no longer want a collection, you can delete it. To delete 
a collection, follow these steps.

1. Access the collections screen for the content folder in which 
you want to add the collection, as described in ”Finding a 
Collection by Navigating to its Content Folder” on page 256.

2. Access the View Collection Screen, as described in ”Viewing a 
Collection” on page 258.

3. Click the Delete button ( ).

4. A confirmation message appears.
5. Click OK to proceed.

Working with Collections in a Multi-Language 
System

In a multi-language Ektron CMS400.NET system, you can create a 
language-specific edition of each collection. For example, prior to 
the 4.7 Release, the RC International sample site’s products page 
had a collection in the default application language (English unless 
you change it). From 4.7 on, you can create an edition of a 
collection in every enabled language.

When a visitor to your site selects a language then navigates to a 
page with a collection, Ektron CMS400.NET displays the collection 
in the selected language if available. If not, Ektron CMS400.NET 
displays nothing.

NOTE Note the contrast between the collections and content: if a collection is not 
available in the selected language, nothing appears. But if content is not available 
in the selected language, content in the default language appears.

When creating a collection for a foreign language, decide if you 
want to create 

• a foreign edition of an existing collection, or

• a new collection in a foreign language
For example, if you want to provide several versions of a single 
page that change depending on the language selected by the user, 
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see ”Creating a Language-Specific Collection if Another Edition 
Exists” on page 271.

On the other hand, if you are creating a collection to appear only 
on a foreign language page, and no other edition of the collection 
will appear on your site, see ”Creating a Language-Specific 
Collection if Another Edition Does Not Exist” on page 271.

You can only add content in the language of a collection. So, 
create the content first, then create the collection that links to them.

Creating a Language-Specific Collection if Another Edition 
Exists

1. Click the content folder in which your collection exists. The 
folder’s contents are displayed.

2. Click the View Collections button ( ).

3. The View Collections screen is displayed.
4. Select the collection that you want to translate.
5. From the Add drop-down list, select the language of the new 

collection.

6. Using the Add button ( ), select the content to add to the 
collection. Navigate through the folders to the content you want 
to add. You can only add content in the selected language.

Creating a Language-Specific Collection if Another Edition 
Does Not Exist

1. Navigate to the folder in which you will create the collection.

2. Click the View Collections button ( ). The View Collections 
screen is displayed.

3. Click the Add button ( ) and enter basic information about 
the collection. (This screen is described in ”Creating a 
Collection” on page 260.)

4. The View Collections in Folder screen appears. Click the 
collection you just created.

5. From the Add drop-down list, select the language of the new 
collection.
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6. Using the Add button ( ), select the content to add to the 
collection. Navigate through the folders to the content you want 
to add. You can only add content in the selected language.

Comparison of Collections, Menus, and the List 
Summary Features

A menu, a collection, and the ListSummary function are similar in 
that they let you add a list of links to a Web page. The following 
table compares these features to help you understand which one 
would best accommodate your needs for a particular page.

NOTE To implement these features, the assistance of a developer is required.

Collection Menu List Summary

Display title of all content in 
a folder and possibly 
subfolders

X

Display title of selected 
content in a folder and 
possibly subfolders

X X

Display external hyperlinks 
& library assets

X

Display content summary 
(optional)

X X
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Display additional content 
information:

• comment

• last modified date

• start date

• end date

• user who last edited it

• ID number

• path relative to your 
site’s root

X

Can be multi-leveled (that 
is, you can have 
submenus)

X

Collection Menu List Summary



Working with Menus

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 274

Working with Menus

Ektron CMS400.NET’s Menu feature lets users create and maintain 
a dropdown menu system for your Web site. The menu options can 
link to content, library assets, external hyperlinks, and submenus. 
Below is a sample menu.

In this example (delivered with Ektron CMS400.NET), the menu 
appears when the person viewing the Web page moves the cursor 
over Products. The above display illustrates the menu’s 
appearance to a visitor to your site.

However, if a content contributor with permission to edit menus 
signs in to Ektron CMS400.NET then views the menu, it has 
additional options for editing the menu or adding content.

NOTE For more information on adding content, see ”Adding Content” on page 46.

This chapter describes the following aspects of managing menus: 
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• what they are

• how they can be used

• how to the add, edit, view and delete a them

What’s In This Chapter
The following information is included in this chapter:

• ”The Structure of Menus and Menu Items” on page 275

• ”Access to the Menus Feature” on page 276

• ”Adding a New Menu” on page 277

• ”Adding a Menu Item” on page 283

• ”Editing a Menu” on page 291

• ”Editing a Menu Item” on page 292

• ”Viewing a Menu” on page 301

• ”Reordering Menu Items” on page 306

• ”Deleting a Menu” on page 307

• ”Deleting a Menu Item” on page 308

• ”Working with Menus in a Multi-Language System” on 
page 309

The Structure of Menus and Menu Items
Menus have the following structure:

• menu - top level structure that is a placeholder for menu items 
and submenus. It is assigned to a content folder. If a menu item 
links to content, it must reside in the assigned folder or one of 
its subfolders.
A menu also identifies the page template used to display menu 
options that are content.

• menu item - the individual options on a menu; can be any of 
the following

- content

- library asset
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- external hyperlink (link to a page outside your Web site)

- submenu (a link to another menu. In the illustration below, 
the menu on the right is a submenu. It appears when the 
user hovers the cursor over the menu item to the left, RC 
Planes. The right pointing arrow indicates that a submenu 
is available.)

Access to the Menus Feature
There are three ways to access the Menus feature:

• the Workarea, by choosing the associated content folder then 

clicking the View Menus button ( )

• the Workarea, by choosing Modules > Menus
• the Edit Menu option on the sample menu displayed above
If you choose the first or second option, you then select a specific 
menu. Next, that menu appears on the View menus screen. For 
the third option, the selected menu appears on the View Menu 
screen.

From the View Menus screen, you can perform the following 
actions on a menu.

• Create a new menu

• Edit menu information (URL and template link)

• Translate the menu into another language

• Delete the menu

• Add or remove items
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• Change the sequence of menu items

• Edit menu items

• For submenus

- add /remove items

- change sequence of menu items

- edit menu information

- edit information about menu items

Managing Menus
Ektron CMS400.NET gives you the flexibility to add, edit, view and 
delete a menu. The following sections explains how to do that:

• ”Adding a New Menu” on page 277

• ”Adding a Menu Item” on page 283

• ”Adding New Content to a Menu via Navigation Link on a Web 
Page” on page 290

• ”Editing a Menu” on page 291

• ”Editing a Menu Item” on page 292

• ”Editing Types of Menu Items” on page 296

• ”Viewing a Menu” on page 301

• ”Reordering Menu Items” on page 306

• ”Deleting a Menu” on page 307

• ”Deleting a Menu Item” on page 308

• ”Working with Menus in a Multi-Language System” on 
page 309

See Also: ”Working with Menus” on page 274

Adding a New Menu
You can add a new menu by navigating to the folder that contains 
its content or by choosing Modules > Menus from the left frame of 
the Workarea. If you choose Modules > Menus
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• you cannot select the menu’s language -- it assumes the 
current language. In contrast, if you create a menu after 
choosing a content folder, you can select a language during the 
menu creation process.

• you cannot select the menu’s folder -- it is automatically 
assigned to the root folder. In contrast, if you create a menu 
after choosing a content folder, you select a folder while 
creating the menu.

Adding a Menu via Content Folder

1. Navigate to the content folder that contains the content you 
want to display on the menu. The content can reside in the 
selected folder or any of its subfolders.

2. In the View Language dropdown list, select the language of the 
menu you want to create.

3. Click the View Menus button ( ).

4. The View All Menus screen appears.

5. Click the Add button ( ).

6. The Add Menu screen appears.

7. At minimum, a menu requires a title. If you want to add more 
information, click Advance Settings. When you do, the lower 
section of the screen appears as shown below.



Working with Menus

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 279

8. Using the following table, complete the fields on the Add Menu 
screen.

Fields on the Add/Edit Menu Screen

Field Description

Title The name given to the menu by the creator. It appears on the Web 
page to indicate the kind of information on the menu.
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Image Link You can have an image appear next to or instead of the menu title. 
For example: 

To do this, follow these steps.

Note: Before beginning these steps, the image must reside in the 
library. if it does not, add it before proceeding. For more information, 
see ”Copying Files to the Library” on page 196.

1. Click the image icon ( ).

2. The library window opens.

3. Navigate to the folder that contains the image you want to use.

4. Click the Insert button ( ) to insert it.

Using Image to Replace Title Text
Alternatively, you can have the image replace the menu text, so that 
only the image appears to indicate the kind of information on the 
menu. To do this, check the Use image instead of a title checkbox.

Field Description
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URL Link After you create a menu, your developer links it to text or an image 
on a Web page by modifying a page template. As a result, when a 
user reading that Web page moves the cursor over the text or image, 
the menu appears. In the illustration below, the menu appears when 
the user moves the cursor over Products.

You can also assign a URL link to a menu, using this field. If you do, 
and the user clicks the link text or image, he jumps to the specified 
page.
For example, in this field you assign the product landing page, 
CMS400Example/products.aspx. In the illustration above, if the user 
moves the cursor over Products, the assigned menu appears. 
However, if the user clicks Products (as indicated by the hand), he 
jumps to CMS400Example/products.aspx.
Entering the Path to the Landing Page
This path must be relative. For example: /400Sample/index.aspx
This URL path can be a static template path (like the one mentioned 
above) or a dynamic path, such as 
/400Sample/index.aspx?id=25

Field Description
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6. Click the Save button ( ).

With the menu added, you may assign menu items to it. See 
”Adding a Menu Item” on page 283.

Adding a Menu via the Menus Module

1. From the left frame of the Workarea, click Modules > Menus.

2. Click the Add Menu button ( ).

Template 
Link Note: This field applies to content only. It has no effect on other types 

of menu items (such as images).

If you want to apply a template to this menu, enter the template here. 
If you do, all content on this menu use this template when selected 
from the menu.
If you do not enter a template here, the content on this menu uses 
the template specified in their Quicklink.
Overriding the Template Link
You can override the menu template for any content item on this 
menu and, instead, use the template specified in its Quicklink. To do 
so, follow these steps.

1. Add all items to the menu. (See ”Adding a Menu Item” on 
page 283)

2. Go to the View Menus option.

3. Click More Info.

4. Click the menu item you want to change.

5. At the Link field, change the value from Menu Template to 
Quicklink.

Important! If you created menus prior to upgrading to this version of 
Ektron CMS400.NET , those menu items are assigned as 
Quicklinks. You cannot change them to template links simply by 
entering a template link here. Instead, you must go to each menu 
item and change the Link field value from QuickLink to Menu 
Template (as illustrated above).

Description Add a more detailed description for the menu.

Field Description
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3. The Add Menu screen appears.

4. To complete the fields on the Add Menu screen, see ”Fields on 
the Add/Edit Menu Screen” on page 279.

With the menu added, you may assign menu items to it. See 
”Adding a Menu Item” on page 283.

Adding a Menu Item
Similar to being able to add, edit, view or delete a menu, Ektron 
CMS400.NET also allows you to add, edit, view and delete a menu 
item to a menu. See Also: ”The Structure of Menus and Menu 
Items” on page 275

Adding a Menu Item via Content Folder

To add a menu item via a content folder, follow these steps.

1. Navigate to the content folder that contains the menu to which 
you want to add items.

2. Click the View Menus icon ( ).

3. Click the menu that you want to add items to.
4. In the View Language dropdown list, select the language of the 

menu. See Also: ”Working with Menus in a Multi-Language 
System” on page 309

5. The Add Menu screen opens, displaying a list of items that can 
be added to the menu. The following illustration explains the 
icons on the screen.
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6. Click the Add Item button ( ).

7. Use the table below to select a type of menu item and follow 
the steps to add that menu item.

Adding a Menu Item via Menus Module

To add a menu item via the menus module, follow these steps.

Assign this type of content to 
the menu

For details, see

Content ”Adding Content as a Menu Item” on 
page 286

Any library asset: images, files, 
Quicklinks, hyperlinks to the menu

”Adding a Library Asset as a Menu 
Item” on page 287

External hyperlink ”Adding an External Hyperlink as a 
Menu Item” on page 288

Submenu to the main menu ”Adding a Submenu as a Menu Item” 
on page 288
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1. From the left frame of the Workarea, click Modules > Menus.
2. Click the menu that you want to add a menu item to.
3. In the View Language dropdown list, select the language of the 

menu.

4. Click the Add Item button ( ).

5. The Add Menu screen displays a list of items that you can add 
to the menu. Use to the table below to select the type of menu 
item and follow the steps to add it.

Adding a Menu Item via Navigation Link on a Web Page

1. Access the Web page that contains the link to display the 
menu.

2. Place the mouse on the hyperlink that causes the menu to 
appear.

3. The menu appears.

4. Click Edit Menu.

Menu item type For more information, see

Content ”Adding Content as a Menu Item” on 
page 286

Any library assets: images, files, 
Quicklinks, hyperlinks to the menu

”Adding a Library Asset as a Menu Item” 
on page 287

External hyperlinks ”Adding an External Hyperlink as a Menu 
Item” on page 288

Submenu to the main menu ”Adding a Submenu as a Menu Item” on 
page 288
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5. In the View Language dropdown list, select the language of the 
menu.

6. Click the Add Item button ( ).

7. The Add Menu screen displays a list of items you can add to 
the menu.

8. Use to the table below to select the type of menu item and 
follow the steps to add that menu item.

Adding Content as a Menu Item

To add content as a menu item, follow these steps.

1. Follow the directions in ”Adding a Menu Item via Content 
Folder” on page 283, ”Adding a Menu Item via Menus Module” 
on page 284, or ”Adding a Menu Item via Navigation Link on a 
Web Page” on page 285.

NOTE You can only add content that resides in the menu’s content folder or its 
subfolders.

2. Click the circle next to Content Block.
3. Click the Next... button.
4. The Add New item screen appears, listing all content in the 

folder (and its subfolders) in which you created the menu.
5. Click any folder to display its content.

Assign this type of content to 
the menu

For details, see

Content ”Adding Content as a Menu Item” on 
page 286

Any library assets: images, files, 
Quicklinks, hyperlinks to the menu

”Adding a Library Asset as a Menu 
Item” on page 287

External hyperlinks ”Adding an External Hyperlink as a 
Menu Item” on page 288

Submenu to the main menu ”Adding a Submenu as a Menu Item” 
on page 288
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6. Check all content you want to add to the menu.

7. Click the Add Item button ( ).

8. The View Menu screen reappears, showing the new content.

9. Click the Edit icon ( ) next to each new content item to 
access the Edit Menu Item screen. This screen lets you assign 
additional information to the menu item, such as the target 
window. See ”Fields on the Add/Edit Menu Screen” on 
page 279.

Adding a Library Asset as a Menu Item

To add a library asset as a menu item via a content folder or menus 
module, follow these steps.

1. Follow the directions in ”Adding a Menu Item via Content 
Folder” on page 283, ”Adding a Menu Item via Menus Module” 
on page 284, or ”Adding a Menu Item via Navigation Link on a 
Web Page” on page 285.

2. Click the radio button next to Library Asset option.
3. Click the Next button.
4. The library screen opens.
5. Navigate to the folder whose assets you want to add.
6. In the right frame, select the type of asset to insert (image, 

hyperlink, etc.).

NOTE To insert assets, the menu’s folder must contain library assets. However, you can 
insert library assets from other folders for which you have permission.

7. Select a library asset and click the Insert button ( ).

8. The Add New Item screen appears. Use the following table to 
complete that screen.

Name Description

Title Title of the library asset. When you insert the 
asset, the title is used for the title of the menu 
item. You can change it if needed.
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9. Click the Save button ( ). 

Adding an External Hyperlink as a Menu Item

To add an external hyperlink as a menu item via a content folder or 
menus module, follow these steps.

1. Follow the directions in ”Adding a Menu Item via Content 
Folder” on page 283, ”Adding a Menu Item via Menus Module” 
on page 284, or ”Adding a Menu Item via Navigation Link on a 
Web Page” on page 285.

2. Click the circle next to External Hyperlink.
3. Click the Next button.
4. The Add New Item screen is displayed.

5. Complete the fields as needed.

6. Click the Save button ( ). 

NOTE When adding an External Hyperlink menu item, the URL does not get added to 
the library nor is an ID assigned to it. So, when you save the menu item, it is not 
added to the CMS database nor can it be retrieved for future use.

Adding a Submenu as a Menu Item

To add a submenu as a menu item via content folder or menus 
module, follow these steps.

Browse Library If you want to insert a different asset, click the 
Browse Library... button to browse the library and 
select another asset.

Name Description

Field Description

Title Title of the new external hyperlink menu item.

URL Link The URL link for the external hyperlink. For 
example, www.google.com.
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1. Follow the directions in ”Adding a Menu Item via Content 
Folder” on page 283, ”Adding a Menu Item via Menus Module” 
on page 284, or ”Adding a Menu Item via Navigation Link on a 
Web Page” on page 285.

2. Click the radio button next to Submenu.
3. The Add Menu screen is displayed.
4. Complete the fields using ”Fields on the Add/Edit Menu 

Screen” on page 279 as a reference.

5. Click the Save button ( ).

Adding an Item to a Submenu

1. From the left frame of the Workarea, click Modules > Menus.
2. Select the menu.
3. Find the submenu to which you want to add items. (Submenus 

have a folder icon ( ) next to them.)

4. Click the Add Item icon ( ) next to the submenu.
5. The Add Menu screen opens, displaying items you can add.
6. Refer to the table below for selecting a menu item and follow 

the steps to add it.
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Adding New Content to a Menu via Navigation Link on a Web 
Page

NOTE You can only use this feature after your Web developer has modified a page 
template to display the menu. This procedure is described in the Ektron 
CMS400.NET Developer Manual section “Custom ASP Functions” > “Menus.”

To add new content to a menu via a navigation link on a Web page, 
follow these steps.

1. Access the Web page that contains the link to display the 
menu.

2. Place the mouse on the hyperlink that causes the menu to 
appear.

3. The menu appears.

Assign this type of content to 
the menu

For details, see

Content ”Adding Content as a Menu Item” on 
page 286

Any library asset: images, files, 
Quicklinks, hyperlinks to the menu

”Adding a Library Asset as a Menu 
Item” on page 287

External hyperlink ”Adding an External Hyperlink as a 
Menu Item” on page 288

Submenu to the main menu ”Adding a Submenu as a Menu Item” 
on page 288
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4. Click ( ) Add Content.

NOTE The Add Content option lets you only add new content to a menu. You cannot add 
another type of menu item using this button.

5. A screen displays the name of the current folder and its 
subfolders. To create the new content in the current folder, click 
Next. To create it in subfolder, click it.

6. The Add Content screen opens, allowing you to enter 
information. Enter all information in the Add Content screen 
and click the Publish button. See Also: ”Adding Content” on 
page 46

7. The content is added to the menu.

Editing a Menu
You can edit a menu via:

• its content folder 

• menus module

• navigation link on a Web page
This section describes each option.

Editing a Menu via its Content Folder

To edit a menu from a content folder, follow these steps.

1. Access the View Menu screen, as described in ”View a Menu 
via its Content Folder” on page 301.

2. Click the Edit button ( ). 

3. The Edit Menu screen is displayed.
4. As necessary, change the fields in Edit Menu screen by 

referencing ”Fields on the Add/Edit Menu Screen” on 
page 279.

5. Click the Save button ( ).
Editing a Menu via Menus Module

To edit a menu via the Menus Module, follow these steps.
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1. Access the View Menu screen, as described in ”Viewing a 
Menu via the Menus Module” on page 305.

2. Click the Edit button ( ). 

3. The Edit Menu screen is displayed.
4. As necessary, update the fields in Edit Menu screen by 

referencing ”Fields on the Add/Edit Menu Screen” on 
page 279.

5. Click the Save button ( ). 

Editing a Menu via Navigation Link on a Web Page

To edit a menu via a navigation link on a Web page, follow these 
steps.

1. Navigate to the Web page that contains the link to display the 
menu.

2. Click the menu link.
3. The menu appears.

4. Click the Edit option.
5. The View Menu screen for the menu appears.

6. Click the Edit button ( ).

7. The Edit Menu screen is displayed.
8. As necessary, update the fields by referencing ”Fields on the 

Add/Edit Menu Screen” on page 279.

9. Click the Save button ( ).

Editing a Menu Item
You can edit a menu item via:
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• its content folder

• menus module

• navigation link on a Web page
See Also: ”Working with Menus” on page 274

Editing a Menu Item via its Content Folder

To edit a menu item from its content folder, follow these steps.

1. Access the View Menu screen, as described in ”View a Menu 
via its Content Folder” on page 301.

2. Click the menu you want to edit.
3. The View Menu screen for that menu appears, listing all menu 

items.

Icons on the View Menus Screen

The following icons indicate the type of each menu item and the 
options you can perform on them.
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Editing a Menu Item via Menus Module

To edit a menu via the Menus module, follow these steps.

1. Access the Menu Report screen, as described in ”Viewing a 
Menu via the Menus Module” on page 305.

2. Click the menu you want to edit.

Icon Menu item type Available actions For more information, see

Submenu Add submenu item ( ) ”Adding an Item to a Submenu” 
on page 289

Reorder submenu items 
( )

”Reordering Menu Items” on 
page 306

Edit submenu ( ) ”Fields on the Add/Edit Menu 
Screen” on page 279

Delete submenu ( ) ”Deleting a Submenu” on 
page 307

Web page on your site Edit Web page on your site 
( )

”a Content Menu Item” on 
page 296

Delete Web page on your 
site ( )

”Removing a Menu Item via its 
Content Folder” on page 308

External Web page Edit external Web page 
( )

”Editing an External Hyperlink 
Menu Item” on page 300

Delete External Web 
page( )

”Removing a Menu Item via its 
Content Folder” on page 308

Library asset Edit library asset ( ) ”Editing a Library Asset Menu 
Item” on page 300

Delete library asset ( ) ”Removing a Menu Item via its 
Content Folder” on page 308
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3. The View Menu screen for that menu appears, listing all items 
on the menu. Tho following illustration lists the four types of 
menu options. For more information on working with these 
options, see ”Icons on the View Menus Screen” on page 293.

Editing a Menu Item via Navigation Link on a Web Page

To edit a menu via navigation link on a Web page, follow these 
steps.

1. Access the template where you inserted the link to display the 
menu.

2. Click the Menu Navigation link title on the Web page.
3. A DHTML menu is displayed along with all menu items on the 

menu.
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4. Click Edit Menu.
5. The Edit Menu Item screen appears.
6. See ”Editing a Menu Item via its Content Folder” on page 293.

Editing Types of Menu Items
This section explains how to edit the following types of menu 
items:

• content on your Web site

• library asset

• link to an external Web site

• submenu
Editing a Content Menu Item

To edit a content menu item via its content folder or menus module, 
follow these steps.

1. Navigate to the menu you want to edit by referencing ”Viewing 
a Menu” on page 301.

2. The View Menu screen displays the menu items.

3. Click the edit icon ( ) next to the content ( ) you want to edit.

4. The Edit Menu Item screen opens.
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5. Using the table below as a reference, make changes to the 
content menu item.

Fields on the Edit Menu Item Screen

Field Description

Title The name that was given to the menu item by the creator. Edit if 
needed.

Description Add a more detailed description for the content menu item that is 
being edited. 
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Image Link You can have an image appear next to or instead of the menu title. 
For example: 

To do this, follow these steps. 

Note: Before beginning these steps, the image must reside in the 
library. if it does not, add it before proceeding. For more information, 
see ”Copying Files to the Library” on page 196.

1. Click the image icon ( ).

2. The library window opens.

3. Navigate to the folder that contains the image you want to use.

4. Click the Insert button ( ) to insert it.

Using Image to Replace Title Text
Alternatively, you can have the image replace the menu text, so that 
only the image appears to indicate the kind of information on the 
menu. To do this, check the Use image instead of a title checkbox.

Field Description
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5. Click the Save button ( ). 

URL Link After you create a menu, your developer links it to text or an image 
on a Web page by modifying a page template. As a result, when a 
user reading that Web page moves the cursor over the text or image, 
the menu appears. In the illustration below, the menu appears when 
the user moves the cursor over Products.

You can also assign a URL link to a menu, using this field. If you do, 
and the user clicks the link text or image, he jumps to the specified 
page.
For example, in this field you assign the product landing page, 
CMS400Example/products.aspx. In the illustration above, if the user 
moves the cursor over Products, the assigned menu appears. 
However, if the user clicks Products (as indicated by the hand), he 
jumps to CMS400Example/products.aspx.
Entering the Path to the Landing Page
This path must be relative. For example: /400Sample/index.aspx
This URL path can be a static template path (like the one mentioned 
above) or a dynamic path, such as 
/400Sample/index.aspx?id=25

Target Select how the library menu item will display.

• Popup: Opens in a new browser window

• Self: Opens in the same window

• Parent: Opens in the parent window

• Top:

Note: By default, the target option is set to self.

Link See ”Template Link” on page 282

Field Description
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Editing a Library Asset Menu Item

To edit a library menu asset via its content folder or menus module, 
follow these steps.

1. Navigate to the menu whose items you want to edit by 
referencing ”Viewing a Menu” on page 301.

2. The View Menu screen displays the menu items.

3. Click the edit icon ( ) next to the library asset ( ) you want 
to edit.

4. The Edit Menu Item screen opens.
5. Make changes to the library asset menu item. For 

documentation of the fields, see ”Fields on the Edit Menu Item 
Screen” on page 297.

6. Click the Save button ( ). 

Editing an External Hyperlink Menu Item

To edit an external hyperlink menu item via its content folder or 
menus module, follow these steps.

1. Navigate to the menu that you want to edit by referencing 
”Viewing a Menu” on page 301.

2. The View Menu screen displays the menu items.

3. Click the edit icon ( ) next to the external hyperlink ( ) you 
want to edit.

4. The Edit Menu Item screen opens. Update as needed. Use the 
table below to guide you through the fields.

5. Click the Save button ( ). 

Name Description

Title Title of the new external hyperlink menu item.

URL Link The URL link for the external hyperlink. For 
example, www.google.com.



Working with Menus

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 301

Editing a Submenu Menu Item

To edit a submenu menu item via its content folder or menus 
module, follow these steps.

1. Navigate to the menu for which you want to edit the menu 
items for by referencing to ”Viewing a Menu” on page 301.

2. The View Menu screen opens, displaying a list of all menu 
items.

3. Click the submenu icon ( ) to display its contents.

Viewing a Menu
Just like editing an existing menu, you can view a menu via:

• its content folder 

• menus module

• navigation link on a Web page
When viewing a menu via the content or menu folder, you get an 
internal view of information entered by menu creator. When 
viewing via a navigation link on a Web page, you get an external 
view of the menu, as seen by anyone navigating Web site.

View a Menu via its Content Folder

To access a menu via its content folder, follow these steps.

To edit a See this section

Content ”Editing a Content Menu Item” on page 296

Library 
Asset

”Editing a Library Asset Menu Item” on page 300

External 
Hyperlink

”Editing an External Hyperlink Menu Item” on page 300

Submenu ”Fields on the Add/Edit Menu Screen” on page 279
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1. Access the Workarea and navigate to the content folder that 
contains the menu.

2. Click the View Menus button ( ).

3. The View All Menus screen displays a list of menus in that 
folder.

4. Click the menu you want to view.

5. The menu’s options appear. The following illustration describes 
the icon accompanying each option.

6. Click More Info to view the details about the menu.
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7. The following information appears on the More Info section of 
the View Menus screen.
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The View Menu screen also provides the following buttons. 

Name Description

Information about 
menu items

See ”Editing a Menu Item via its Content Folder” on 
page 293

Title Title assigned to the menu folder.

ID ID number assigned to the menu by Ektron CMS400.NET. 

Note: The menu ID is automatically generated when you 
create a menu.

Language ID The decimal number representing the menu’s language.

Path Path to the content folder that contains the menu.

Last User to Edit Last user to edit this menu.

Last Edit Date Date and time when this menu was last edited.

Date Created Date and time when this menu was created.

Description Description given to the menu.

Button Name Description More Information

Add Menu Item Add item to menu ”Adding a Menu Item” 
on page 283

Remove Menu 
Item

Remove item from the menu ”Deleting a Menu Item” 
on page 308

Reorder Menu 
Item

Adjust sequence of menu items ”Reordering Menu 
Items” on page 306

Edit Menu Edit existing menu ”Editing a Menu” on 
page 291
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Viewing a Menu via the Menus Module

To access the menu via the Modules folder, follow these steps.

1. From the left frame of the Workarea, click Modules > Menus.
2. The Menus Report screen displays all menus.

3. Continue from the section ”Click the menu you want to view.” 
on page 302.

View Menus via Navigation Link on a Web Page

To access the menu via a navigation link on a Web page, follow 
these steps.

1. Access the Web page on which your Web developer inserted 
the link to display the menu.

2. Click the link that launches the menu on the Web page.

Delete Menu Delete menu and its menu items ”Deleting a Menu” on 
page 307

Back Return to previous screen

Button Name Description More Information
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3. A DHTML menu is displayed along with all menu items on the 
menu.

For information on how to display a menu on a Web page, refer to 
the section on menus in the Developers Manual.

Reordering Menu Items
To rearrange the items on a menu, follow these steps.

1. Navigate to the menu you want to rearrange. See ”Viewing a 
Menu” on page 301.

2. Click the Reorder button ( ).

3. The Reorder Items screen appears.

4. Click the item you want to move.
5. Click the up arrow to move it up, or the down arrow to move it 

down.

6. When finished, click the Save button ( ).
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Deleting a Menu
Similar to editing and viewing a menu, you can delete a menu via

• its content folder

• menus module
You cannot delete a menu from the navigation link on a Web page.

Deleting a Menu via Content Folder

To delete a menu via its content folder, follow these steps.

1. Access the View Menu screen, as described in ”View a Menu 
via its Content Folder” on page 301.

2. Click the Delete button ( ).
3. A confirmation message is displayed.
4. Click OK to delete the menu.

NOTE Deleting a menu automatically deletes all menu items associated with it. Do not 
confuse the menu link with the item itself. For example, deleting a menu deletes 
its links to content but has no effect on the content.

Deleting a Menu via Menus Module

To delete a menu via its menus module, follow these steps.

1. Access the View Menu screen, as described in ”Viewing a 
Menu via the Menus Module” on page 305.

2. Click the Delete button ( ).

3. A confirmation message is displayed.
4. Click OK.

NOTE Deleting a menu automatically deletes all menu items associated with it. Do not 
confuse the menu link with the item itself. For example, deleting a menu deletes 
its links to content but has no effect on the content.

Deleting a Submenu

1. Access the View Menu page, as described in ”Viewing a Menu 
via the Menus Module” on page 305.

2. Select the submenu.
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3. Click the delete icon ( ) to the right of the submenu 
(surrounded in red below).

Deleting a Menu Item
Similar to editing and viewing a menu, you can remove a menu 
item from a menu via

• its content folder

• its menu folder
Removing a Menu Item via its Content Folder

You can delete any menu item by clicking the accompanying 
Delete icon ( ) on the View menu screen.

Alternatively, you can follow these steps. The procedure below is 
quicker if you are deleting several or all items at once.

1. Access the View Menu screen, as described in ”View a Menu 
via its Content Folder” on page 301.

2. Click the menu you want to delete.
3. The View Menu screen for that menu is displayed.

4. Click the Remove button ( ).

5. The Delete Menu Item screen opens.
6. Click the check box next to the menu item you want to delete.

You can click Select All to choose all menu items. Click Clear 
All to unselect all menu items.

7. Click the Delete button ( ).
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Removing a Menu Item via Menus Module

You can delete any menu item by clicking the accompanying 
Delete icon ( ) on the View menu screen.

Alternatively, you can follow these steps. The procedure below is 
quicker if you are deleting several or all items at once.

1. Access the View Menu screen, as described in ”Viewing a 
Menu via the Menus Module” on page 305.

2. Click the Remove button ( ).

3. The Delete Menu Item screen opens.
4. Click the checkbox next to the menu item you want to delete. 

You can click Select All to choose all menu items delete. Click 
Clear All to unselect all menu items.

5. Click the Delete button ( ).

Working with Menus in a Multi-Language System

NOTE For background information about supporting multiple languages on your Web 
site, see the Ektron CMS400.NET Administrator manual section “Multi-
Language Support” > “Working with Multi-Language Content.” 

You can create an edition of any menu in every supported 
language. When a site visitor selects a language, navigates to a 
page that has a menu and clicks the menu link, Ektron 
CMS400.NET displays the menu in the selected language if it is 
available. If a menu in that language is not available, nothing 
appears.

Before creating or translating a menu, it’s a good idea to create or 
translate all content that will be on the menu. In this way, you can 
link this content to the new menu. However, after creating a menu, 
you can add new items to it.

Translating a Menu

To translate a menu into any supported language, follow these 
steps. You can navigate to the menu via the Web site or from the 
Workarea. Each procedure is described below.
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By Navigating the Site

1. Sign on to Ektron CMS400.NET and select the language in 
which the menu currently exists.

2. Navigate to the page that has the menu you want to translate.
3. Click the menu and the Edit Menu option.

4. The View Menu screen appears for the selected menu.
5. From the Add drop-down list, select the language into which 

you want to translate the menu.

6. The Add Menu screen appears. Complete the screen for the 
menu in the selected language. See ”Fields on the Add/Edit 
Menu Screen” on page 279.

7. Click the Save button ( ).

8. The View Menu screen reappears. Now, the View In drop-
down list displays the menu’s new language.
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9. Add items to the menu. See ”Adding a Menu Item” on 
page 283. If adding content, you can only insert one in the 
selected language.

10. Later, you can add more menu items, edit them, delete them, 
view them, etc. These capabilities are described in this chapter.

By Accessing the Menus Report Screen

1. From the Workarea screen, click Modules > Menus.
2. Click the menu you want to translate.
3. Follow the instructions from Step 3 in ”By Navigating the Site” 

on page 310.
Creating a Menu in Any Language

To create a menu in any language, follow these steps. 

1. Form the Workarea screen, click Modules > Menus.
2. From the language drop-down list, select the new menu’s 

language.

3. Create the menu. See ”Adding a New Menu” on page 277.
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Working with Calendars

Calendars in Ektron CMS400.NET perform the same function as a 
paper calendar: they keep one or more users informed about 
upcoming events. They can be displayed to all visitors to your Web 
site, and any authorized user can add events to a calendar.

Typical calendar events could include

• company meeting

• reserving a conference room for an interview

• company holidays

• deadlines
These are only a few uses of calendar events. Calendars are 
versatile and can easily meet all of your needs. A sample calendar 
appears below.
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The Calendar Feature is explained through the following topics:

• ”Understanding Calendars” on page 314

• ”Accessing the View Calendar Screen” on page 315

• ”Viewing a Calendar” on page 320

• ”Tips on Viewing a Calendar” on page 322

• ”Adding a Calendar Event” on page 324

• ”Understanding Event Types” on page 327

• ”Viewing a Calendar Event” on page 329

• ”Editing Calendar Events” on page 331

• ”Deleting Calendar Events” on page 333
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Understanding Calendars
Before working with calendars, you should understand the 
following points.

• Ektron CMS400.NET supports several calendars at one time. 
There might be a site-wide calendar, and other calendars for 
special interests, such as an athletic events calendar.

• Each date can display several events.

• Only system administrators can create a calendar.

• Each calendar is assigned to a content folder (See Also: 
”Working with Folders and Content” on page 32). Your ability to 
view, add, edit, and remove calendar events is determined by 
your permissions for that folder.

• The following illustrates the workflow of calendar tasks.



Working with Calendars

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 315

Accessing the View Calendar Screen
The View Calendar screen collects general information about a 
calendar, and provides toolbar buttons that let you perform 
calendar-related activities.

To access the View Calendar screen, follow these steps.

1. Access the Modules folder from the lower left corner of the 
Workarea.
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2. Click the Calendars folder.

3. The Calendar Modules screen appears. It lists all calendars in 
Ektron CMS400.NET.

Note Only system administrators can create a new calendar.

4. Click a calendar.
5. The View Calendar screen appears, showing information about 

the calendar.
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The following table explains the fields on the View Calendar 
screen.

Field Description

Title Title given to the calendar. The title identifies the calendar within the 
Workarea.
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ID ID number automatically assigned to calendar. This is used to 
display the calendar on a Web page.

Description Description given to the calendar.

Location Label Label for the calendar’s location information. This label appears on 
the calendar when a location is assigned to a calendar event.

Start Time Label Label for the calendar’s start time. This appears on the calendar 
when a start time is assigned to a calendar event.

End Time Label Label for the calendar’s end time data. This appears on the calendar 
when an end time is assigned to a calendar event.

Table Properties:
Display Weekends

A green check ( ) means the calendar displays every day of the 
week. A red X ( ) means the calendar displays weekdays only.

Forward Only If a green check ( ) appears next to Show only events that fall 
after the viewing day, and the user viewing the calendar is not 
logged in, the calendar only displays events from the viewing date 
forward. No past events appear.
A logged-in user can view past calendar events.

Field Description
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Event Type Label Indicates if event types are assigned to this calendar.

See Also: ”Understanding Event Types” on page 327
One section of the Add Calendar Events screen displays available 
event types and lets the user assign them to the event.

By default, this text is Event Type:. Your system administrator can 
edit the text.

Event Types Available A green check ( ) means you can add event types to the calendar.

Event Types Required A green check ( ) means that when entering a calendar event, you 
must assign an event type to it.

Instructions If this calendar uses event types, text appears at the bottom of the 
screen that explains how to use the event type selection box. By 
default, this text is Select Event Type to View:.

Your system administrator can change this text.

Show All Label If this calendar uses event types, the list of event types appears at 
the bottom of the screen. On top of the list is text indicating that all 
event types will appear on the calendar. By default, this text is Show 
All.

Your system administrator can change this text.

Long Description Lets the user enter additional text while adding a calendar event.

Field Description
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The View Calendar screen may contain the following toolbar 
buttons that let you perform other tasks.

Viewing a Calendar
NOTE This section explains how to view a calendar and enter calendar events from the 

Workarea. Once a calendar is available on your Web site, you can also perform 
these actions by logging in and navigating to the calendar on your site.

To view a calendar, follow these steps.

1. Access the View Calendar screen for the calendar you want to 
see, as described in ”Accessing the View Calendar Screen” on 
page 315.

2. Click the View Calendar ( ) button.

3. The calendar appears.

Folder Name Name of content folder to which the calendar is assigned for 
permission purposes.
You can only add, edit or delete events for calendars in folders to 
which you have been granted permission.

Folder Path Complete path to the calendar’s content folder.

Field Description

Button Name Description More Information

View 
Calendar

Show calendar in the Workarea ”Viewing a Calendar” on 
page 320

Back Return to previous screen
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See Also:  ”Tips on Viewing a Calendar” on page 322.

4. If you want to view events of a certain type only, click the 
Select Event Type to View drop-down list (illustrated below). 
Then, choose an event type. See Also: ”Understanding Event 
Types” on page 327

The page is refreshed, and the calendar displays events of that 
type only.
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From here, you can perform the following tasks. Note that the Add 
and View buttons appear on each calendar day, while the Return 
button is on the toolbar at the top of the screen. 

See Also: ”Working with Calendars” on page 312

Tips on Viewing a Calendar
• The monthly calendar displays the current month. In the 

intranet sample, today is highlighted in yellow (illustrated 
below).
At the top of the calendar are the previous and next months. 
Click them to view those months.

Click on Action More Information

Add Calendar Event ”Adding a Calendar Event” on page 324

View Calendar Events ”Viewing a Calendar Event” on page 329

Return to Previous Screen Return to previous screen

Event title within 
calendar (sample 
below)

Jump to calendar event’s 
Web page (if available)
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• Where an event appears, move the cursor over it to see a 
popup box with the event name, location, and start and end 
times.
If a Web page is linked to the event, you can click the event 
name to jump to that page.

• Click the number that represents any day to view detail for that 
day (illustrated below).

• From the daily view, you can

- see all events and the hours they span

- proceed to the previous or next day (click a date in the upper 
left or right corner)

- return to the month view by clicking on today’s date

- view detail about an event by clicking on it

• From the event view (illustrated below), you can view the 
event’s location and start and end times. Click the date to 
return to the daily view.
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Adding a Calendar Event
NOTE You can only add a calendar event if you have add or edit permission for the 

calendar’s folder.

To add a calendar event, follow these steps.

1. Access the calendar to which you want to add an event, as 
described in ”Viewing a Calendar” on page 320.

NOTE You can also add a calendar event after viewing the View Events screen. See 
Also: ”Viewing a Calendar Event” on page 329

2. Navigate to the month and day for which you want to add a 
calendar event.
Your calendar display is determined by your system 
administrator.

3. Click the Add Event ( ) button.
4. The Add Calendar Event screen appears.

NOTE Folder information appears at the bottom of the screen only if the folder has 
subfolders or content under it.
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5. Respond to the fields using the following table as a reference.

Field Description

Event Title Enter a title for the event.

Note: If you enter a Quicklink in the Hyperlink field, the Quicklink’s content 
title replaces this title. You can then edit the new title if desired.
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Event Location If desired, enter a location for the event (for example, Conference Room 1 or 
Cafeteria).

One Time/
Recurring

If you want to enter a one-time only event, continue reading.
If you want to add a recurring event, see ”Adding a Recurring Event” on 
page 328.

Date Click the calendar icon ( ) to display a calendar. From it, select a start date.

Technical note: If you see a mix-up of the month and date of your entry (for 
example, you select March 2 but see February 3), make sure the date format 
specified in the Windows Control Panel Regional Settings dialog matches 
your current language. Also, make sure the settings apply to the default user. 

Start Time Click the clock icon ( ) to display a clock. From it, select a start time.

End Time Click the clock icon ( ) to display a clock. From it, select an ending time for 
the event.

Display the times 
for the event

Check this box if you want the calendar to display the event’s start and end 
times (illustrated below).

The time also appears on the event detail if this box is checked.

Field Description
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6. Click Save ( ).

Understanding Event Types
Your system administrator can set up types of calendar events. For 
a personal or workgroup calendar, examples might be staff 
meetings, employment interviews, conference calls. For an 
educational institution, examples might be academic deadlines, 
sporting events, and tuition due dates.

Hyperlink You can link a Web page to this calendar event. The Web page could contain 
more information about the event, directions to it, etc.
If you insert a hyperlink, when this event appears on the calendar, the reader 
can click the event to jump to that page.
To enter any page on the internet, enter its Web address. For example, 
www.ektron.com.

To link to content on your Web site, click the library button ( ). (This type of 
link is known as a Quicklink.) The Quicklinks dialog appears, and you can 
navigate to the content.
The last published version of linked content appears. If content has never 
been published, nothing appears.
If you select a hyperlink, the title of the selected content replaces any text in 
the Event Title field. You can edit the new title if desired.

Launch link in a 
new browser

Check this box if you want the Web page or Quicklink specified in the 
Hyperlink field to appear in a new browser window when someone clicks it.
If you do not check this box, the new Web page replaces the current one 
when the link is clicked.

Event Type Note: This field only appears if your system administrator set up one or more 
event types for this event.
See Also:  ”Understanding Event Types” on page 327

To apply an event type to this event, click an Event Type from the right 

column. Then, click the Right Arrow ( ) to move the event type to the 
Selected column.
Repeat for each event type you want to assign to the event.

Field Description
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If you assign a type to an event while creating it, you can later 
display only events of that type. This feature lets the viewer 
temporarily suppress unwanted events. As a result, the calendar 
display is cleaner, because it only shows relevant information.

Adding a Recurring Event
You can assign an event to occur multiple times on a calendar. To 
do so, follow these steps.

1. Add a calendar event (as described in ”Adding a Calendar 
Event” on page 324).

2. Click the Recurring tab to assign the event for more than one 
day.
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3. Refer to the table below to complete to the Recurring fields.

4. Finish your edits. 

5. Click the Save button ( ).

Viewing a Calendar Event
Once events are added to a calendar, you can easily view them. To 
view a calendar event, follow these steps.

Field Description

Start Date Click the calendar icon ( ) to display a calendar. From it, select a start date.

Technical note: If you see a mix-up of the month and date of your entry (for 
example, you select March 2 but see February 3), make sure the date format 
specified in the Windows Control Panel Regional Settings dialog matches 
your current language. Also, make sure the settings apply to the default user.

End Date Click the calendar icon ( ) to display a calendar. From it, select an end date 
for the series of recurring events.

Event will occur Select the frequency of the event from among the choices.

For documentation of See

Start Time ”Start Time” on page 326

End Time ”End Time” on page 326

Display the times for the event ”Display the times for the event” on 
page 326

Hyperlink ”Hyperlink” on page 327

Launch Link in New Browser ”Launch link in a new browser” on 
page 327

Event Types ”Event Type” on page 327
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1. Access the Show Calendar screen for the calendar that 
contains the event you want to view, as described in ”Viewing a 
Calendar” on page 320.

2. Place the cursor on the event you want to view.

3. Click the View Events ( ) button.

4. The View Events screen appears, listing all calendar events for 
that date. If an event is part of a series of recurring events, the 
following icon appears next to it: 
From this screen, you can perform the following functions:

- Add a new event (See Also: ”Adding a Calendar Event” on 
page 324)

- View, edit, and delete an existing event
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Editing Calendar Events
The section explains how to edit a single event or a recurring 
series of events.

NOTE You can only edit a calendar event if you have edit permission for the folder to 
which the calendar is assigned.

See Also: ”Adding a Calendar Event” on page 324

Editing a Single Event
After a calendar event is added to a calendar, you may edit it to 
change the title, location, times, etc. To edit a calendar event, 
follow these steps.

1. Access the View Calendar Events screen for the date that 
contains the event you want to edit, as described in ”Adding a 
Calendar Event” on page 324.

2. Click the event you want to edit.
3. The Edit Calendar Event screen appears.
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4. Update the fields using the table described in ”Adding a 
Calendar Event” on page 324 as a reference.

5. Click the Save button ( ).

Editing Recurring Events
After a recurring series of events is added to a calendar, you may 
edit it to change the title, location, hyperlink, and event type.
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NOTE You cannot edit event dates or times. To change those, delete and re-enter the 
series of events.

To edit a recurring series of events, follow the steps in ”Editing a 
Single Event” on page 331. The only difference is the Update all 
recurring events associated with this event box.

To apply the edits to only the instance of the event that you 
selected, uncheck the box. To apply the changes to all instances, 
check the box.

Deleting Calendar Events
The section explains how to delete a single event or a recurring 
series of events.

NOTE You can only delete a calendar event if you have add, edit, or delete permission 
for the content folder to which the calendar is assigned.

Deleting a Single Occurrence Calendar Event
You can easily delete calendar events that are no longer needed, 
or do not belong to the calendar they were added to. To delete a 
calendar event, follow these steps.

1. Access the View Calendar Events screen for the date that 
contains the event you want to delete, as described in ”Adding 
a Calendar Event” on page 324.

2. Click the event you want to delete.
3. The Edit Calendar Event screen appears.

4. Click the Delete button ( ).

5. A confirmation message appears.
6. Click OK.

Deleting a Recurring Calendar Event
You can delete a single event in a recurring series or all events in 
the series.

Deleting a Single Recurring Event
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1. Access the View Calendar Events screen for the date that 
contains the event you want to delete, as described in ”Adding 
a Calendar Event” on page 324.

2. Click the event you want to delete.
3. The Edit Calendar Event screen appears.

4. Click the Delete Content button ( ).

5. A confirmation message appears.
6. Click OK.

Deleting All Events in a Recurring Series

1. Access the View Calendar Events screen for any date that 
contains an events in the series that you want to delete, as 
described in ”Adding a Calendar Event” on page 324.

2. Click the event in the series that you want to delete.
3. The Edit Calendar Event screen appears.
4. Click the Delete This and Associated Recurring Events button 

( ).
5. A confirmation message appears.
6. Click OK.
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Managing Tasks

A task is a request from one user to another to perform an action 
within Ektron CMS400.NET. Examples of a tasks include:

• updating content

• publishing content

• updating an image

• reordering a collection

The Tasks folder displays all tasks that are either assigned to you 
or that you assigned to another user or user group. You can also 
assign tasks to yourself.

A task may or may not be related to a specific piece of content. If it 
is, you can access content then “attach” a task to it. This kind of 
task is managed just like the other tasks, but you can also view and 
update it via the attached content. For more information, see 
”Viewing a Task” on page 347.

This chapter explains how to work with tasks through the following 
topics.

• ”Creating a Task via the Task Folder” on page 336

• ”Creating a Task from the Web Site” on page 346

• ”Creating a Task via the Content Folder” on page 346

NOTE Tasks can also be created automatically when forms are submitted. See Also: 
”Assigning a Task to a Form” on page 170

• ”Viewing a Task” on page 347

• ”Editing a Task” on page 352

• ”Adding Comments to Tasks” on page 353

• ”Deleting a Task” on page 355

• ”Viewing a Task’s History” on page 356
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• ”Task Module Toolbar” on page 357

Creating a Task via the Task Folder
This topic consists of the following subtopics:

• ”Accessing the Tasks Folder” on page 336

• ”Creating a Task via the Task Folder” on page 337

• ”Adding a Task Category and Task Type” on page 342

Accessing the Tasks Folder
To access the Tasks folder, follow these steps.

1. Access your Smart Desktop, as explained in ”Understanding 
the Smart Desktop” on page 20.

2. The Smart Desktop folders appear in the top left frame.

3. Click the Tasks folder. The following subfolders appear:

• Assigned To Me - tasks assigned to you

• Assigned By Me - tasks you assigned to someone else

• Created By Me - tasks you created

• Assigned To User - search for tasks assigned to a user

• Not Started - tasks whose state is set to not started

• Active - tasks whose state is set to Active

• Awaiting Data - tasks whose state is set to Awaiting Data

• On Hold - tasks whose state is set to On Hold

• Pending - tasks whose state is set to Pending

• Reopened - tasks whose state is set to Reopened
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• Complete - tasks whose state is set to Reopened
You can click any folder to view only tasks in that category.

Also, the View Tasks screen appears in the right frame, listing all 
tasks assigned to you, or assigned by you.

From this page, you can view, sort, update, or add tasks. To learn 
more about the View Tasks screen, see ”Viewing a Task” on 
page 347.

To learn about sorting by Task Type, see ”Sorting Tasks By Task 
Type” on page 350.

Creating a Task via the Task Folder
See Also: ”Task Module Toolbar” on page 357

To create a task, follow these steps.

1. Access your Tasks folder, as described in ”Accessing the Tasks 
Folder” on page 336.

2. Click the Add button ( ).

3. The Add Task screen appears.
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4. Enter information for the task using the following table.

Field Description

Task Title Enter a title for the task (for example, Update Content). The 
title appears in the left column of the View Tasks screen.

Assigned To Your user name appears.

• If you do not have Redirect permissions, you cannot 
assign tasks to other users.

• If you have Redirect permissions, your user name 
appears followed by Select User or Group. To assign 
the task to yourself, proceed to the next field. To assign 
the task to someone else, click Select User or Group 
and choose a user or group.

When you complete the screen, an email is sent to the 
selected user or user group informing him of the assigned 
task.

Note: email is only sent if email notification is enabled for 
Ektron CMS400.NET .

Language Select the language of the user who will perform the task.

Content If this task involves a piece of content, select it. When you 
click Select, a new window appears. From this window, you 
can navigate through folders to find the content.
You can only select a piece of content whose language 
matches the user language selected above.

See Also: ”Selecting Content for the Task” on page 340

Priority Select the priority of the task. Your choices are High, Normal 
and Low.
The priority appears on the View Tasks screen. A user can 
sort tasks on the screen by priority.

Task Category Select a category for the task. When a Task Category is 
chosen, the Task Type drop down box is auto filled with task 
types associated with that category. See Also: ”Adding a 
Task Category and Task Type” on page 342.

Task Type Select the Task Type for this task. You must specify a Task 
Category before you assign a task type. See Also: ”Adding a 
Task Category and Task Type” on page 342.
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Add By clicking the Add link, you can add Task Categories and 
Task Types. See Also: ”Adding a Task Category and Task 
Type” on page 342

Note: If you Add a Task Category or Task Type while adding a 
task, the task information (Task Title, Assigned To, Language, 
etc.) entered will be lost when the screen refreshes.

Edit By clicking the Edit link, you can edit the Task Type chosen in 
the Task Type drop down box. See Also: ”Editing a Task 
Type” on page 344

Note: If you edit a Task Type while adding a task, the task 
information (Task Title, Assigned To, Language, etc.) entered 
will be lost when the screen refreshes.

State Choose a status for the task. Your choices are:

• Not Started

• In Progress

• Completed

• Waiting on Someone else

• Deferred

If the task is not linked to content, you can assign it to any 
state. However, if you later link the task to content (via the 
Content link above), the state switches to Not Started.
The state appears on the View Tasks screen. A user can sort 
tasks on the screen by state.

Start Date Using the calendar button, choose a start date for the task. 
The start date appears on the View Tasks screen. A user can 
sort tasks on the screen by start date.

Technical note: If you see a mix-up of the month and date of 
your entry (for example, you select March 2 but see February 
3), make sure the date format specified in the Windows 
Control Panel Regional Settings dialog matches your current 
language. Also, make sure the settings apply to the default 
user. 

Field Description
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5. Click the Save button ( ).

6. If email notification is enabled, an email is sent to the user/user 
group to which the task was assigned.

Selecting Content for the Task

Due Date Using the calendar button, choose the date by which the task 
needs to be completed.
The due date appears on the View Tasks screen. A user can 
sort tasks on the screen by due date.

Technical note: If you see a mix-up of the month and date of 
your entry (for example, you select March 2 but see February 
3), make sure the date format specified in the Windows 
Control Panel Regional Settings dialog matches your current 
language. Also, make sure the settings apply to the default 
user. 

Description Add additional information to describe the task. The 
description appears on the View Task screen (circled below).

Field Description
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When you click Select Content from the Add Task screen, the 
Select Content screen appears. It shows only content in the 
selected language.

You should only select a content folder for which you have 
permissions.

To select a piece of content to assign to the task, follow these 
steps.

1. Navigate to the content. (Click any folder to open it.)
2. Click the circle to the left of the content.

3. Press the Save button ( ).
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Adding a Task Category and Task Type
Task Categories and Task Types let users and administrators sort 
task by user defined categories and types.

By clicking the Add link, located next to the Task Type drop down 
box, you can add Task Categories and Task Types. This allows you 
to add categories and types without leaving the Add Task screen.

NOTE Administrators can also add and edit Task Categories and Task Types from the 
Workarea by clicking Settings > Configurations > Task Types. See Also: Ektron 
CMS400.NET Administrators Manual > “Managing Tasks” > “Task Categories and 
Types”. 

To add a Task Category and a Task Type, follow these steps.

1. Go to the Add Task screen, as described in ”Creating a Task 
via the Task Folder” on page 337.

2. Click the Add link, next to the Task Type drop down box.

3. The Add Task Type screen appears.
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From this screen you can perform the following:

• Add a task type to an existing task category

• Create a new task category

• Add a new task type

• Add a task type description

• Define task type availability. See Also: ”Task Type Availability” 
on page 343.

NOTE As a user, if you set the Task type to Not Available, you cannot edit the Task Type 
after that. To make the Task Type available, see your administrator. Task Type 
availability is explained inthe Ektron CMS400.NET Administrators Manual > 
“Managing Tasks” > “Task Categories and Types” > “View Categorization 
Screen“> “Task Type Availability” 

4. Enter your information.

5. Click Save ( ).
6. Your new Task Category and Task Type appear in the drop 

down boxes.
Task Type Availability
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Task types can be hidden from users by clicking the Not Available 
check box in the Add Task Type and Edit Task Type screens. By 
making Task Types not available, you can make the Task Type 
unavailable without deleting it.

Editing a Task Type

From the Add Task screen, you can edit a Task Type. This will 
allow you to change the Task Type name, Task Type description, 
and Task Type availability.

To edit a task type, follow these steps.

1. Go to the Add Task screen, as described in ”Creating a Task 
via the Task Folder” on page 337.

2. Choose a Task Category and the Task Type to edit.
3. Click the Edit link, next to the Task Type drop down box.

4. The Edit Task Type screen appears.
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From this screen you can edit the following:

• Task Type

• Task Type Description

• Task Type Availability. See Also: ”Task Type Availability” on 
page 343

NOTE As a user, if you set the Task type to Not Available, you cannot edit the Task Type 
after that. To make the Task Type available, see your administrator. Task Type 
availability is explained in the Ektron CMS400.NET Administrators Manual > 
“Managing Tasks” > “Task Categories and Types” > “View Categorization 
Screen“> “Task Type Availability”

5. Edit the information.

6. Click Save ( ).
7. The Task Type information is changed.
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Creating a Task from the Web Site
To create a task from a Web page, follow these steps.

1. Sign in.
2. Browse to the content for which you want to assign a task.

3. Click the Add Task button ( ).

4. The Add Task screen appears. The content you were viewing is 
assigned to the task.

5. Follow the directions in ”Creating a Task via the Task Folder” 
on page 337. The only differences are 

• the content’s ID number and title appear on the screen

• the language of the content is the default language

Creating a Task via the Content Folder
The above section describes assigning tasks from the Tasks folder. 
You can also assign task via the content folder, as illustrated 
below.

Assigning a Task from the View Content Screen
To assign a task from the View Content screen, follow these steps.

1. Access the View Content screen for the content to which you 
want to “attach” in a task, as described in ”Viewing Content” on 
page 40.
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2. Click the Add Task button ( ).

3. Follow the directions in ”Creating a Task via the Task Folder” 
on page 337. The only differences are 

• the content’s ID number and title appear on the screen

• the language of the content is the default language

Viewing a Task
Once a task is added, (with the exception of Administrators) only 
the user who assigned the task and those to whom the task was 
assigned can view it.

To view a task, follow these steps.

Viewing a Task from the Content Folder
1. Access the Contents folder from the left side of your Workarea.
2. Select the content associated with the task.
3. Click the Tasks tab.
4. The page lists all tasks assigned to the content.
5. Select a task.
From the view task page, you can add a comment to the task. See 
”Adding Comments to Tasks” on page 353 for more information.

Viewing a Task from the Tasks Folder
To view a task from the Tasks folder, follow these steps.

1. From the Smart Desktop, select the Tasks folder.
2. Click the task you want to view.
3. The View Task screen is displayed. From here, you can 

perform these tasks.

• ”Editing a Task” on page 352

• ”Deleting a Task” on page 355

• ”Adding Comments to Tasks” on page 353
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See Also: ”Task View Options” on page 348, ”Sorting Tasks By 
Task Type” on page 350, ”Sorting Tasks By Column” on page 351; 
”Managing Tasks” on page 335; ”emailing Tasks” on page 352

Task View Options
Beneath the main task module folder, several view screens display 
all tasks filtered by specified categories. After viewing tasks in any 
category, most screens let you perform an action on the tasks (the 
actions are included in the table below). For example, you can 
change a tasks state to another state. To select all tasks on a 
screen, click the check box in the header row (illustrated below).

Folder Displays these tasks Action you can perform 
from view screen

Tasks All tasks assigned to you, that are in one 
of the following states.

• not started
• active
• awaiting data
• on hold
• reopened
• pending

• Click on task to view it

• Add a task

• Sort tasks by Task Type

• Sort tasks by column

Assigned To Me All open tasks assigned to you • Click on task to view it

• Sort tasks by Task Type

• Sort tasks by column

Assigned By Me All open tasks you assigned to yourself or 
others

• Click on task to view it

• Sort tasks by Task Type

• Sort tasks by column
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Created by Me All open tasks you created • Click on task to view it

• Sort tasks by Task Type

• Sort tasks by column

Assigned to User All open tasks assigned to a user you 
select

• Select any user and view 
all tasks assigned to that 
user.
To do so, select new user 
from Assign to User drop 
down list and click Get 
Tasks.

• Click on task to view it

• Sort tasks by Task Type

• Sort tasks by column

Not Started All whose state is Not Started • Change to the following 
states: Awaiting Data, On 
Hold

• Click on the task to view it

• Sort tasks by Task Type

• Sort tasks by column

Active All whose state is Active • Change to the following 
states: Awaiting Data, On 
Hold

• Click on the task to view it

• Sort tasks by Task Type

• Sort tasks by column

Awaiting Data All whose state is Awaiting Data • Change to the following 
states: Awaiting Data, On 
Hold

• Click on the task to view it

• Sort tasks by Task Type

• Sort tasks by column

Folder Displays these tasks Action you can perform 
from view screen
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Sorting Tasks By Task Type
On every View Task page, you can sort tasks by the Task Type 
assigned to the task. You sort by Task Type using the Show Task 
Type drop down box. It is located in the upper right corner of the 
Workarea.

NOTE Task Types only appear in the Show Task Type dropdown box when they have 
been added to a task.

On Hold All whose state is On Hold • Change to the following 
states: Awaiting Data, On 
Hold

• Click on the task to view it

• Sort tasks by Task Type

• Sort tasks by column

Pending All whose state is Pending • Click on the task to view it

• Sort tasks by Task Type

• Sort tasks by column

Reopened All whose state is Reopened • Click on the task to view it

• Sort tasks by Task Type

• Sort tasks by column

Completed All whose state is Completed • Change to the following 
state: Archive

• Click on the task to view it

• Sort tasks by Task Type

• Sort tasks by column

Folder Displays these tasks Action you can perform 
from view screen
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To sort by Task Type, click the drop down box and choose a Task 
Type. Words in bold Italics are Task Categories. You cannot sort 
by Task Categories.

Sorting Tasks By Column
On every View Tasks page, you can sort the information by most 
columns. Information can be sorted by the following.

Column Click to sort tasks

Title Alphabetically by title of associated 
content

CID By content ID number

State By task state, from first to last

Priority By task priority. High appears first, 
followed by Normal then Low

Due Date By due date, beginning with dates closest 
to today

Assigned To Alphabetically by user to whom the task 
is assigned

Note: Once set, a task’s assigned-to user 
does not change throughout the life of 
the task.

Assigned By Alphabetically by user who assigned the 
task 
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emailing Tasks
You can email the contents of any Task screen. emailing tasks 
works the same as emailing reports. See ”emailing Reports” on 
page 115.

Editing a Task
You can change task information, such as

• Title

• Assigned to

• Language

• Content

• Priority

• Task Category

• Task Type

• Status (State)

• Due Date

• Start Date

• Description

To edit a task, perform the following steps:

1. Access the view task page for the task, as described in 
”Viewing a Task” on page 347.

2. Click the Edit button ( ).

3. The Edit Task screen appears.

Last Added Comment Alphabetically by the most recently 
created task comment

Create Date By date task was created, beginning with 
dates closest to today

Column Click to sort tasks
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4. Edit the task.

5. Click the Update button ( ) to save the changes.

Adding Comments to Tasks
You can add comments to an assigned task if you want to provide 
additional information about its status. For example, if you update 
a task’s status from In progress to Waiting on Someone Else, you 
can use a comment to describe the status change, such as: 

left voice mail with John with questions about 
his changes to the home page

Comments appear at the bottom of the View Tasks screen 
(illustrated below).



Managing Tasks

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 354

Several comments can be added to a task to record its progress 
from assignment to completion.

To add a comment to a task, follow these steps.

NOTE When an approver approves/declines content from the Content Awaiting Approval 
screen, if the content has an active task, the Add Comments to Task screen 
appears. The screen lets the approver insert comments about the task associated 
with the content.

1. Access the View Task screen for the task, as described in 
”Viewing a Task” on page 347.

2. Click the Add Comment button ( ).

3. The Comments window appears.

4. Enter your comment in the editor. Note that you can format and 
spell check the text using the toolbar buttons.

5. Click the  button.

6. The View Task screen reappears with the comment at the 
bottom of the page.

Updating Comments
To update a comment, follow these steps.
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1. Access the View Task screen that contains the comment you 
want to update, as described in ”Viewing a Task” on page 347.

2. Click the comment’s Date/Time link (illustrated below).

3. The Comments window opens with the comment displayed.
4. Update the comment.

5. Click the  button.

Deleting a Task
You can easily delete a task that is no longer needed. For example, 
the user who assigned a task would typically delete it when it is 
completed.

To delete a task, follow these steps.
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1. Access the View Task screen for the task, as described in 
”Viewing a Task” on page 347.

2. Click the Delete button ( ).

3. A confirmation message appears.
4. Click OK.

Viewing a Task’s History
Ektron CMS400.NET maintains a history of all events in the life of a 
task, as well as any comments entered. As examples, the task 
history shows when and by whom the task was created, when it 
changed to Active, when it was linked to content, when its state 
changed, when it was approved, etc.

You can view the task’s history until the task is purged. To view a 
task’s history, follow these steps.

1. Navigate to the View Task screen, as explained in ”Viewing a 
Task” on page 347.

2. Click the History button ( ).

3. The history of task events appears (example below).
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Task Module Toolbar
The following table explains the toolbar buttons available while 
managing tasks.

Button Name Description More Information

Add Comment Add a comment to the task. ”Adding Comments to 
Tasks” on page 353

Add Task Access the Add Task screen from the 
View Content page.

”Task Module Toolbar” 
on page 357

Add Task Access Add Task screen from task 
module folder.

”Creating a Task via 
the Task Folder” on 
page 337

Back Return to previous page.

Calendar Select a date.

Delete Task Delete a task. ”Deleting a Task” on 
page 355

Edit Task Edit a task. ”Editing a Task” on 
page 352

Save Save task information.

Update Save task information.

View Task View task information. ”Viewing a Task” on 
page 347
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Updating Your User Profi le

When a new user is added to an Ektron CMS400.NET Web site, 
the administrator sets up a personal profile for him. It contains 
information such as password and email address. You can update 
some personal profile information when needed. This section 
explains how to modify your personal profile.

Viewing Your Profile
Before changing your personal profile, you must view it. To do so, 
follow these steps.

1. Access your Smart Desktop. See Also: ”Understanding the 
Smart Desktop” on page 20

2. From the lower left frame, click Settings.
3. From the top left frame, click User Profile.

4. Your user profile appears.
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5. Click the Edit button ( ) in the top left corner.
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6. The Edit User Information screen appears. The following table 
explains fields you can edit.

Field Description

Password If desired, enter a new password into this field.

If you change your password, you do not need to log out 
then log back in. However, the next time you log in, you 
must use the new password.

Confirm Pwd Confirm your new password by retyping it into this field.

User Language Select a language in which to view Ektron 
CMS400.NET. Click the black down arrow on the right 
(circled below) to see a list of choices.

Email Address Enter a new valid email address. Notification email is 
sent to this address unless the Disable E-mail 
Notification field is checked.
To understand how email notification operates within the 
content workflow, see ”Example of an Approval Chain” 
on page 89.
Also, this address identifies the user sending Instant 
email. See Also: ”Sending Instant Email” on page 28

Disable Email 
Notification

Check this box if you do not want to receive notification 
email.

Work Page Size
Your system administrator may let you change the work page values. If he does, the 
following fields are editable. Otherwise, you can only view the fields.
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Width If desired, change the width of the screen in which 
Ektron CMS400.NET  appears. The width in pixels 
must be between 400 and 2400.
This field accommodates users who have larger 
monitors and/or prefer a smaller resolution, such as 
1280 x 1024.

Height If desired, you can change the height of the screen in 
which Ektron CMS400.NET  appears. The height in 
pixels must be between 300 and 1800.
This field accommodates users who have larger 
monitors and/or prefer a smaller resolution, such as 
1280 x 1024.

Display button text in 
the title bar

Check this box if you want any button’s caption text to 
appear in the screen title’s bar whenever a user moves 
the mouse over the button. Note the word Update, 
describing the button, in the illustration below.

If you do not check this box, the screen’s title remains in 
the title bar when the user moves the mouse over the 
button, as illustrated below.

Landing Page after 
login

If you want one page in your Web site to appear after 
sign in, enter the URL to that page. You might select a 
page that leads to a group of pages that you maintain.
If you don’t know the URL, navigate to the page, go to 
the browser address bar and select the text following the 
directory in which Ektron CMS400.NET  resides. For 
example, if the browser address bar says http://
www.ektron.com/customers.aspx?id=945, you would 
enter customers.aspx?id=945 here.

Field Description
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7. Click the Update button ( ).

Set smart desktop as 
the start location in the 
Workarea

If you want the Smart Desktop to appear as soon as you 
enter the Workarea, click inside this check box.

See Also: ”Understanding the Smart Desktop” on 
page 20
If you leave this check box blank, when you enter the 
Workarea, you go to the folder of the content specified 
at the Landing Page after login field.

Inherit Task 
Permissions From 
User Groups 

This area indicates your task permissions and if you 
inherit them from user groups to which you belong. 
For more information, seethe Ektron CMS400.NET  
Administrator Manual chapter “Managing Tasks,” 
section “Task Permissions.” 

User Properties the Ektron CMS400.NET  Administrator Manual 
chapter “Custom User Properties.”
See “Custom User Properties” in the Ektron 
CMS400.NET  Administrator Manual.

Field Description
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Online Help

Online help provides access to important and useful information 
about using Ektron CMS400.NET. Help is provided in two formats:

• online help - accessible from most screens by clicking the help 
button ( ), it provides information about the screen you are 
currently viewing. Online help is in HTML format, so it opens in 
the browser you use to surf the internet.
After viewing a help topic, you can browse to related topics as 
well as access a table of contents, index, and search to expand 
your quest for information. See Also: ”Accessing Online Help” 
on page 363

• online manuals - can be viewed, searched, and printed like a 
paper manual. Online manuals are in a PDF format, which 
makes it easy to navigate online and print. See Also: 
”Accessing Online Manuals” on page 365

Both formats provide the same information. Choose the format that 
best suits your needs.

Accessing Online Help
To access online help for any screen, click the help icon (illustrated 
below).

When you do, an online help screen appears.



Online Help

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 364

The following table describes the buttons available on every help 
screen.

Button Description

Returns to help topic you last viewed.

Moves to prior topic in the manual. This refers to the 
topic sequence arranged by the manual’s author.

Moves to next topic in the manual. This refers to the 
topic sequence arranged by the manual’s author.

Divides the help into two panels.

• The left panel displays the table of contents. It also 
provides buttons for accessing the index and full-
text search. 

• The right panel continues to display help topics.
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Accessing Online Manuals
To access the help folder, follow these steps.

1. Access your Smart Desktop. See Also: ”Understanding the 
Smart Desktop” on page 20

Creates an email to send to Ektron with feedback about 
the documentation.
An Internet connection is required.

Connects to Ektron CMS400.NET  support page on our 
Web site.
An Internet connection is required.

Connects to the Ektron CMS400.NET  Learning 
Center, also on our Web site.
An Internet connection is required.

Prints current topic

Button Description
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2. From the lower left frame, click Settings.

3. From the top left frame, click Help.
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4. The help screen appears in the right frame. 

5. Click on a link to open the documentation or Web page. 

NOTE Your computer requires an internet connection to access the help page on 
Ektron.com.
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Introduction to 
eWebEditPro+XML

eWebEditPro+XML is a browser-based, Web content editor 
designed for dynamic Web sites. It lets you create and publish your 
own Web content in any language supported by the operating 
system and your Web site.

More specifically, eWebEditPro+XML lets you perform Web page 
editing functions, such as

• copy content from any Windows-based application

• use Microsoft Word to edit Web content

• cut, copy, and paste

• find and replace text

• check spelling

• edit an image

• change font style, size, attributes (bold, italics, underline), and 
color

• begin lines with bullets or numbers

• adjust indentation

• right, center, or left justify text and images

• add a bookmark, hyperlink, image, or table

• view your text as WYSIWYG or HTML code

• insert or clean HTML source code
You gain access to these functions either from the toolbar at the 
top of the editor window or from a menu that appears when you 
right click the mouse inside the editor.
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Using eWebEditPro+XML
eWebEditPro+XML is like many other word processing 
applications. You type text and then use toolbar buttons (illustrated 
below) and menu options to change the text’s appearance or 
perform functions on it, such as spell checking.

Organization of this Documentation
The next section, “Creating a Simple Web Page” on page 370, 
walks you through the steps required to create a simple Web page.

The following section, “Toolbar Buttons” on page 374, explains 

• each toolbar button

• functions that appear when you right click the mouse
Many of these functions are simple and require only a brief 
explanation.

The last section, “Using eWebEditPro+XML’s Advanced Features” 
on page 396, explains how to use the more advanced features.
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Creating a Simple Web Page

This section walks you through the process of creating a simple 
Web page, using only a few of the many features available. Later 
sections explain all of the features and how to use them.

Your Finished Web Page
When you finish this exercise, your simple Web page will look like 
this.

Notice that this page has the following elements.

• The second sentence includes bold, italic and underlined text.

• The third sentence includes a hyperlink, text that will jump to 
another Web page when the user clicks on it.

• The fourth sentence begins with a bullet.

• The last sentence has some very large (18 point) text. 
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Creating the Sample Web Page
To create this page, follow these steps.

Enter the First Two Sentences
1. Open eWebEditPro+XML. (Your Webmaster installs 

eWebEditPro+XML on your computer and determines which 
fonts and sizes are available. Your system may not match the 
example below.)

2. Type the first two sentences. 
This is some sample content. You can make text bold, 
italic and underlined with the push of a button.

3. Double click the word “bold” to select it. Then, click the Bold 
button ( ) to apply bold to the word.

4. Double click the word “italic.” Then, click the Italic button ( ) to 
apply italic to the word.

5. Double click the word “underlined.” Then, click the underline 
button ( ) to underline the word.

Creating a Hyperlink
1. Type You can also easily add hyperlinks.
2. Double click the word hyperlinks so that it becomes selected.

3. Click the Hyperlink button ( ).
4. The hyperlink dialog box appears.
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5. In the Link field, after http://, enter www.ektron.com.
6. Click OK.
Notice that the word hyperlink now appears in a different color. 
When you save this Web page and a user views it, if the user clicks 
hyperlink, a new Web page will display Ektron’s home page.

NOTE If your computer has an internet connection, you can double click the hyperlink to 
test it.

Applying a Bullet to a Line of Text
1. Press <Enter> to move the cursor down to the next line.
2. Type You can begin a line with bullets.

3. Click the bullet button ( ).
4. Notice that the line is indented and now begins with a bullet.

Changing the Size of Text
1. Press <Enter> to move the cursor down to the next line.
2. Type Finally, you can change the font to a large size. 
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3. Select the words large size.
4. Click the down arrow to the right of the font size list. When you 

do, the list of available fonts appears.

5. Click 5 (18 pt).
6. Notice that large size is now much larger than the other text.
Congratulations! You have just created your first Web page with 
eWebEditPro+XML. You have learned how to apply bold, italic, and 
underlining, create a hyperlink, add a bullet to a line, and change 
the size of the text. 

This sample used only a few of the many features available. The 
following sections explain the rest of the details about using the 
product.
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Toolbar Buttons

This section explains how to use the buttons and drop-down lists 
on the toolbar. (The toolbar is the row of buttons across the top of 
the editor window, illustrated below.) 

The buttons let you perform functions such as cutting and pasting 
text, inserting images, and creating tables.

All buttons may not appear. Your Webmaster determines which 
buttons appear on your toolbar. Also, you can customize your 
toolbar so that it contains only the buttons you use (See 
“Customizing Your Toolbar” on page 385).

This section explains

• ”Selecting Text” on page 374

• ”Applying Formatting Attributes to Text” on page 375

• ”Table of Toolbar Buttons and Drop-Down Lists” on page 375

Selecting Text
You select text before performing an action on it, such as copying 
it.

• To select all information on a page, press Ctrl+A.

• To select a portion of the information on a page, you have two 
choices.

- Hold down the left mouse button and drag the cursor across 
the data you want to select.

- Hold down the Shift key and the right arrow key ( ) until 
the desired data is selected.
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• To select a single word, place the cursor on the word and 
double click the mouse.

Selected text has different background and foreground colors, as 
illustrated below.

Applying Formatting Attributes to Text
Several buttons apply formatting attributes to text, such as bold 
and italics. There are two ways to apply these attributes.

• Enter the text. Then, select the text and press the toolbar 
button. The button is now in a “pressed in” condition, and the 
text has the formatting attribute.

• Press the toolbar button. Then, begin typing the text. As you 
type, the formatting is applied.

To stop applying the formatting, press the button again. This action 
changes the button to a “pressed out” condition and terminates the 
formatting.

Table of Toolbar Buttons and Drop-Down Lists
The following table explains each toolbar button and drop-down 
list.

NOTE The Data Designer feature also has a toolbar. For information, see “Using the 
Data Designer” on page 177.
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Button Equivalent 
Keystroke
(Internet 
Explorer only)

Function For more 
information, see

 Cut Ctrl+X Remove selected text and graphics. 
Place that data into temporary memory, 
also known as the “clipboard.”
(If you later cut or copy more information 
onto the clipboard, the new information 
overwrites the original information.)

 Copy
Ctrl+C Copy selected text and graphics into 

temporary memory. Leave selected data 
where it is.
(If you later cut or copy more information 
into memory, the original information is 
lost.)

“Copying from Other 
Applications” on 
page 397

 Paste
Ctrl+V Insert the most recently cut or copied text 

and graphics at the current cursor 
location.

 Paste Text
Paste the contents of the clipboard as 
plain text. That is, all HTML tags 
(including images) are not pasted.
This button is helpful when you want to 
eliminate the HTML formatting of the text 
being copied.

 Replace Launches the Search and Replace dialog 
box. The dialog searches for (and lets 
you optionally replace) text that you 
specify.

“Finding and 
Replacing Text” on 
page 398

 Find Next
Find next occurrence of the string 
entered into the Find What field of the 
Search and Replace dialog box.

“Finding and 
Replacing Text” on 
page 398

 Undo
Ctrl+Z Reverse the most recent action, as if it 

never occurred. You can undo as many 
actions as you wish.

 Redo
Ctrl+Y Reverse the undo action.
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 Spell Check 
(manual)

Begin spell checker. “Checking Spelling 
Upon Demand” on 
page 403

 Spell Check 
(automatic)

Turn on or off spell check as-you-type 
feature.

“Checking Spelling 
as You Type” on 
page 402

 Edit Hyperlink
Change information about a hyperlink. “Using Hyperlinks” 

on page 505

 Remove Hyperlink
Remove a hyperlink. “Removing a 

Hyperlink” on 
page 510

 Library Insert a library file ”Adding a Library 
File to Content” on 
page 204

 Upload Files
Upload any external files (such as 
images) to the server.

”Moving an Image to 
the Server” on 
page 423

 Translate Translate content into another language Ektron 
CMS400.NET  
Administrator 
Manual section 
“Multi-Language 
Support” > “Working 
with Multi-Language 
Content” > 
“Translating Content” 
> “Using Machine 
Translation”

 Add Comment Insert a comment into the content ”Adding Comments 
to Content” on 
page 526

 Picture
Insert a picture. “Inserting Images” 

on page 410

Button Equivalent 
Keystroke
(Internet 
Explorer only)

Function For more 
information, see
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 Image Editor
Edit an image. ”Editing Images” on 

page 425

 Table Insert or edit a table. “Introduction to 
Tables” on page 457

 Edit in Microsoft 
Word

Edit content in Microsoft Word. “Editing in Microsoft 
Word” on page 407

 Data Design Mode
Switches to Data Design Mode.

Button only appears when 
eWebEditPro+XML  configuration 
enables the Data Designer feature.

“Design Mode vs. 
Data Entry Mode” on 
page 179

 Data Entry Mode
Switches to Data Entry Mode.

Button only appears when 
eWebEditPro+XML  configuration 
enables the Data Designer feature.

“Design Mode vs. 
Data Entry Mode” on 
page 179

 View as 
WYSIWYG

Display the page content as WYSIWYG 
(What You See Is What You Get). 
WYSIWYG is the ability to see in the 
editor what will appear when user views 
the Web page.

 View as HTML
Display the page content as HTML. “Viewing and Editing 

HTML” on page 511

nbsp Insert a blank space character. 
Although you can add spaces in the 
editor using the <space> bar on the 
keyboard, those spaces are ignored 
when the content is displayed by a 
browser.

 Copyright
Insert copyright symbol.

Button Equivalent 
Keystroke
(Internet 
Explorer only)

Function For more 
information, see
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 Registered 
Trademark

Insert registered trademark symbol.

TM Insert trademark symbol.

 and 
Special Characters

Insert special characters (such as 

) from a drop down list. 
To view the list, click the black down 
arrow.

 Remove Style
Remove all style information applied to 
selected text. (You apply styles using the 
Style dropdown list.) For example
Before
<P class=note>This is initial 
content. </P>

After
<P>This is initial content.</P> 

Style Display a list of styles. Users can select 
from the list to apply a style to selected 
text.
Note that the list can change depending 
on the formatting of the selected line.
Your Webmaster determines which styles 
are available.

Heading Size Change the heading size. Your 
Webmaster determines which heading 
sizes are available.

 Font Style

Change the font style. Your Webmaster 
determines which fonts are available.

Note: If more than one font appears in a 
selection, the browser on the reader’s PC 
tries to display text using the first font. If 
the browser cannot find that font, it tries 
to use the second, etc.

Button Equivalent 
Keystroke
(Internet 
Explorer only)

Function For more 
information, see
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 Font 
Size

Change the font size. Your Webmaster 
determines which font sizes are 
available.

 Font Color
Change the font color. 

Background Color
Change the background color of the text.

Note: To remove background color from 
selected text, click the Normal button 
( ).

 Bold
Ctrl+B Make the text bold.

 Italic
Ctrl+I Make the text italic.

 Strikethrough Apply strikethrough to selected text. For 
example: Here is some text

 Normal
Remove all formatting from selected text.

 Superscript Make selected text appear smaller and 
above text line

 Subscript Make selected text appear smaller and 
below text line

 Number
Begin the line on which the cursor rests 
with a number. If the line above this line 
is

• not numbered, assign this line 1

• numbered, assign a number one 
more than the line above

 Bullet
Begin the line on which the cursor rests 
(or all selected lines) with a bullet ( ).

Button Equivalent 
Keystroke
(Internet 
Explorer only)

Function For more 
information, see
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  Indent
Increase or decrease the current line’s 
distance from the left margin.

Left, Center, and Right 
Justify

Align paragraph so that it is arranged

• evenly on the left side (uneven on 
the right)

•in the center of each line

•evenly on the right side (uneven on
the left)

• evenly on right and left side

 About 
eWebEditPro+XML

Display a dialog box that shows your 
version of eWebEditPro+XML  and your 
license keys.

 Open File Open local file and copy it into CMS 
content.
While you can open any file type, Ektron 
CMS400.NET ’s editor only works with 
.htm and .xml files.
When you open a file into a content 
block, the new file replaces any content 
currently in the block.

 Save File Save CMS content as file on your 
computer or network. 
Since Ektron CMS400.NET ’s editor 
only works with .htm and .xml files, you 
should save the file using one of those 
extensions.

 Display/hide 
Borders

Display or suppress table and cell 
borders

 Display/hide 
Invisible Elements

Display or suppress formatting 
characters that do not appear when 
content is published

 View Preferences Display a dialog that lets you change the 
appearance of the HTML source code

Button Equivalent 
Keystroke
(Internet 
Explorer only)

Function For more 
information, see
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Position Objects Options
These buttons let you absolutely position elements (pictures, 
tables, etc.) anywhere on a page.

WARNING! Some older browsers (for example, Netscape 4) do not display absolutely 
positioned elements. Absolute position uses the style attribute. If you use this 
feature, the content is not compatible with all browsers.

 Delete Delete selected content

 Underline Ctrl+U Make the text underlined.

 Remove alignment Remove alignment settings applied to 
selected content

 Bookmark
Create a bookmark. “Using Bookmarks” 

on page 501

Horizontal Line
Insert a horizontal line.

 Print
Ctrl+P Print the editor content.

 Select All
Ctrl+A Select all content

 Select None
Deselect all selected content

Button Equivalent 
Keystroke
(Internet 
Explorer only)

Function For more 
information, see

Button Function

 Position Lets you move selected table or image anywhere on the screen. 

 Lock
“Locks” selected table or image at its current screen position. Nothing can move 
a locked object.
To move the object, unlock it by clicking this button again.
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Text Direction Options

The text direction menu options ( ) allow bi-
directional editing of text, which is useful for Arabic, Farsi and 
Hebrew. The client computer must also support the language.

The text buttons determine the editing direction, while the edit 
buttons determine the side of the editor that displays the scroll bar.

For right-to left languages, such as Arabic, Farsi and Hebrew, the 
text editing would be “right to left”, and the scroll bar would be on 
the left side.

For western European languages, the text editing would be “left to 
right”, and the scroll bar would be on the right side.

 Move to Front
If two or more images overlay each other, moves the selected image in front of 
the others.

 Move to Back
If two or more images overlay each other, moves the selected image behind the 
others.

 Above Text
If text overlays an image, move the image in front of the text.

 Below Text
If an image overlays text, move the text in front of the image.

Button Function

Button Function

 Left-Right Text
Text is entered left to right.

 Right-Left Text
Text is entered right to left.

 Left-Right Edit
The vertical scroll bar appears on the 
right side of the window.
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Form Elements Toolbar
See “Inserting Form Fields” on page 147

 Right-Left Edit
The vertical scroll bar appears on the left 
side of the window.

Button Function
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Customizing Your Toolbar

The eWebEditPro+XML toolbar consists of one or more menus. 
Each menu has one or more buttons.

You can recognize the beginning of a menu by the double vertical 
bars (circled in the illustration). 

This sample toolbar has four menus.

Your Webmaster determines

• which menus are available to you

• which buttons appear on each menu, and the sequence in 
which they appear initially

• whether or not you are authorized to customize your toolbar. If 
you are not authorized, your edits are not saved when you 
leave the eWebEditPro+XML screen.

If you are authorized to customize your toolbar, there are several 
ways to do so.

• ”Removing Or Adding Menus” on page 386

• ”Removing or Adding Menu Items” on page 386

• ”Restoring Toolbars” on page 389

• ”Rearranging the Menus on a Toolbar” on page 389

• ”Creating a New Menu” on page 389

• ”Moving a Menu Off the Toolbar” on page 391

• ”Changing the Menu’s Orientation” on page 391

Each procedure is explained below.
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Removing Or Adding Menus
To remove or add a menu, follow these steps.

1. Place the cursor on the toolbar.
2. Right click the mouse.
3. A dropdown list appears. It displays all menus available to you 

and the Customize option.

NOTE If Customize does not appear on the menu, you are not authorized to customize 
the toolbar.

Menus that are checked appear on your toolbar.
In the above example, the Special Characters, View As, 
Format, and Paragraph Format menus appear. The Table, 
Position Objects and Text Directions menus, which are not 
checked, are available but do not currently appear on the 
toolbar.

4. To add a menu to your toolbar that appears on the list but is not 
currently checked, place the cursor on the menu name and 
click the mouse. A check mark appears, and the menu appears 
on the toolbar.
To remove a menu from your toolbar, place the cursor on the 
menu name and click the mouse. The check mark disappears, 
and the menu no longer appears on the toolbar.

Removing or Adding Menu Items
1. Place the cursor on the toolbar.
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2. Right click the mouse.
3. A dropdown list appears. Click Customize.

NOTE If Customize does not appear on the menu, you are not authorized to customize 
the toolbar.

4. The Toolbar Customization dialog box appears.

5. Click the menu that you want to edit.
6. Click the Commands tab. A new screen appears.
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Using the Customize Toolbar Dialog Box
The left half of the Commands screen lists the buttons in the 
sequence in which they appear on the menu. 

The right half of the screen lists available buttons that do not 
currently appear on the menu. 

To add a button to the toolbar, drag it from the right side of the 
screen to the location on the left side where you want it to appear. 
(You can also click a button then click <--Add. This action places 
the button at the bottom of the list.)

To remove a button from the toolbar, drag it from the left side of the 
screen to the right. (You can also click a button then click Remove-
->.)

The Move Up and Move Down buttons let you to move any button 
up or down one slot within the list of buttons.

Rearranging the Items on a Menu
1. Click the button you want to move
2. Click Move Up and Move Down to move the button up or 

down one slot for each click.
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Restoring Toolbars
If you remove all toolbars from your menu, and then want to 
restore the menus but do not have the Customize menu option, 
follow these steps.

1. Place the cursor in the editor.
2. Right click the mouse. 
3. A menu appears with a Redisplay toolbars option. 
4. Click this option to restore all menus.

Rearranging the Menus on a Toolbar
To move a menu to a different toolbar location, follow these steps.

1. Place the cursor on the double vertical bars that indicate the 

beginning of the menu.
2. Click the mouse.
3. Hold down the mouse button and drag the menu to the new 

location. You can move the menu anywhere else on the 
toolbar. 
Note that your Webmaster can define a menu so that it cannot 
reside on the same row with another menu. If you move such a 
menu, it will not remain on a row with another menu. Instead, it 
will move down to the next row.

4. After you place the menu where you want it, release the mouse 
button.

Creating a New Menu
1. Place the cursor on the toolbar.
2. Right click the mouse.
3. A dropdown list appears. Click Customize.
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4. The Toolbar Customization dialog box appears.

5. Click New.
6. A new menu appears on the left side of the window, above the 

existing menus. The default name of the new menu is Custom 
0. 

7. To rename the menu, place the cursor in the field that displays 
the new menu and enter the new name.
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NOTE If you click outside the toolbar name field, you cannot later change the menu’s 
name.

8. To have the menu appear on your toolbar, click in the small box 
to the left of the menu name.

9. Click the Commands tab.
10. Add buttons to the menu, following the procedure described in 

“Using the Customize Toolbar Dialog Box” on page 388.

Moving a Menu Off the Toolbar
You can move a menu from the toolbar to anywhere else on the 
screen, even if eWebEditPro+XML does not occupy the entire 
screen.

You can also change the orientation of a menu that is not on the 
toolbar from a horizontal to vertical.

To move a menu, follow these steps.

1. Place the cursor on the double vertical bars that indicate the 

beginning of the menu.
2. Click the mouse.
3. Hold down the mouse button and drag the menu to the new 

location. You can move the menu anywhere on the screen. 
4. After you place the menu where you want it, release the mouse 

button.

Changing the Menu’s Orientation
To change the menu’s orientation, follow these steps.

1. Drag the menu from the toolbar. 
2. Move the cursor to the bottom of the menu until it becomes a 

double-headed arrow (illustrated below).
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3. Drag the cursor to the lower left. As you do, the menu’s 
orientation changes from horizontal to vertical (illustrated 
below).
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The Context Sensit ive Menu

This section explains the functions available on the menu that 
appears when you right click the mouse within the 
eWebEditPro+XML editor. You can also access this menu by 

pressing the application key ( ).

Because this menu can change depending on what you are doing, 
it is called a context-sensitive menu.

NOTE A different context-sensitive menu is available when your cursor is within a table. 
That menu is described in “The Table Context Sensitive Menu” on page 467.

The following table lists the menu options and where to get more 
information on each.
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Menu Option Lets you For more information, 
see

Menus View all toolbar menus. “Using eWebEditPro+XML 
without a Mouse” on 
page 516

Cut Remove selected text and graphics. 
Place that data into temporary memory. 
If you later cut or copy more information 
into memory, the information in memory 
is lost.

Copy Copy selected text and graphics into 
temporary memory. Leave selected data 
where it is. (If you later cut or copy more 
information into memory, the original 
information is lost.)

“Copying from Other 
Applications” on page 397

Paste Insert the most recently cut or copied text 
and graphics at the current cursor 
location.

Paste Text Paste the contents of the clipboard as 
plain text. That is, all HTML tags 
(including images) are not pasted.
This button is helpful when you want to 
eliminate the HTML formatting of the text 
being copied.

Select All Select all information on your page. After 
you select it, you can cut it, copy it, etc.

Clean Source Remove unnecessary HTML tags “Cleaning Source Code” on 
page 513

Hyperlink Create a link to another Web page or a 
spot within the current page

“Using Hyperlinks” on 
page 505

Edit Source Edit your page’s HTML source “Editing a Section of a 
Page” on page 512

Insert Source Insert HTML source onto the page at the 
cursor location.

“Inserting Source” on 
page 512
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Check Spelling Compare words in the editor to Microsoft 
WORD spelling list.

“Checking Spelling” on 
page 402

View as WYSIWYG/HTML View and edit your page’s HTML “Viewing and Editing HTML” 
on page 511

Picture Insert a picture “Inserting Images” on 
page 410

These options only appear if 
your site is using 
eWebEditPro+XML :
Insert Custom tag, tag name tag 
Attributes, tag name tag 
Properties

Work with XML tags “Editing XML Web Pages” 
on page 368 only available 
in the eWebEditPro+XML  
User Guide

Menu Option Lets you For more information, 
see
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Using eWebEditPro+XML’s 
Advanced Features

Most of eWebEditPro+XML’s features are easy to learn. For 
example, to make your text bold, you select the text, and click the 
bold button ( ).

However, some of eWebEditPro+XML’s features are more complex. 
For example, when creating a table, you must make several 
decisions: the number of rows and columns, the size of the border, 
the spacing between cells, etc.

The following sections explain eWebEditPro+XML’s more advanced 
features.
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Copying from Other 
Applications

You can copy information from most other Windows 
applications into eWebEditPro+XML and retain the formatting 
from the original application. In general, copying from another 
application involves these steps.

1. Sign on to the application in which the information resides.
2. Select the information to be copied.
3. Press <Ctrl>+<C>.
4. Go to eWebEditPro+XML.
5. Press <Ctrl>+<V> to paste the selected information.
Note that you can only copy content, not background 
information that generates content. 

So, for example, you can copy the values in a spreadsheet but 
not the formulas used to generate those values. Also, copying 
dynamic fields from Microsoft WORD would retrieve the current 
value of the fields but not the variables that generate those 
values.

It’s a good idea to experiment with copying from different 
sources to test the results.
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Finding and Replacing Text

To find (and optionally replace) text on your Web page, click the 
Replace button ( ). When you do, the Find and Replace 
dialog box appears.

You can use this dialog box to simply find text, or to find text 
and replace it with other text. Each option is explained below.

NOTE You can also use this dialog to delete text that appears repeatedly. To do so, 
follow the directions in ”Finding and Replacing Text” on page 398 and enter 
nothing in the Replace With field.

Finding Text
1. In the Find What field, type the text that you want to find in 

the content.
2. Set dialog box options (see ”Additional Options on the 

Dialog Box” on page 399).
3. Click Find Next to find the next occurrence of the “find” 

text.

Finding and Replacing Text
1. In the Find What field, type the text that you want to find.
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2. In the Replace With field, type the text to replace the “find” 
text.

3. Set dialog box options (see ”Additional Options on the Dialog 
Box” on page 399).

4. If you want to 

- replace all occurrences of the “find” text with the “replace” 
text, click Replace All.

NOTE You can undo replacements one at a time using the Undo button ( ).

- replace only the highlighted term with the “replace” text, click 
Replace.

- find the next occurrence of the “find” text (and optionally 
replace it with the “replace” text), click Find Next.

- change the highlighted term using the editor, exit the Find 
and Replace dialog, move to the term and edit as needed. 
To restart the search, press the Find Next button ( ).

5. Continue to find and optionally replace or edit until you reach 
the end of the text.

Additional Options on the Dialog Box
The dialog box also lets you do the following.

• ”Specifying a Search Direction” on page 399

• ”Considering the Case of a Search Term” on page 400

• ”Whole Word Match” on page 401

Specifying a Search Direction
The search begins where the cursor is when you click Find Next. 
To make sure you locate every occurrence of a term, place the 
cursor at the top of the content before beginning the search.

If you begin the search from somewhere other than the top of the 
page, use the Direction field to search from the current location to 
the top or bottom of the file.
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Considering the Case of a Search Term
By default, the search ignores the case (upper or lower) of a 
search term. In other words, if you enter Bob in the Find What 
field, the search finds bob, Bob, BOB, etc.

If you want the search to be case sensitive, use the Match case 
check box on the Find window. If you enter Bob in the Find What 
field and place a check in the Match case box, the search only 

To search from the 
cursor location to the

Click this option in the 
Direction field

end of the page Down

top of the page Up
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stops at Bob, not bob or BOB.

Whole Word Match
By default, the search finds any occurrence of the text that you 
type into the Find what field. For example, if you enter the, the 
search finds the word the, as well as those letters embedded in 
other words, such as others and theater.

If you want the search to find only whole word occurrences of the 
text you type into the Find what field, click the Match whole 
words only box in the Find dialog box.
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Checking Spell ing

The eWebEditPro+XML editor can check your spelling as you type 
or whenever you want to check it. The rest of this section explains

• ”Disabling Script Blocking” on page 402

• ”Checking Spelling as You Type” on page 402

• ”Checking Spelling Upon Demand” on page 403

• ”Spell Checking Selected Text” on page 405

• ”Setting Spell Check Options” on page 405

Disabling Script Blocking
If Norton Antivirus TM 2001 is installed on your computer, you need 
to disable script blocking in order to use the spell checker. If you do 
not disable script blocking, an error message will appear whenever 
you check spelling.

To do this, follow these steps.

1. Launch Norton Antivirus TM 2001.
2. From the first window, click Options.
3. On the next window, click Script Blocking.
4. On the script blocking window, uncheck Enable Script 

Blocking.
5. Press OK.

Checking Spelling as You Type
You can have the editor check spelling as you type. To turn on the 
spell-check-as-you-type feature, click the automatic spell check 
button( ).
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When you click the button, the spell checker reviews every word in 
the file. A wavy red line ( ) appears under any word whose 
spelling is not found in the system’s dictionary.

The spell checker continues to review each word as you type it, 
marking any words not in the dictionary.

NOTE Depending on the speed of your computer, there may be a short delay between 
the time you type an incorrect word and when the wavy red line appears. Also, the 
spell check does not check a word until you enter a space character after the 
word.

Fixing Spelling Errors
There are two ways to fix a spelling error (indicated by a wavy red 
line).

• Click the misspelled word and then right click. A menu displays 
words that are similar to the misspelled word. Click the correct 
word.

• If you know the correct spelling, type the correction.

Checking Spelling Upon Demand
If you do not want to use the spell-check-as-you-type feature, you 
can begin spell checking whenever you wish. To do this, click the 
spell check button ( ).
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When you do, the system checks each word in the file. If the spell 
check finds a word in none of the dictionaries, it displays the 
Spelling dialog box.

The Spelling Dialog Box
The Spelling dialog box displays

• the word not in the dictionary (in the Not in Dictionary field).

• suggested spellings for the word (in the Suggestions field). 
The most likely replacement is selected at the top of the list.

• buttons that let you ignore the word, change the word, or exit.

If you want to Do this

Replace the word with one of the suggestions and continue 
spell checking the page.

1. Click the suggested word.

2. Click Change.

Replace every occurrence of the word with one of the 
suggestions and continue spell checking the page.

1. Click the suggested word.

2. Click Change All.

Correct the spelling of the word by typing it and continue 
spell checking the page.

1. Click in the Not In Dictionary 
field.

2. Correct the spelling.

3. Click Change.
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Spell Checking Selected Text
To check the spelling for a single word or a group of words, follow 
these steps.

1. Select the text that you want to spell check.

2. Press the manual spell check button ( ).
3. The spell checker reviews the words in the selected text and 

stops at any word not in the dictionary. For documentation of 
options when a misspelled word is found, see “The Spelling 
Dialog Box” on page 404.

4. When the spell checker finishes reviewing the words in the 
selected text, it displays the following message
Finished checking selection. Do you want to check the rest of the 
document?

Click Yes to spell check the rest of the document (including text 
above the selected text).
Click No to stop the spell checker.

Setting Spell Check Options
eWebEditPro+XML can use Microsoft Word’s spell checking feature 
(your Webmaster makes this decision).

If your installation uses Word, Word’s Spelling & Grammar window 
(available from the Tools - > Options menu) has settings that 
affect the operation of the spell check.

Leave the word as is; continue spell checking the page.
You would normally do this if a word (such as a company 
name) is spelled correctly even though it is not in the 
dictionary.

Click Ignore.

Leave the word as is; continue spell checking the page, 
ignoring all other occurrences of the word.

Click Ignore All.

Stop spell checking. Click Cancel.

If you want to Do this
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Specifically, you can set the spell check feature to check or ignore

• words in UPPERCASE (for example, XYLOGIC)

• words with numbers (for example, mp3)

• Internet and file addresses (for example, http://www.ektron.com/
)

As an example, if you check the box to the left of Ignore Words in 
UPPERCASE, eWebEditPro+XML’s spell check does not consider 
words in all uppercase characters.

You also use the custom dictionary section of the screen to identify 
custom dictionaries for the spell check to reference.

The spell check feature does not use the other fields on this 
screen.
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Editing in Microsoft Word

If your computer has Microsoft Word 2000 or greater, you can edit 
content within Word. You may prefer to do this because of 
familiarity with Word’s user interface, and to use additional 
functionality available in Word.

NOTE Some Word formatting may not be compatible with HTML and, as a result, not be 
transferred to eWebEditPro+XML.

To edit with Word, follow these steps.

1. Open eWebEditPro+XML.

2. Press the Word toolbar button ( ).
3. The following dialog may appear, warning you that some Word 

formatting may not be transferred back to eWebEditPro+XML. 
Press Yes if you still want to edit in Word.

4. Microsoft Word opens. Any content that was in 
eWebEditPro+XML when you pressed the Word button is 
copied to Word.

5. Edit content as desired.
6. Press File -> Close. 
7. Another warning like the one in Step 3 may appear. Press Yes 

to copy the edited content back to eWebEditPro+XML.
8. When done, return to eWebEditPro+XML and press the Word 

toolbar button again. 
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9. If you change your mind and decide to restore the content to 
the way it was before you edited it in Word, press the undo 
button ( ). 
If you want to restore the Word changes after pressing Undo, 
press the redo button ( ).

Uploading an Image in a Microsoft Word Document
If you insert an image into the Word content and then paste that 
content or save it, the following dialog box appears. The box lists 
all images in the content and asks if you want to copy them from 
your computer to your organization’s Web server.

If you are ready to publish your Web content and want to display 
the image, click Update Now. If you plan to add more content later, 
you can click Upload Later and upload all images at that time.
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Editing XML Documents
If your organization has implemented eWebEditPro+XML, you 
cannot edit XML documents using Microsoft Word. This is because 
Word does not support XML editing. If a full XML document is 
loaded, the Word button ( ) is disabled. 

If a Word document includes some custom/XML tags, the following 
dialog appears, warning you about the problem.

You can proceed and edit using Word or decide not to edit using 
Word.
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Inserting Images

To insert a picture into the editor, place the cursor where you want 

the image to appear and click the Insert Picture button ( ). When 
you click the button, one of the two Picture Properties dialog boxes 
illustrated below appears, depending on how your Webmaster has 
set up your system.

The dialog boxes are very similar, with the only difference being 
that the Select Server File button only appears on the second 
dialog box. 

The Select Server File button appears if your upload mechanism 
is set to FTP. It does not appear if the mechanism is HTTP. For 
more information, see the eWebEditPro+XML Administrator Manual 
section “Managing Image Selection” > “Examples of Implementing 
Image Selection” > “Selecting Files from the Server.”
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You can also access this dialog box to modify a picture after you 
insert it. To do this, follow these steps.

1. Click the picture.
2. Right click the mouse.
3. Click Picture from the menu.
If you see the first dialog box, proceed to “Using the First Picture 
Properties Dialog Box” on page 411. If you see the second dialog 
box, proceed to “Using the Second Media Selection Dialog Box” on 
page 415.

Using the First Picture Properties Dialog Box
When the first Picture Properties dialog box appears, click the 
Select New File button. When you do, the Insert Media Item dialog 
box appears.

This box and lets you insert a picture from your computer (and any 
network folder available to your computer), or from the Web server 
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to which your computer is connected. Both choices are described 
below.

Inserting a Picture from the Server
The top left corner of the dialog box (Illustrated below) lists the 
pictures on the Web server.
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Pictures that you previously inserted appear on this list, as do 
pictures inserted by other users connected to that server.

To insert a picture from the server, follow these steps.

1. Click the picture from the To Select an Existing File field that 
you want to insert.

2. Information about the picture’s file size, width and height 
appears in the upper right corner of the dialog box.

3. If you want to view a picture before inserting it, click Preview 
(on the right side of the dialog box).

4. Click OK.
5. The Picture Properties dialog box reappears. Here, you can 

change the properties of the picture. For more information, see

•“Adjusting a Picture” on page 416

•“Setting a Border” on page 418

•“Aligning the Picture” on page 419

•“Adding Space around the Picture” on page 421

6. Click OK to insert the picture into the editor.
Deleting a Picture from the Server

To delete a picture from the server, select the picture and click the 
Delete button.

Inserting a Picture from Your Computer
Use the lower left corner of the dialog box to insert pictures from 
your computer (and any network folder available to your computer) 
into the editor.
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NOTE You can only select files in the To Select a Local File: field if your computer has 
permission to upload files to the server.

To insert a picture from your computer, follow these steps.

1. Click the Browse button.
2. Navigate to the file that you want to insert and press Open to 

insert it. 
Your Webmaster can set a maximum size (in kilobytes) for 
images. If you select an image that exceeds the maximum, an 
error message appears and you cannot insert it.
Your Webmaster can also restrict the type of image file you can 
insert. For example, if your Webmaster does not authorize you 
to insert bitmap (.bmp) files and you try to do so, an error 
message lists valid file extensions, and you cannot insert the 
image.

3. Click in the Enter a description for the file field. Enter a title 
to describe the file. 

4. After you insert the picture, the title appears in the dialog box’s 
top left corner to identify the picture to you and all users 
connected to the same Web server.
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NOTE The title is also the alt text for the image. The alt text appears in place of the 
image on the Web page if the image itself cannot display for any reason.

5. Information about the picture’s file size, width and height 
appears in the upper right corner of the dialog box.

6. If you want to view a picture before inserting it, click Preview 
(on the right side of the dialog box).

7. Click OK.
8. The Picture Properties dialog box reappears. Here, you can 

change the picture’s properties. For more information, see 

•“Adjusting a Picture” on page 416

•“Setting a Border” on page 418

•“Aligning the Picture” on page 419

• “Adding Space around the Picture” on page 421

• “Editing the Picture’s Title” on page 422

9. Click OK to insert the picture into the editor.

Using the Second Media Selection Dialog Box
When using the second Media Selection dialog box, you can insert 
a picture from any folder available to your computer (whether the 
folder is on your computer or a remote computer) or from the Web 
server. Your Webmaster determines which pictures are available 
on the Web server.

To insert a picture from

• a folder available to your computer, click Select New File, 
navigate to the file of interest, and click OK.

• the Web server, click the Select Server File button.You are 
prompted to enter a User Name and Password. Your 
Webmaster assigns these codes to you, which are needed to 
copy the file to the Web server.
Next, the Image Explorer dialog appears (illustrated below). 
Navigate through the folder structure until you find the image. 
Then click OK to insert the image into eWebEditPro+XML.
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The Picture Properties Dialog Box
You can also use the Picture Properties dialog box to

• adjust the picture’s width, height, border thickness, and 
alignment

• reset the image’s properties width, height, border thickness, 
and alignment to their original specifications

• set spacing between the picture and surrounding information 
on the page

• enter or edit the picture’s title

• view technical information about your connection

Adjusting a Picture
The layout area of the Picture Properties dialog box lets you adjust 
a picture’s width, height, border thickness, and alignment.
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You can use the following fields to adjust the picture before 
inserting it into the editor.

WARNING! If you substantially adjust the picture’s height and/or width, the picture may be 
distorted when users view your Web page.

Pixels
A pixel is a single point in a graphic image.

Computer monitors display pictures by dividing the screen into 
thousands of pixels, arranged in rows and columns. The pixels are 
so close together that they appear connected.

Below is an image shown at regular size and then enlarged so you 
can see the pixels that make up the picture.

To make this change Use this field

The width of the picture, in pixels Width

The height of the picture, in pixels Height

Add a border around the picture Border Thickness
For more information, see “Setting a Border” on 
page 418

Adjust the alignment of the picture Alignment
For more information, see “Aligning the Picture” on 
page 419



Inserting Images

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 418

 regular size

 enlarged to show pixels

Setting a Border
To add a border around a picture, enter the border’s thickness in 
pixels in the Border Thickness field on the Picture Properties 
dialog box.

Here is a picture with a 1 pixel border.

Here is the same picture with a 10 pixel border.

If the picture is not a hyperlink, its border is black. If the picture is 
also a hyperlink, the border is the same color as a hyperlink (for 
example, blue or purple if visited). 
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Aligning the Picture
To align a picture, use the Alignment field on the Picture 
Properties dialog box.

When deciding how to align a picture, you need to become familiar 
with these terms.

• baseline of text - the imaginary line on which the text lies. 
Some letters (such as g, p and y) have descenders, segments 
of letters that extend below the baseline

• bottom of text - the lowest section of a line to which a 
descender extends

• top of text - the highest spot of a line to which any segment of a 
letter extends

• vertical center - the midpoint between the top and bottom of the 
line

The following table lists your alignment choices.
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Resetting Width, Height, Border Thickness, and Alignment 
If you adjust the picture’s width, height, border thickness, and/or 
alignment and later want to restore all of those settings to their 
original values, click the Reset button.

To align Click this in the 
Alignment field

Illustration

The picture on the left margin, allowing 
subsequent text to wrap around it

Left

The picture on the right margin, allowing 
subsequent text to wrap around it

Right

The top of the picture with the top of the 
text

Text Top, Top

The vertical center of the picture with the 
baseline of the text

Middle

The vertical center of the picture with the 
vertical center of the text

AbsMiddle

The bottom of the picture with the 
baseline of the text (This is the default 
alignment)

Bottom, Baseline

The bottom of the picture with the bottom 
of the text

AbsBottom
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Note that you cannot selectively restore some settings -- the Reset 
button automatically restores all of them.

Adding Space around the Picture
On the Picture Properties dialog box, you can use the Spacing 
fields (Horizontal and Vertical) to add space around the picture. 
You enter a number of pixels to determine spacing value.
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The following graphic illustrates the effect of adding spacing to a 
picture.

Editing the Picture’s Title
The title that you entered in the Insert Media Item dialog box 
defaults into the Title field of the Media Selection dialog box. You 
can edit the title in this field if desired.

NOTE The title is also the alt text for the image. The alt text appears in place of the 
image on the Web page if the image itself cannot display for any reason.

The Options Button
When you click the Options button on the File Properties dialog 
box, the options dialog box appears. The box displays information 
about your connection to the Web server.

For information about these settings, see “Uploading Images” in 
the eWebEditPro+XML Developer’s Reference Guide.
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Moving an Image to the Server
If you insert an image from your computer into eWebEditPro+XML 
content, that image must be moved to the server when you save 
the content. The image can only appear on Web pages that display 
it after you move it to the server.

When you save content that incudes an image you inserted, the 
following dialog appears.

All inserted files appear in the dialog, which also estimates how 
long it will take to move the files to your server. If you do not want 
to wait that long to upload the files, click Upload Later. If you do 
this, the images will not appear on the published Web content until 
you move them to the server.

You can also enter a Title for the image near the bottom of the 
screen. If you do, this text appears when the user reading the Web 
pages moves the cursor over the image.

Deleting a Picture
If you want to delete a picture, follow these steps.
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1. Move the cursor over the picture.
2. Click the mouse to select the picture.

3. Click the Cut button ( ).
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Editing Images

WebImageFX lets you select an image from the content, edit that 
image, and then insert the updated image into the content. Editing 
consists of several functions available on the toolbar, such as

• brightening

• rotating

• changing the color depth

• inserting text
This section explains WebImageFX.

Important! WebImageFX is an external, add-on product available from Ektron.

Using WebImageFX

Choosing the Image
If you double click an image, it appears within WebImageFX. You 
can also right click the mouse and choose Image Editor from the 
menu that appears.
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WebImageFX looks similar to eWebEditPro+XML but has different 
menu and toolbar buttons.
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If the Image Edit button ( ) appears on your toolbar, you can click 
it to open WebImageFX. If no image is selected when you press 
the button or click the menu command, a blank editor appears, and 
you can use the File -> Open command to choose an image.

Once the image is in WebImageFX, you can use the buttons and 
menu options to edit it. The rest of this chapter describes those 
buttons and menu options.

Saving the Image
When you finish editing the image, you can insert it into the content 
by pressing the Exit button ( ). Alternatively, you can save the 
image to a local or network folder using the Save button ( ).

When you insert the image into the content, WebImageFX checks 
the file extension. If the image is a .gif file, it is saved as a .png file 
in your temporary directory. For example test.gif is saved as 
C:\Documents and Settings\your user name\Local 

Settings\Temp\test.png.

Any other file type is saved in your temporary directory without 
changing the file extension, unless you use the Save As option. 
For example, you save test.jpg as test.png.

Assigning a Name to a New Image

If you create an image in WebImageFX, and then exit 
WebImageFX and return to eWebEditPro+XML, the system assigns 
the image a random name, such as WIF50A.jpg.

If you want to assign a different name and/or folder to the image, 
use the Save as command.

See Also: ”Save As” on page 450

Toolbar Buttons and Menu Commands
The following tables list each toolbar button and menu command. 
They are followed by a more detailed description of each function.
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File Menu Options

Edit Menu Options

Toolbar 
Button

Command Brief Description For more 
information, see

Create New Creates a new image. ”Create New” on 
page 437

Open Selects an image to edit. ”Open” on page 443

Save Saves changes to an image. ”Save” on page 449

Save As Saves the current image under a 
different name or format.

”Save As” on page 450

Twain Acquire Performs a single page scan.
Before scanning, you must select a 
source using the Twain Source 
command.

”Twain Acquire” on 
page 453

Twain Source Allows the user to select a source for 
acquiring an image, such as a 
scanner or digital camera.

”Twain Source” on 
page 454

Exit Save changes and return to 
eWebEditPro+XML .

”Exit” on page 439

Exit without save Ignore changes; return to 
eWebEditPro+XML .

”Exit without Save” on 
page 440

Toolbar 
Button

Command Brief Description For more 
information, see

copy Copies a selected area of an image. ”Copy” on page 437
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View Menu Options

paste as new 
image

Inserts copied image or area into a 
new file.

”Paste as New Image” 
on page 445

undo Reverses the most recent action. ”Undo” on page 454

redo Reapplies the changes from the 
command that occurred before you 
pressed Undo.

”Redo” on page 447

select Selects an area of an image. You 
can then perform actions on the 
area, such as blur and delete.

”Select” on page 451

crop Removes everything outside of 
selected area of an image.

”Crop” on page 437

delete Deletes selected area of an image. ”Delete” on page 438

Toolbar 
Button

Command Brief Description For more 
information, see

Toolbar 
Button

Command Brief Description For more 
information, see

reset zoom ratio Displays image at full size. ”Reset Zoom Ratio” on 
page 448

zoom in Increases an image’s magnification. ”Zoom In” on page 455

zoom out Decreases an image’s magnification. ”Zoom Out” on 
page 456
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Image Menu Options

Toolbar 
Button

Command Brief Description For more 
information, see

image info Displays information about an 
image.

”Image Info” on 
page 441

dimensions Modifies an image’s width and 
height.

”Dimensions” on 
page 438

color depth Changes the number of colors 
available to an image.

”Color Depth” on 
page 435

blur Blurs or softens an image. ”Blur” on page 431

sharpen Sharpens edges within an image. ”Sharpen” on page 451

brightness Changes an image’s brightness. ”Brightness” on 
page 432

contrast Changes the difference between 
light and dark areas of an image.

”Contrast” on page 436

horizontal flip Reverses an image horizontally left 
to right.

”Horizontal Flip” on 
page 441

vertical flip Flips an image vertically top to 
bottom.

”Vertical Flip” on 
page 455

rotate Turns an image a specified number 
of degrees.

”Rotate” on page 448
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Annotation Menu Options

Blur
Standard Toolbar Button

Description

Blurs or softens an image. You can select a level of blur, from 0 
through 4.

Toolbar 
Button

Command Brief Description For more 
information, see

pointer selection Click an annotation to select it. ”Pointer Selection” on 
page 445

choose color Sets the color for an annotation 
before you insert it.

”Choose Color” on 
page 433

choose font Sets the color of text before you 
insert it.

”Choose Font” on 
page 434

freehand Draws a line in any shape that you 
want.

”Freehand” on 
page 440

line Draws a straight line. ”Line” on page 442

oval Draws an oval. ”Oval” on page 444

polygon Draws a polygon (a closed figure 
surrounded by straight lines).

”Polygon” on page 446

rectangle Draws a rectangle. ”Rectangle” on 
page 447

text Inserts text. ”Text” on page 452
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If you select an area of the image, the command only changes that 
area.

Dialog Box

Brightness
Standard Toolbar Button

Description

Increases or decreases an image’s brightness. You can select a 
brightness level from 32 (brightest) through -32 (darkest).

If you select an area of the image, the command only changes that 
area.

NOTE You cannot adjust brightness if the image’s bit depth is 8 or fewer. See Also: 
”Specifying Color Depth” on page 456

Dialog Box
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Choose Color
Standard Toolbar Button

Description

Lets you choose the color of an annotation before you insert it.

To change an annotation’s color after inserting it, place the cursor 
on the annotation and press the right mouse button to display the 
Attributes menu.

Dialog Box
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Choose Font
Standard Toolbar Button

Description

Lets you choose the color of annotation text before you insert it.

To change an annotation’s color after inserting it, place the cursor 
on the annotation and press the right mouse button to display the 
Attributes menu.

Dialog Box
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Color Depth
Standard Toolbar Button

Description

Changes an image’s color depth.

See Also:  “Specifying Color Depth” on page 456

Dialog Box
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Contrast
Standard Toolbar Button

Description

Increases or decreases an image’s contrast (that is, the difference 
between light and dark areas of an image). You can select a 
contrast level, from 10 through -10.

If you select an area of the image, the command only changes that 
area.

Dialog Box
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Copy
Standard Toolbar Button

Description

Copies a selected area of an image. After you copy an image, you 
can paste it using the paste command. See Also: ”Paste as New 
Image” on page 445

To select an area of an image, use the Select command. See Also: 
”Select” on page 451

If you do not select an area, the entire image is copied.

Create New
Standard Toolbar Button

Description

Lets you create a new image. If you are editing an image when you 
press this command, you are asked if you want to save changes to 
it first.

By default, a new image’s bit depth is 24, but you can change it if 
desired using the color depth command.

See Also: ”Color Depth” on page 435

Crop
Standard Toolbar Button

Description
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Keeps selected area of an image; removes everything outside that 
area.

To use the Crop command, follow these steps.

1. Select an area of an image that you want to keep.

2. Press the Crop button ( ).
3. Everything outside the selected area is removed.

Delete
Standard Toolbar Button

Description

Removes a selected area of an image. You must select an area 
before you delete it.

The deleted area is not saved for later pasting. In contrast, if you 
use the Cut command, you can later paste the cut area.

Dimensions
Standard Toolbar Button

Description

Lest you change an image’s width and/or height, which are defined 
in pixels.

Maintaining Aspect Ratio

Use this check box to change an image’s size while maintaining its 
aspect ratio.
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Aspect ratio is the ratio of an image’s width to height. For example, 
if a graphic has an aspect ratio of 2:1, its width is twice as large as 
its height.

If you check the Maintain Aspect Ratio box, just specify a new 
width -- the height is calculated automatically.

Dialog Box

Exit
Standard Toolbar Button

Description

Save the change in the WebImageFX and return to 
eWebEditPro+XML, where the updated image appears.
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Exit without Save
Standard Toolbar Button

Description

Ignore changes made to the image in WebImageFX. Return to 
eWebEditPro+XML.

Freehand
Standard Toolbar Button

Description

Lets you draw a line in any shape that you want, similar to using a 
pen on paper.

To use this command, click the freehand command, drag the line, 
and release the mouse. To change the line’s size or color, place 
the cursor on the line and press the right mouse button to display 
the Attributes menu.

Dialog Box
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Horizontal Flip
Standard Toolbar Button

Description

Reverses an image horizontally left to right.

Click this command again to reverse the image horizontally right to 
left.

Image before horizontal flip 

Image after horizontal flip 

Image Info
Standard Toolbar Button
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Description

Displays information about an image:

• image name

• height and width in pixels

• bit depth (See Also: ”Specifying Color Depth” on page 456)

• file format

Line
Standard Toolbar Button

Description

Draw a straight line. To change a line’s size or color, right click it 
after drawing it.

To use this command, click the line command, drag the line, and 
release the mouse. To change the line’s size or color, place the 
cursor on the line and press the right mouse button to display the 
Attributes menu.

Dialog Box
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Open
Standard Toolbar Button

Description

Select an image for editing. The image can be on your computer or 
a local area network.

Dialog Box
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To change the type of file that appears in the window, click the 
down arrow (circled above) to the right of the Files of type field. 
Your system administrator determines which types of files you can 
edit.

Oval
Standard Toolbar Button

Description

Draws an oval.

To use this command, click the oval command, drag the line, and 
release the mouse. To change the oval’s line size or color, place 
the cursor on the line and press the right mouse button to display 
the Attributes menu.

Dialog Box
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Paste as New Image
Standard Toolbar Button

Description

After you copy or cut an image or an area of an image, use paste 
as new image to insert it into a new file.

Before creating a new file, WebImageFX asks if you want to save 
changes to current file.

Pointer Selection
Standard Toolbar Button

Description

Click an annotation to select it. After you select an annotation, you 
can perform functions on it, such as delete it.

This command is a toggle, which means the first time you click it, it 
is on, and the next time you click it, it is off.
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Polygon
Standard Toolbar Button

Description

Draws a polygon (that is, a closed figure surrounded by straight 
lines).

To use this command, follow these steps.

1. Click the polygon command.
2. Drag the line in one direction as far as you want.
3. Drag the line in the other directions to complete the polygon.
4. Double click the mouse to terminate the polygon.
5. To change the polygon’s line size or color, place the cursor on 

the line and press the right mouse button to display the 
Attributes menu.

Dialog Box
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Rectangle
Standard Toolbar Button

Description

Draws a rectangle. 

To use this command, click the rectangle command, drag a 
rectangle, and release the mouse. To change the rectangle’s line 
size or color, place the cursor on the line and press the right mouse 
button to display the Attributes menu.

Dialog Box

Redo
Standard Toolbar Button

Description
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If you use the Undo command and then decide that it was a 
mistake, use this command. It re-applies the changes from the 
command that occurred before you pressed Undo.

See Also: ”Undo” on page 454

Reset Zoom Ratio
Standard Toolbar Button

Description

Displays image at full size.

See Also: ”Zoom In” on page 455; ”Zoom Out” on page 456

Rotate
Standard Toolbar Button

Description

Turns an image a specified number of degrees. Note that the 
dialog box lets you rotate the image

• left or right

• 90, 180, or 270 degrees

• any number of degrees between 1 and 359
Dialog Box
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Save
Standard Toolbar Button

Description

Save changes to an image. If required information is missing, such 
as the image name, you are prompted for this information.

Dialog Box
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NOTE The dialog box only appears the first time you save the image. If you later want to 
save it to a different folder, or under a different name or file type, use the Save As 
command.

Save As
Standard Toolbar Button

Description

Save the current image under a different name or format. For 
example, you might save mypicture.gif as mypicture.jpg.

Your system administrator determines which file formats are 
available.

Dialog Box

See ”Save” on page 449
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Select
Standard Toolbar Button

Description

Selects an area of an image. You can then execute other 
commands on the selected area, such as blur, sharpen, cut, and 
delete.

NOTE Once you press the Select command, it remains selected and continues to be 
active until you press it a second time.

Sharpen
Standard Toolbar Button

Description

Sharpens edges within an image. You can select a level of 
sharpness, from 1 through 5.

Sharpening brings an image into better focus and increases the 
detail.

If you select an area of the image, the command only changes that 
area.

Dialog Box
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Text
Standard Toolbar Button

Description

Places text on an image. You can also change the text’s size, font, 
color, and attributes (bold, italic, etc.).

To use the Text command, follow these steps.

1. Click the Text button ( ).
2. Move the cursor to where you want to place the text.
3. Click the mouse button and drag a rectangle in which to insert 

the text. 

NOTE Make sure the rectangle is large enough to accommodate your text. The rectangle 
disappears after you enter text.

4. Type the text.
5. Click outside the rectangle to close it.
6. To change the text or its font, size, style, color, etc., place the 

cursor over the text and right click the mouse. The text 
attributes dialog appears.

Dialog Box
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The following table lists functions you can perform with this dialog.

Twain Acquire
Standard Toolbar Button

To change this Use this tab/field

font Font Attributes/Font

font size Font Attributes/Size

font style (bold, italic, etc.) Font Attributes/Style

underlining Font Attributes/Underline

strikeout (for example, sample) Font Attributes/Strikethrough

font color Color Attributes/Primary 
Color

text Text Attributes/white box 

if text wraps when it reaches the 
end of a line

Text Attributes/ Wrap
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Description

Perform a single page scan from a previously selected source.

See Also:  ”Twain Source” on page 454

Importing Scanned Images

WebImageFX lets you acquire images from a scanner or digital 
camera that supports the Twain standard. You select the source 
(using Twain Source) and do a quick acquire from that source 
(using Twain Acquire).

Limitations

• You can only acquire one page at a time

• Few digital cameras support twain. Usually, digital cameras 
resemble a hard drive or use proprietary software to extract 
images. Ektron does not support an interface to proprietary 
software.

• Not all scanners support the twain standard

Twain Source
Standard Toolbar Button

Description

Lest you select a source for acquiring an image, such as a scanner 
or digital camera.

See Also: ”Twain Acquire” on page 453

Undo
Standard Toolbar Button
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Description

Reverses the most recent commands within the current editing 
session.

You can undo several commands at once by pressing the undo 
command repeatedly. The first time you press the command, the 
most recently completed command is “undone.” The next time, the 
second most recently completed command is “undone”, etc.

See Also: ”Redo” on page 447

Vertical Flip
Standard Toolbar Button

Description

Flips an image vertically top to bottom.

Click this command again to reverse the image vertically bottom to 
top.

Image before vertical flip 

Image after vertical flip

Zoom In
Standard Toolbar Button

Description
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Increases an image’s magnification.

You can press this command several times to continue to increase 
magnification.

See Also: ”Zoom Out” on page 456; ”Reset Zoom Ratio” on 
page 448

Zoom Out

Standard Toolbar Button

Decrease an image’s magnification.

You can press this command several times to continue to decrease 
magnification.

See Also: ”Zoom In” on page 455; ”Reset Zoom Ratio” on 
page 448

Specifying Color Depth
To specify an image’s color depth (that is, the number of colors 
available to an image), specify a bit depth. The color depth is 
derived from the bit depth. Here are the bit depth values.

Bit depth Color depth

1 2 colors

4 16 colors

8 256 colors

24 16M colors
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Introduction to Tables

Sometimes, the information on your Web page looks better when 
displayed on a table. Here is an example.

This section explains

• ”Creating a Table” on page 458

• ”Deleting a Table” on page 459

• ”Inserting a Table within a Table” on page 460

See Also: “Table Dialog Boxes and Menus” on page 461, 
“Manipulating Your Table’s Format” on page 468, “Working with 
Table Cells” on page 483 and ”Section 508 Tables” on page 518

City Baseball Team Hockey Team

Boston Red Sox Bruins

New York Yankees / Mets Rangers

Chicago White Sox / Cubs Black Hawks
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Creating a Table
To create a table, click the table button ( ) then click Insert Table 
from the menu. When you do, the Insert Table dialog box appears.

You can also access this dialog box after you insert it. You would 
do this if you wanted to edit any of the information entered in the 
dialog.

To access this dialog after insertion, follow these steps.

1. Click the table.
2. Right click the mouse.
3. Click Table Properties from the menu.
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When creating a table, you can specify the

• number of rows and columns

• width

• horizontal alignment on the page

• background color or background picture

• border size and color

For more information about managing tables, see “Manipulating 
Your Table’s Format” on page 468.

For more information about managing individual cells within a 
table, see “Working with Table Cells” on page 483.

Deleting a Table
To delete a table, follow these steps

1. Move the cursor over the table until the cursor becomes a four-
headed arrow ( ). 

2. Click the mouse button. The table becomes selected (small 
squares appear around it).

3. Press <Delete>.
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Inserting a Table within a Table
You can insert a table within a table. You might want to do this to 
arrange text in columns. 

NOTE HTML does not let you use tabs or spaces to align text in columns. You must use 
a table to align columns. You can remove the table’s border, so that no lines 
appear between the columns and rows.

To insert a table within a table, follow these steps.

1. Place the cursor in the cell into which you want to insert a table.

2. Click the Insert Table button ( ).
3. Click Insert Table from the menu.

4. The Insert Table dialog box appears.
5. Edit the fields in the dialog box as needed. Then, click OK.
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Table Dialog Boxes and Menus

This section explains the menu options and dialog boxes you use 
to manipulate tables and cells. In most cases, you are referred to 
another section that describes the feature in more detail.

This section explains

• ”The Insert Table Menu” on page 461

• ”The Table Properties Dialog Box” on page 463

• ”The Cell Properties Dialog Box” on page 465

• ”The Table Context Sensitive Menu” on page 467

The Insert Table Menu
You access the Insert Table menu by clicking on the Insert Table 

button ( ) while the cursor is inside a table. 

NOTE Before you click the button, make sure the table is not selected (that is, the table 
is not surrounded by small boxes).

When you do, the following menu appears. 
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The following table lists the menu options and where to get more 
information on each.

Menu Option Description For more information, see

Insert Table Inserts a new table where the 
cursor is currently resting

“Creating a Table” on page 458

Insert Row Creates a new table row above the 
row in which the cursor is currently 
resting

“Adding or Removing Rows and 
Columns” on page 469

Insert Column Creates a new table column next to 
the column in which the cursor is 
currently resting

“Adding or Removing Rows and 
Columns” on page 469

Insert Cell Inserts a cell to the left of the cursor 
in a table

Delete Rows Deletes table row in which the 
cursor is currently resting

“Adding or Removing Rows and 
Columns” on page 469

Delete Column Deletes table column in which the 
cursor is currently resting

“Adding or Removing Rows and 
Columns” on page 469

Delete Cells Deletes the selected cells

Merge Cells Combines the contents of two or 
more selected cells into one

“Merging Two Cells” on page 497

Split Cell Divides a cell into two. Each cell 
occupies one half the size of the 
original cell.

“Splitting a Cell” on page 496

Table Properties Displays and lets you edit table 
properties, such as the number of 
rows and columns, cell padding, 
and borders.

“The Table Properties Dialog Box” on 
page 463

Cell Properties Displays and lets you edit cell 
properties, such as width and 
alignment

“The Cell Properties Dialog Box” on 
page 465
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The Table Properties Dialog Box
The Insert Table dialog box lets you manipulate most elements of a 
table‘s appearance. 

The following table lists the fields on this dialog box and refers you 
to the section that explains each field.
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Field(s) Lets you specify For more 
information, see

Size: Rows, Columns The number of rows and 
columns in the table

“Choosing the Number 
of Rows and Columns” 
on page 468

Layout: Width Table width “Specifying Table Width” 
on page 470

Layout: Horizontal 
Alignment

The table’s alignment 
across the Web page

“Setting Horizontal 
Alignment” on page 493

Background Color The background color of 
the table

“Specifying a Table’s 
Background Color” on 
page 476

Background Image A background image for 
the table

“Specifying a 
Background Image 
for a Table” on 
page 477

Borders: Use Default 
Color

Whether or not to use 
the default color (gray) 
for table borders

Border Color If you do not use the 
default, the color of the 
table border

“Assigning Border 
Color” on page 479

Border Size The size of the table 
border

“Assigning Border Size” 
on page 481

Cell Padding The space (in pixels) 
between the cell text 
and a cell’s border 

“Assigning Cell 
Padding” on page 500

Cell Spacing The space (in pixels) 
between a cell and 
surrounding cells

“Assigning Cell 
Spacing” on page 500
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The Cell Properties Dialog Box
The Cell Properties dialog box lets you manipulate most elements 
of a cell‘s appearance.

The following table lists the fields on this dialog box and refers you 
to the section that explains each field.
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Field(s) Lets you specify For more 
information, see

Rows Spanned If the cell spans two or 
more rows

“Spanning Rows or 
Columns” on page 491

Columns Spanned If the cell spans two or 
more columns

“Spanning Rows or 
Columns” on page 491

Width The minimum cell width “Specifying the Width of 
a Cell” on page 483

Word Wrap Whether text moves 
down to the next line 
when it reaches the 
specified width of a cell

“Word Wrap” on 
page 498

Horizontal Alignment The alignment of data 
across a cell

“Setting Horizontal 
Alignment” on page 493

Vertical Alignment The alignment of data 
up and down within a 
cell

“Setting Vertical 
Alignment” on page 495

Background Color The cell’s background 
color, if you want it to be 
different from the table’s 
background color

“Specifying a Cell’s 
Background Color” on 
page 487

Background Image A background image for 
the cell

“Specifying a 
Background Image for a 
Cell” on page 489

Use Default Color Apply the table border 
color to this cell border

Border Color Apply a color other than 
the table border color to 
this cell border

“Setting a Cell’s Border 
Color” on page 486
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The Table Context Sensitive Menu
The following menu appears when you right click the mouse while 
the cursor is in a table.

All items on this menu are described in ”The Context Sensitive 
Menu” on page 393 except Tables, which is described in ”The 
Insert Table Menu” on page 461.
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Manipulating Your Table’s 
Format

This section explains how to manipulate your table’s format by 
specifying

• a number of rows and columns

• a width

• horizontal alignment

• a background color or image

• border color and size

NOTE You can also apply most of these properties to individual cells within a table. See 
“Working with Table Cells” on page 483 for details.

Choosing the Number of Rows and Columns
Use the Size section of the Insert Table dialog box to specify the 
number of rows and columns in the table.
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A row is a horizontal series of cells, while a column is a vertical 
series.

If you know how many rows and columns the table will be, enter 
those numbers. If you don’t know the number of rows and columns 
you need when you create the table, estimate how many you need. 
You can add or remove rows and columns later.

Placement of Inserted Row or Column
If you add a row, it appears above the row in which the cursor was 
resting when you pressed Insert Row.

If you add a column, it appears on the left side of the table.

Adding or Removing Rows and Columns
To add or remove rows and columns after you create the table, 
follow these steps.

1. Place the cursor in the cell from which you want to add or 
delete.
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2. Right click the mouse. A menu appears.

3. Click the appropriate action from the menu. For example to add 
a row, click Insert Row.

NOTE If you are working with nested tables, and you add or remove a column then undo 
that action and redo it, you must press the redo button once for each cell in the 
row or column.

Specifying Table Width
When you create a table, you can set its width by specifying one of 
the following:

• percentage of the window: the table’s width varies as a user 
adjusts the browser size

• fixed number of pixels, the table’s width stays the same as a 
user adjusts the browser size

You can also not set a width but instead let information you enter 
into the table’s cells determine its width.



Manipulating Your Table’s Format

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 471

NOTE To set the width of a table column, adjust the width of one of the cells within the 
column (as described in “Specifying the Width of a Cell” on page 483). Usually, 
this change affects all other cells in the column.

Specifying Table Width by Percentage
Specify table width by percentage if you want the table to be 
resized as the user resizes the browser. 

NOTE In order for the table to resize with the browser, the Word Wrap attribute must be 
turned on in all of a table’s cells. For details, see “Word Wrap” on page 498.

For example, if you specify that a table is 100% wide, and your 
browser displays 14 inches across when it is maximized, the table 
fills the screen (except for the browser border).
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If you resize the browser to half the screen, the table will be about 
7” wide. You still see both columns, but some of the data is moved 
down. 

Setting Table Width by Percentage

To specify table width by percentage, choose Percent in the layout 
section of the Insert Table dialog box. Then, specify the percentage 
at the Width field.
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Specifying Table Width by Pixels
Specify table width by pixels if you want the table to remain the 
same size if a user resizes the browser.

For example, if you specify that a table is 610 pixels wide, and the 
user’s browser is set to low resolution (640 x 480 pixels), the table 
occupies the full width of the browser when it is maximized.

If the user resizes the browser so that it only occupies the left half 
of the screen, only the left half of the table appears. A scroll bar 
appears at the bottom of the browser. The user must move the 
scroll bar to see the rest of the table.

If you set table width by pixels, do not set it to more than 610 
pixels. Otherwise, the table will not fully display on a monitor set to 
low resolution (640 x 480).

Setting Table Width by Pixels
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To specify table width by pixels, choose Pixels in the layout section 
of the Insert Table dialog box. Then, specify the number of pixels at 
the Width field.

Specifying Horizontal Alignment
You can specify your table’s horizontal alignment (left, right, or 
center) within the browser.

Alignment Example

left

right
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If you specify right or left justify, you can wrap text around the table. 
To do this, move the cursor to the right or left of the table and begin 
typing.

Specify the table alignment at the Horizontal Alignment field on 
the Layout area of the Insert Table dialog box.

center

Alignment Example
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Table Backgrounds
You can specify a background color or image for your table.

Specifying a Table’s Background Color
You can assign a background color to a table to make it more 
pleasing to the eye. Here is an example.

NOTE If you apply a dark background color to a table, you may want to apply a light 

foreground color to the text. Use the font color button ( ) to change the text 
color.

To assign a background color to your table, click the Background 
Color field on the Insert Table dialog box.

When you click that field, a color dialog box appears. Click the 
color that you want to apply to the background of the table. 

Follow these steps to get help on how to use the color box.

1. Click the question mark in the top right corner.
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2. A large question mark appears next to your cursor. 
3. Drag the question mark to the area of the dialog box that you 

want to learn about.
4. Click the mouse button. A box appears with instructions for that 

area.
Deleting a Table’s Background Color

To delete a table’s background color, click the Unassigned box in 
the Custom Background area of the Insert Table dialog box.

Specifying a Background Image for a Table
If you want a background image to appear in all table cells, use the 
Background Image field of the Insert Table dialog box.
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Your Webmaster determines which images are available to you.

To insert a background image

1. Click the down arrow to the right of (Select Image). A list of 
background images appears.

2. Click the image of your choice.
3. Click OK.
Note that when you apply a background image to a table 

• it applies to the entire table, including the borders.

• if the table is larger than the image, the image repeats until it 
fills the table.

• if the image is larger than the table, the top left corner of the 
image aligns with the top left corner of the table. The rest of the 
image fills as much of the table as possible.

• you can also apply an image to individual cells (see “Specifying 
a Background Image for a Cell” on page 489).

• make sure that the image does not obscure user’s ability to 
read the table text.

Deleting a Background Image

1. Move the cursor to any cell on the table and right click the 
mouse.
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2. Click Table Properties from the menu.

3. Select the value in the Background Image field and press 
<Backspace>.

4. Click OK.

Setting Table Borders
You can specify a border color or size for your table.

Assigning Border Color 
A table border is the line that separates the table from the rest of 
your Web page. By default, table borders are gray. You can change 
the color of table borders.



Manipulating Your Table’s Format

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 480

If you want a table’s border to “disappear,” set it to the same color 
as the page’s background color. This technique is often used to 
format text on a Web page.

Assigning a Cell Border Color

Each cell also has a border that separates it from the other cells 
and the table border. By default, a cell’s border color matches the 
table border. However, you can individually change a cell border 
color (see “Setting a Cell’s Border Color” on page 486). 

To assign a color to your table’s border, click the Border Color 
field on the Insert Table dialog box.

When you click that field, a color selection box appears. Click the 
color that you want to apply to the table’s border. Follow these 
steps to get help on how to use the color box.

1. Click the question mark in the top right corner.
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2. A large question mark appears next to your cursor. 
3. Drag the question mark to the area of the dialog box that you 

want to learn about.
4. Click the mouse button. A box appears with instructions for that 

area.

Assigning Border Size
You can also adjust the size of a table border. Size is measured in 
pixels.

To assign a border size to your table, enter a number of pixels into 
the Border Size field on the Insert Table dialog box.



Manipulating Your Table’s Format

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 482

If you set a table’s border size to zero (0) but wish to view the 
table’s boundary lines while you are editing it, select the table and 
click the border button ( ). Boundary lines will appear while you 
are editing but disappear when a user views the page. 
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Working with Table Cells

Along with functions for managing tables (described in 
“Introduction to Tables” on page 457 and “Manipulating Your 
Table’s Format” on page 468), eWebEditPro+XML also lets you 
perform actions on individual cells within a table.

You can perform the following actions on individual table cells.

• ”Specifying the Width of a Cell” on page 483

• ”Inserting a Cell” on page 484

• ”Deleting a Cell” on page 485

• ”Setting a Cell’s Border Color” on page 486

• ”Specifying a Cell’s Background Color” on page 487

• ”Specifying a Background Image for a Cell” on page 489

• ”Spanning Rows or Columns” on page 491

• ”Aligning Text Within a Cell” on page 493

• ”Splitting a Cell” on page 496

• ”Merging Two Cells” on page 497

• ”Word Wrap” on page 498

• ”Setting Cell Padding and Spacing” on page 499

NOTE HTML does not allow you to adjust the width of a cell’s border.

You can also select several cells or a row of cells and change them 
as described above. However, you cannot select and change a 
column of cells.

Specifying the Width of a Cell
As described in “Specifying Table Width” on page 470, there are 
several ways to set the width of a table. Within a table, you can 
also specify the width of an individual cell.
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When you set a cell width, there is no guarantee that the cell will 
occupy that width when displayed in a browser. This is because the 
cell is part of a column, and changes to other cells in the column 
can affect the cell whose width you set. Setting cell width only 
guarantees that the cell will not be less than the width you specify.

If you want to ensure that a cell’s size does not change, set all cells 
in a column to that width.

To specify a cell’s width, follow these steps.

1. Place the cursor in the cell whose width you want to set.
2. Right click the mouse.
3. Click Table from the menu.
4. Click Cell Properties from the menu.
5. The Cell Properties dialog box appears. 

6. In the layout section of the dialog box, enter the cell width at 
the Width field. You can enter the width in pixels or percentage. 
These choices are explained in “Specifying Table Width” on 
page 470.

7. Click OK.

Inserting a Cell
To insert a cell, follow these steps.
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1. Move the cursor to the right of where you want the new cell to 
appear.

2. Right click the mouse.
3. Click Insert Cell from the menu.
The new cell appears to the left of the cell in which the cursor 
resides when you click Insert Cell. The cursor cell and all cells to 
its right shift right to make room for the new cell.

In this example, the cursor was in cell “b” when the user clicked 
Insert Cell.

Before

After

Deleting a Cell
To delete one or more cells, follow these steps.

1. Move the cursor to the first cell you want to delete.
2. To delete only that cell, proceed to the next step. To delete 

several contiguous cells, select them. Contiguous cells can 
cross rows.

3. Right click the mouse.
4. Click Delete Cells from the menu.
Any cells to the right of the deleted cells shift left to occupy the 
vacant space.

In this example, the cursor was in cell “b” when the user clicked on 
Delete Cells.
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Before

After

Setting a Cell’s Border Color
A cell border is the line that separates it from other cells. 

By default, the color of a cell’s border matches the color of the 
table border. However, you can change the color of any cell border 
individually.

NOTE When viewed in Netscape Navigator, cell borders are gray, regardless of any 
change you make on the Cell Properties dialog box. 

This example illustrates the effect of different cell border colors 
within a table.

If you want a cell’s border to “disappear,” set it to the same color as 
the table’s background color.

To change the color of a cell’s border, follow these steps.

1. Move the cursor to the cell and right click the mouse.
2. Click Table from the menu.
3. Click Cell Properties from the menu.



Working with Table Cells

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 487

4. Click the Border Color field on the Cell Properties dialog box.

5. When you click that field, a Windows Color selection box 
appears. Click the color that you want to apply to the cell 
border. 
See Also: “Using the Color Box” on page 490

Specifying a Cell’s Background Color 
“Specifying a Table’s Background Color” on page 476 explains how 
to apply a background color to a table. You can also apply a 
background color to a cell.

To apply a background color to a cell, follow these steps.

1. Move the cursor to the cell and right click the mouse.
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2. Click Table from the menu.
3. Click Cell Properties from the menu.
4. Click the Background Color field on the Cell Properties dialog 

box.

5. When you click that field, a Windows Color selection box 
appears.
See Also: “Using the Color Box” on page 490

6. Click a color to apply to the background of the cell. 

Deleting a Cell’s Background Color
To delete a cell’s background color, click the Unassigned box in 
the Custom Background area of the Cell Properties dialog box.



Working with Table Cells

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 489

Specifying a Background Image for a Cell
“Specifying a Background Image for a Table” on page 477 explains 
how to apply a background image to a table. You can also apply a 
background image to a cell.

Your Webmaster determines which images are available.

To insert an image into a cell, follow these steps.

1. Move the cursor to the cell and right click the mouse.
2. Click Table from the menu.
3. Click Cell Properties from the menu.
4. Move the cursor to the Background Image field of the Cell 

Properties dialog box.

5. Click the down arrow to the right of (Select Image). A list of 
background images appears.

6. Click the image of your choice.
7. Click OK.
Note that when you apply a background image to a cell
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• If the cell is larger than the image, the image repeats until it fills 
the cell.

• If the cell is smaller than the image, the top left corner of the 
image appears in the top left corner of the cell. The rest of the 
image fills as much of the cell as possible.

• Make sure the image does not obscure a user’s ability to read 
the cell text (if any exists).

Deleting a Background Image
1. Move the cursor to the cell and right click the mouse.
2. Click Table from the menu.
3. Click Cell Properties from the menu.
4. Select the value in the Background Image field and press 

<Backspace>.

Using the Color Box
Follow these steps to get help on how to use the color box.

1. Click the question mark in the top right corner.
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2. A large question mark appears next to your cursor. 
3. Drag the question mark to the area of the dialog box that you 

want to learn about.
4. Click the mouse button. A box appears with instructions for that 

area.

Spanning Rows or Columns
You can create a table cell that stretches across more than one 
row or column. In the following table, notice how the row that 
contains “Sports Teams” spans three columns.

You can also create a column that spans several rows, as 
illustrated below. Notice that Boston spans three rows.

Sports Teams

City Baseball Team Hockey Team

Boston Red Sox Bruins

New York Yankees Rangers

Chicago White Sox Black Hawks

Colleges

City Name

Boston Boston College

Northeastern University

Boston University
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Spanning More than One Row or Column
To have a table cell span more than one row or column, follow 
these steps.

1. Place the cursor in the cell that will span rows or columns.
2. Right click the mouse.
3. Click Table from the menu.
4. Click Cell Properties from the menu.
5. The Cell Properties dialog box appears. In the Rows Spanned 

or Columns Spanned field, enter the number of rows or 
columns that you want this cell to span.

6. Click OK.
Effect of Spanning a Cell

When you set a cell to span rows or columns, the editor does not 
remove the cells that are in the way. Instead, it moves those cells 
across or down to the next available position.

For example, the following table has two rows and two columns.

New York Columbia University

Colleges

City Name
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If you set cell A to span two rows, note that cell C moves across to 
make room for cell A. This action pushes cell D to the next column.

Aligning Text Within a Cell
Within a cell, you can specify how your text aligns horizontally and 
vertically.

Setting Horizontal Alignment
In the Cell Properties dialog box, you can specify the horizontal 
alignment of a cell. You have set the alignment to left, center, or 
right, or 

• left

• center

• right

• justify - the text is justified down both left and right edges. Many 
books use this alignment style. (This alignment is not 
supported by all browsers.)
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This example illustrates these choices. 

To set horizontal justification of a table cell, follow these steps.

1. Place the cursor in the cell that you want to edit.
2. Right click the mouse.
3. Click Table from the menu.
4. Click Cell Properties from the menu
5. The Cell Properties dialog box appears. Click the down arrow 

to the right of the Horizontal Alignment field.
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6. Click your choice from the list and click OK. 

Setting Vertical Alignment
In the Cell Properties dialog box, you can specify the vertical 
alignment of a cell. You have four choices.

• top

• middle

• bottom

• along the baseline of the first line of text (the term “baseline” is 
defined in ”Aligning the Picture” on page 419)

This example illustrates the choices. 

To set vertical justification for a table cell, follow these steps.

1. Place the cursor in the cell that you want to edit.
2. Right click the mouse. 
3. Click Table from the menu.
4. Click Cell Properties from the menu.
5. The Cell Properties dialog box appears. Click the down arrow 

to the right of the Vertical Alignment field.
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6. Click your choice from the list and click OK.

Splitting a Cell
You can divide a cell into two. If you split a cell, each cell occupies 
one half the size of the original cell.

Row before split

Row after split

To split a table cell into two cells, follow these steps.

1. Place the cursor in the cell that you want to split.
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2. Right click the mouse.
3. Click Split Cell from the menu.

4. Two cells now appear where only one appeared before.

Merging Two Cells
You can merge two cells into one. If you merge two cells, the new 
cell contains all of the information from both. The new cell’s width 
equals the sum of the two cells that were merged.

Cells Before Merge
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Cell After Merge

To merge two or more cells, follow these steps.

1. Select the cells that you want to merge.

2. Click the Insert Table button ( ).
3. Click Merge Cells from the menu.

Word Wrap
Word Wrap is a text formatting feature of tables. It causes text to 
move down to the next line when the width of the characters on a 
line equals the column width. For example, if you set column width 
to 50%, with word wrap turned on, a table looks like this.

If you turn Word Wrap off for the same table, you get this result.

If Word Wrap is turned off, text stays on one line until the user 
entering table text presses <Enter>. That keystroke causes text to 
move down to the next line.
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By default, all cells have the Word Wrap feature turned on.

To turn Word Wrap on or off for a cell, follow these steps.

1. Place the cursor in the cell that you want to edit.
2. Right click the mouse. 
3. Click Table from the menu.
4. Click Cell Properties from the menu.
5. The Cell Properties dialog box appears. Click or off the Word 

Wrap checkbox and click OK.

Setting Cell Padding and Spacing
Cell padding is the space between a cell’s data and its border.

Cell spacing is the space between a cell and surrounding cells.
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Assigning Cell Padding
To assign cell padding to your table, click the Cell Padding field on 
the Insert Table dialog box. Enter the number of pixels.

Assigning Cell Spacing
To assign cell spacing to your table, click the Cell Spacing field on 
the Insert Table dialog box. Enter the number of pixels.
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Using Bookmarks

Use a bookmark to let a user “jump” from any word, phrase, or 
image to another place in a file. On your Web page, text appears in 
a different color to indicate that additional information is available 
at the bookmark’s location.

For example, if your Web page includes meeting minutes, the top 
of the page could list the meeting dates. You could then assign a 
hyperlink to each date and a bookmark to each set of minutes.

The user sees that a date is in a different color, so clicks the date to 
“jump” to the bookmark that marks the location of the meeting 
minutes.

“Creating a Bookmark” on page 501 describes how to set up a 
hyperlink to a bookmark within a file. You can also set up hyperlink 
to

• another Web page. This procedure is described in “Using 
Hyperlinks” on page 505.

• a bookmark within another Web page. This procedure is 
described in “Creating a Hyperlink to a Location Within a Web 
Page” on page 509. 

This section explains

• ”Creating a Bookmark” on page 501

• ”Changing the Destination Window” on page 504

Creating a Bookmark
When creating a bookmark, you must specify a

• source, the text or image that the user clicks to move to the 
bookmark
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• bookmark, the place to which the cursor jumps when the user 
clicks the source

To continue with the above example, a meeting date is the source, 
and the meeting minutes are the bookmark.

To create a bookmark, follow these steps.

1. Select the bookmark text or image.

2. Click the Bookmark button ( ). 

3. The Bookmark dialog box appears. Enter the name of the 
bookmark. The bookmark can include the following non-
alphabetic characters: ;  /  ?  :  @  &  =  +  $  , -  _  .  !  ~  *  '  (  ).

4. Click Add.
5. The editor screen returns. (The bookmark does not appear on 

the page.) Select the source text or image.
6. Click the Hyperlink button ( ).

7. The Hyperlink dialog box appears.
8. Click the down arrow to the right of the Quicklink field and 

click the bookmark you created in Step 3.
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9. If desired, you can use the Target Frame field to change the 
window in which the destination text appears. For details, see 
“Changing the Destination Window” on page 504.
If you leave the Target Frame field blank, the new window 
replaces the current window.

10. Click OK.
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Changing the Destination Window
While defining hypertext, you can use the Target Frame field on 
the Hyperlink dialog box to change the window in which the 
destination page appears. 

The possible values that you can enter into the Target Frame field 
are explained below.

If you want the destination page to appear Click this in the Target Frame 
field

In a new browser window, on top of the current 
browser.

New Window(_blank)

In the same position within the browser window. 
The new window replaces the current one.

Same Window(_self)
Note: this is the default.

If your page contains frames, in the frame that 
contains the frame with the hyperlink.

Parent Window(_parent)

If your page contains frames, in the full display 
area, replacing the frames.

Browser Window(_top)

If your page contains frames, in the frame with the 
specified name.

Enter the name of the frame.
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Using Hyperl inks

Use hyperlinks to let a user “jump” from any word, phrase or image 
to another Web page. The page can be within your network (that is, 
on an intranet) or anywhere on the internet.

NOTE If you want to create jumps within a file, see “Using Bookmarks” on page 501.

For example, if your Web page includes a jump to the Ektron Web 
site, you would enter the text to indicate the jump (for example 
Ektron Web Site), then create a hyperlink to www.ektron.com. When 
users see Ektron Web Site in a different color, they can click the 
text to “jump” to the site.

Although most jumps go to the top of another Web page, you can 
also jump to a bookmark within a Web page.

This section explains

• ”Creating a Hyperlink” on page 505

• ”Testing a Hyperlink” on page 508

• ”Creating a Hyperlink to a Location Within a Web Page” on 
page 509

• ”Editing a Hyperlink” on page 510

• ”Removing a Hyperlink” on page 510

• ”Preventing a URL from Becoming a Hyperlink” on page 510

Creating a Hyperlink
When creating a hyperlink, you must specify a

• source, the text or image the user clicks to move to the 
destination

• destination, the Web page to which the display moves when 
the user clicks the source
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To continue with the above example, Ektron Web Site is the 
source, and the Web page available at www.ektron.com is the 
destination.

To create a hyperlink, click the Hyperlink button ( ). When you do, 
the Hyperlink dialog box appears. From there, you can select from 
a list of Web pages (also known as Quicklinks). Or, if the page you 
are jumping to is not on the list, enter the URL address of the 
destination Web page. Each choice is described below.

Using a Quicklink
Your Web master can add to the Hyperlink dialog box any number 
of Quicklinks, that is, Web addresses that you can link to simply by 
selecting an item from a drop down menu.

Quicklinks are “quick” because you do not need to enter or know 
the URL of the destination Web page -- your Web master has 
already stored that information for you.

To apply a Quicklink, follow these steps.

1. Select the source text or image.
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2. Click the Hyperlink button ( ). The Hyperlink dialog box 
appears.

3. Click the down arrow to the right of the Quicklink field. A list of 
Web pages that your Web master has pre-loaded appears.

4. Click an item from the list to select it.
5. If desired, you can use the Target Frame field to change the 

window in which the destination text appears. For details, see 
“Changing the Destination Window” on page 504.
If you leave the Target Frame field blank, the new window 
replaces the current window

6. Click OK.

Entering a Hyperlink Manually
To create a hyperlink, follow these steps.

1. Select the source text or image.
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2. Click the New Hyperlink button ( ). The Hyperlink dialog box 
appears.

3. Click in the Link field after http://. Then, enter the address of 
the destination Web page. For example, to enter a hyperlink to 
the ektron Web site, enter www.ektron.com.

4. If desired, you can use the Target Frame field to change the 
window in which the destination text appears. For details, see 
“Changing the Destination Window” on page 504.
If you leave the Target Frame field blank, the new window 
replaces the current window

5. Click OK.

Testing a Hyperlink
Within the eWebEditPro+XML editor, you can test a hyperlink. To do 
this, select the hyperlink then double click it. That action launches 
the Web page assigned to the hyperlink.
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Creating a Hyperlink to a Location Within a Web 
Page

Sometimes, the destination Web page contains bookmarks, and 
you want to jump from your page to a bookmark on another page. 
(Bookmarks are described in “Using Bookmarks” on page 501.)

To create a hyperlink that jumps to another page’s bookmark, 
follow these steps.

1. Go to the destination Web page.
2. Click the bookmark that you want to jump to. For example, on 

the illustration below, the text Benefits to Partners jumps to a 
bookmark further down on the page.

3. When you click the bookmark, its full address appears in your 
browser’s address bar. This bookmark’s address looks like this.

http://www.ektron.com/single.cfm?doc_id=35#Benefits2

4. Click the address bar. The address is selected. Press 
<Ctrl>+<C> to copy the address into the Windows clipboard.

5. Go to eWebEditPro+XML.
6. Select the text or image from which you want to jump to the 

bookmark.

7. Click the Hyperlink button ( ). The hyperlink dialog box 
appears.

8. Move the cursor to the Link field. 
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9. Press <Ctrl>+<V> to paste the address you copied in Step 4 
into the Link field.

10. Click OK.

Editing a Hyperlink
If you need to change a hyperlink’s destination Web page or target 
frame, follow these steps.

1. Click the Hyperlink button ( ). The hyperlink dialog box 
appears.

2. Edit the Link or Target Frame field as needed.
3. Press OK.

Removing a Hyperlink
If you want to remove the hyperlink from text or an image, select 

the text or image and press the Remove Hyperlink button ( ).

Preventing a URL from Becoming a Hyperlink
If you enter a URL or an email address into eWebEditPro+XML, it 
automatically becomes a hyperlink. To prevent this, enter an extra 
space in the URL or address.

For example, instead of entering sales@ektron.com, enter 
sales<blank>@ektron.com.
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Working with HTML

eWebEditPro+XML creates pages for display on the World Wide 
Web or an intranet. These pages use HTML (hypertext markup 
language) to format text and images for display in a browser. You 
do not need to know HTML to use eWebEditPro+XML. 

However, if you know HTML, you can view, insert or edit your Web 
page’s HTML code. 

• ”Viewing and Editing HTML” on page 511

• ”Inserting Source” on page 512

• ”Cleaning Source Code” on page 513

• ”Inserting Content from MS Office 2000” on page 514

Viewing and Editing HTML
When you choose to view your page as HTML, the editor cleans 
the content using a method determined by your Webmaster. (For 
more information, see “Cleaning HTML” in the eWebEditPro+XML 
Developer’s Reference Guide.)

To view your page’s HTML, follow these steps.

1. Click the View as HTML button ( ), or right click the mouse 
and click View as HTML from the menu.
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2. The HTML code appears. While viewing the code, you can edit 
it using editor functions such as Cut, Copy, Paste and Replace. 
To select all content, press <Ctrl>+<A>.
You can also set default values for the style, size and color in 
which the HTML appears. To do this, right click the mouse and 
click Preferences. When you do, a dialog box appears in which 
you can enter formatting information about the HTML code.

These settings will be used whenever you view as HTML.
The settings are ignored when you view the page in WYSIWYG 
mode and when the user views the page.

3. To return to normal view, click the View as WYSIWYG button 
( ) or right click the mouse and click View WYSIWYG.

Editing a Section of a Page 
If you want to edit only a section of the HTML on your Web page, 
follow these steps.

1. Select the portion of your Web page that you want to edit.
2. Right click the mouse.
3. Click Edit Source from the menu. The HTML code appears.
4. Edit the HTML code as desired.
5. Click OK.

Inserting Source
If you want to insert HTML source code into your Web page, follow 
these steps.
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1. Place the cursor at the spot on the page where you want to 
insert the HTML.

2. Right click the mouse.
3. Click Insert Source from the menu.
4. The Insert Source dialog box appears. Paste or type your 

HTML code.
5. Click OK.

Cleaning Source Code
eWebEditPro+XML lets you “clean” the HTML source code for your 
Web page. You would typically use this feature after entering 
HTML text or pasting HTML code into eWebEditPro+XML from 
another application. 

The Clean Source option removes unnecessary HTML tags, 
ensures that all tags begin and end properly, and maximizes the 
page for efficiency. As a result, the page should be error-free and 
load more quickly in a browser. Also, the appearance of clean 
HTML is more consistent when viewed in different browsers.

To clean your HTML, follow these steps.

1. Right click the mouse.
2. Click Clean Source from the menu.
3. eWebEditPro+XML cleans your Web page’s HTML content. 
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Inserting Content from MS Office 2000
If you paste text into eWebEditPro+XML from a Microsoft Office 
2000 application, such as Microsoft Word, the following window 
appears.

For best results, click Yes.
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Section 508 Compliance

This section explains how eWebEditPro+XML complies with 
Section 508 of the Rehabilitation Act (a law enacted by the 
United States government that requires Federal agencies to 
make their electronic and information technology accessible to 
people with disabilities).

Specifically, this section explains the following topics. 

• ”Moving the Cursor into eWebEditPro+XML” on page 515

• ”Using eWebEditPro+XML without a Mouse” on page 516

• ”Section 508 Tables” on page 518

Moving the Cursor into eWebEditPro+XML

Using Internet Explorer
If the eWebEditPro+XML editor is one of several fields on a 
page, and your browser is Internet Explorer, move to 
eWebEditPro+XML by pressing <Tab> until the cursor lands in 
the editor.

To move from the editor to the next field, press <Ctrl>+<Tab>.

Using Netscape
If the eWebEditPro+XML editor is one of several fields on a 
page, and your browser is Netscape, your Webmaster needs to 
create custom toolbar buttons that let you move into and out of 
the editor. (This procedure is described in the 
eWebEditPro+XML Developer’s Reference Guide.)
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Using eWebEditPro+XML without a Mouse
As explained in ”Customizing Your Toolbar” on page 385, the 
eWebEditPro+XML toolbar consists of one or more toolbar 
menus. Menus have buttons that you click with the mouse to 
perform actions, such as copying text.

This section explains how to perform those actions without using 
the mouse.

1. With the cursor in the eWebEditPro+XML editor, press the 

application key ( ).
2. A menu appears. 

3. Press the down arrow key ( ) to select Menus. Menus 
becomes highlighted.

4. Press <Enter>. A new menu lists all toolbar menus available to 
you. 
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If your Webmaster has given you access to all standard toolbar 
menus, the menu looks like this.

5. Press the down arrow key ( ) to select the toolbar menu that 
has a button that you want to use. 

6. A new menu appears, listing all options on the selected menu. 
The following menu displays what might appear if you select 
the Edit Menu. (Your Webmaster determines which menu 
options are available).
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7. Press the down arrow key ( ) until the desired option is 
highlighted. Then, click the option to perform the action.

Section 508 Tables
You can apply the following information to any table to make it 508 
compliant.

Information Where applied For more information, see

Heading Rows Accessibility dialog ”Accessibility Dialog” on 
page 521

Heading Columns Accessibility dialog ”Accessibility Dialog” on 
page 521
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WARNING! The Section 508 Table Properties dialog only works if Internet Explorer version 
6.0 or higher is installed. Once that is installed, any browser can be used 
(Netscape, FireFox, IE, etc.).

WARNING! Even if you change no values on the screen, you must open the Accessibility 
dialog whenever you modify a table (for example, add a new row). The table’s 
properties, required for Section 508, are generated when you click OK to close 
the dialog box.

To create a 508 compliant table, follow these steps.

1. Create a new table or edit an existing one, as explained in 
”Introduction to Tables” on page 457.

2. Select the table by moving the cursor to a table border until you 
see a four headed arrow (illustrated below). When a table is 
selected, small squares surround it.

Summary Accessibility dialog ”Accessibility Dialog” on 
page 521

Caption Accessibility dialog ”Accessibility Dialog” on 
page 521

Horizontal Caption 
Alignment

Accessibility dialog ”Accessibility Dialog” on 
page 521

Vertical Caption 
Alignment

Accessibility dialog ”Accessibility Dialog” on 
page 521

Abbreviation Cell properties dialog ”Accessibility Fields on Cell 
Properties Dialog” on page 523

Categories Cell properties dialog ”Accessibility Fields on Cell 
Properties Dialog” on page 523

Information Where applied For more information, see
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3. Click the Tables button ( ). 
4. Click Table Properties.
5. The Table Properties dialog appears.
6. Click the Accessibility button.

NOTE Your system administrator can add or remove the Accessibility button from the 
Insert Table dialog.

7. The Accessibility dialog appears.
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Accessibility Dialog
Respond to the fields in the dialog. They are described below.

Field Description

Heading 
Rows

If you want your table to have a horizontal header, enter 
the number of rows that it should occupy. 
Beginning with the top, all cells in the specified number 
of rows are designated as table headers.

Heading 
Columns

If you want your table to have a header, enter the 
number of columns that it should occupy. 
Beginning with the left column, all cells in the specified 
number of columns are designated as table headers.

Summary If desired, enter the table summary. Non-visual browsers 
can use the summary to explain the contents of the 
table.
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After you complete the Table Properties dialog, click OK to make 
the table comply with Section 508.

Setting Abbreviation and Category Attributes
You can modify abbreviation (ABBR) and category (AXIS) 
attributes within a table. To do so, follow these steps.

1. Select one or more cells.
2. RIght click the mouse.
3. Select Table > Cell Properties.
4. Access the Cell Properties dialog.
The Cell Properties dialog includes fields that let you adjust the 
Abbreviation and Category Attribute field values (see illustration 
below).

NOTE Your system administrator can add or remove the Accessibility fields from the 
Cell Properties dialog.

Caption If desired, enter the table caption. The caption appears 
centered below the table when viewed.

Horizontal 
Caption 
Alignment

If desired, enter the caption’s horizontal alignment:

• center

• left

• right

Vertical 
Caption 
Alignment

If desired, enter the caption’s vertical alignment:

• bottom

• top

Field Description
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The following explains how to respond to these fields.

Accessibility Fields on Cell Properties Dialog
 

Field Description

Abbreviation Sets or retrieves abbreviated text for the content in the 
tag. Can be used to render non-visual media, such as 
speech or Braille.
For more information, see http://msdn.microsoft.com/
library/default.asp?url=/workshop/author/dhtml/
reference/properties/abbr.asp

http://msdn.microsoft.com/library/default.asp?url=/workshop/author/dhtml/reference/properties/abbr.asp
http://msdn.microsoft.com/library/default.asp?url=/workshop/author/dhtml/reference/properties/abbr.asp
http://msdn.microsoft.com/library/default.asp?url=/workshop/author/dhtml/reference/properties/abbr.asp
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Categories Sets or retrieves a comma-delimited list of conceptual 
categories associated with that tag. Can be used to 
render non-visual media, such as speech or Braille.
For more information, see http://msdn.microsoft.com/
workshop/author/dhtml/reference/properties/axis.asp

Field Description

http://msdn.microsoft.com/workshop/author/dhtml/reference/properties/axis.asp
http://msdn.microsoft.com/workshop/author/dhtml/reference/properties/axis.asp
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Inserting Comments within 
Content

While editing Ektron CMS400.NET content, you can insert 
comments to the content. Comments might be an author’s note to 
himself or other authors about the content. For example, you could 
insert a comment explaining why you are using a certain style 
class.

Comments are only visible during editing -- they do not appear 
when the content is published on your Web site.
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Other users can add comments to your comments. This feature is 
know as “Content Collaboration.”

Similar to other word processing programs, comments can be 
added, updated, and tracked to audit changes being made. 

This section explains the content collaboration feature.

WARNING! Do not confuse these comments, which are inserted within the content, with 
history comments, which are inserted outside the content and used to indicate 
what changed during an editing session.

Adding Comments to Content
To add a comment to content, follow these steps.

1. Create new content or edit existing content. See Also: ”Adding 
Content” on page 46

2. In the editor, place the cursor where you want to insert the 
comment.

3. On the editor toolbar, click the Insert Comment button ( ).

4. The Ektron CMS Comment window opens.
5. Insert a comment. Use the toolbar to format the text if desired.
6. Click the Insert button.
7. The comment is saved.
8. Click the Close button.
9. The comment window closes, and a comment icon is placed 

where the comment was added to the content.
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Each comment appears in the table at the top of the window. From 
this window, you can add another comment and update an existing 
one. See the next section for more details.

Viewing a Comment
After a comment is inserted into content, it can be viewed by any 
user who can edit the content. To view a comment, follow these 
steps.

1. Edit the content that contains the comment.
2. Within the content, double-click the comment icon.

3. The Comments window opens.

Adding Another Comment
To comment on an existing comment, follow these steps.

1. Access the View Comment window for the comment, as 
described in ”Viewing a Comment” on page 527.

2. Insert the comment.
3. Click the Insert button.
4. The comment is saved and added to the top row of the 

comment table.
5. Click the Close button.
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Updating a Comment
You can change a comment if needed. To update a comment, 
follow these steps.

1. Access the View Comments window for the comment that 
needs to be updated.

2. Click the Date/Time link of the comment you want to edit.

3. The comment editor opens with the selected comment in it.
4. Update the comment.
5. Click the Update button to save the changes.
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Macintosh Support for Ektron 
CMS400.NET Clients

IMPORTANT! An additional editor license is required when using the Macintosh as a client and 
editing content. For information on adding the license, see the Setup Manual 
section “Macintosh Editor License.”

You can use an Apple Macintosh computer to create and edit 
Ektron CMS400 content. To get the most functionality from Ektron 
CMS400.NET on the Macintosh, use the Safari browser.

When using a Macintosh to edit content, log on to your site as if 
you were using a PC.

1. Open a Safari browser.
2. Navigate to your site’s login page.
3. Click the Login button.
If you have access to the Workarea, the Workarea button appears, 
and you can start editing.

While there are a few limitations when using the Macintosh with 
Safari to edit content, almost all functionality is the same as using a 
PC. The following functionality is different when using a Macintosh:

• creating and editing HTML forms is not supported

• creating and editing XML Forms (aka the Data Designer) is not 
supported

• working with Document Management content is not available

See Also: ”Using the Integrated Macintosh Editor” on page 529

Using the Integrated Macintosh Editor
The Integrated Macintosh Editor (IME) plays the same role on a 
Macintosh that eWebEditPro plays on a PC, that of a content 
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editor. While both editors have similar functionality, some functions 
are accessed differently with the IME.

Ektron CMS400.NET clients only support the IME when used on 
an Apple Macintosh running the Safari browser.

If you use another browser, such as Internet Explorer, Firefox, or 
Netscape Navigator, a plain text box appears where the editor 
should be and you can add content as plain text or html code.

Below is an image of the Integrated Macintosh Editor in the Ektron 
CMS400.NET Workarea.

Menu Items and Toolbar Buttons
This section explains how to use the menu Items and toolbar 
buttons in the Integrated Macintosh Editor (IME). The menus are 
located above the rows of toolbars button across the top of the 
editor window, illustrated below.
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The toolbar is the row of buttons across the top of the editor 
window, illustrated below. 

The menu items and toolbar buttons allow you perform functions 
such as cutting and pasting text, inserting images, and creating 
tables.

Table of Menu Items, Toolbar Buttons and Drop-Down Lists

The following table explains each menu item, toolbar button and 
drop-down list.

Command Access to Command Description

Spelling
Button: 
Menu: Tools > Spelling...
Keystroke: F7

Begin spell checker.

Automatic Spell 
Check Button: 

Menu: Tools > Disable Check Spelling 
As You Type
Keystroke: None

Turn on or off spell check as-you-type 
feature.

Accessibility 
Report...

Button: None
Menu: Tools > Accessibility Report...
Keystroke: F8

Provides an report on how accessible 
your page is, according to Section 508, 
WCAG Priority 1 and WCAG Priority 2
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Word Count Button: None
Menu: Tools > Word Count...
Keystroke: None

Details the amount of words used in the 
editor.

Find
Button: 
Menu: Edit > Find...
Keystroke: Control F

Launches a dialog box that allows you to 
Find, Find Next or Replace an 
occurrence of the string entered into Find 
field.

Cut
Button: 
Menu: Edit > Cut
Keystroke: Control X

Remove selected text and graphics. 
Place that data into temporary memory.
(If you later cut or copy more information 
onto the clipboard, the new information 
overwrites the original information.)

Copy
Button: 
Menu: Edit > Copy
Keystroke: Control C

Copy selected text and graphics into 
temporary memory. Leave selected data 
where it is.
(If you later cut or copy more information 
into memory, the original information is 
lost.)

Paste
Button: 
Menu: Edit > Paste
Keystroke: Control V

Insert the most recently cut or copied text 
and graphics at the current cursor 
location.

Paste Special Button: None
Menu: Edit > Paste
Keystroke: None

Paste text in a different format. For 
example, you can copy text from a 
browser and paste it as Rich Text instead 
of Hypertext.

Select Button: None
Menu: Edit > Select
Keystroke: None

Similar to the Document Navigator, this 
function lets you highlight a section of 
text, a table or section of a table. The 
menu is dynamic and the selections can 
change depending on the location of the 
cursor. For example, if the cursor is in a 
table, the menu has the following entries: 
html, body, table, tr, td and content.

Command Access to Command Description
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Select All Button: None
Menu: Edit > Select All
Keystroke: Control A

Selects everything in the editor.

Undo
Button: 
Menu: Edit > Undo
Keystroke: Control Z

Reverse the most recent action, as if it 
never occurred. You can undo up to 50 
actions.

Redo
Button: 
Menu: Edit > Redo
Keystroke: Control Y

Reverse the undo action. You can redo 
as many actions as you have undone.

Insert Hyperlink
Button: 
Menu: Insert > Insert Hyperlink...
Keystroke: Control K

Launches the Insert Hyperlink dialog box. 
Adds hyperlink to text in the editor.

Bookmark Button: None
Menu: Insert > Bookmark...
Keystroke: None

Launches the Insert Bookmark dialog 
box. Adds a bookmark to the content.

Remove Hyperlink Button: None
Menu: Insert > Remove Hyperlink...
Keystroke: None

Removes the hyperlink from text in the 
editor

Files, Images, 
Hyperlinks Button: 

Menu: Insert > Files, Images, Hyperlinks
Keystroke: None

Launches the Library dialog box which 
allows you to add library items to the 
content.

Insert Symbol
Button: 
Menu: Insert > Insert Symbol...
Keystroke: None

Launches a special characters and 
symbols dialog box. Choose a character 
or symbol and click Insert.

Insert Horizontal 
Rule Button: 

Menu: Insert > Insert Horizontal Rule
Keystroke: None

Inserts a Horizontal line below the line 
where the cursor is located.

Command Access to Command Description



Macintosh Support for Ektron CMS400.NET Clients

Ektron CMS400.NET User Manual,  Release 5.1 Revision 5 534

Insert Table
Button: 
Menu: Insert > Insert Table...
Menu: Table > Insert Table...
Keystroke: None

Insert a table. When using the Table 

button ( ), a table appears below the 
button and allows you to choose how 
many columns and rows you want. When 
using a menu to insert a table, the insert 
table dialog box appears.

Add Row or 
Columns Button: rows =  column = 

Menu: Table > Insert Row or Column...
Keystroke: None

Add a row or column to an existing table.

Insert Cell Button: None
Menu: Table > Insert Cell
Keystroke: None

Inserts a cell where the cursor is located 
in a table. Cells in that row to the right of 
the new cell are shifted to the right.

Delete Row
Button: 
Menu: Table > Delete Row
Keystroke: None

Deletes the row where the cursor is 
located.

Delete Column
Button: 
Menu: Table > Delete Column
Keystroke: None

Deletes the column where the cursor is 
located.

Delete Cell Button: None
Menu: Table > Delete Cell
Keystroke: None

Deletes a cell where the cursor is located 
in a table and shifts the remaining cells in 
that row to the left. If multiple cells are 
selected, they are deleted and the 
remaining cells are shifted to the left.

Split Cell
Button: 
Menu: Table > Split Cell
Keystroke: None

Launches a dialog box that allows you to 
split a cell into multiple columns or rows. 
This only adds columns or rows to that 
cell, not the whole table.

Merge Cell
Button: 
Menu: Table > Merge Cell
Keystroke: None

Choose multiple adjoining cells and 
merge them into one cell.

Command Access to Command Description
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Cell Properties Button: None
Menu: Table > Cell Properties...
Keystroke: None

Launches a dialog box that provides 
information about the cell properties. In 
this dialog box you can further define an 
individual cell.

Row Properties Button: None
Menu: Table > Row Properties...
Keystroke: None

Launches a dialog box that provides 
information about the row in which the 
cursor is located. In this dialog box you 
can further define the row.

Column Properties Button: None
Menu: Table > Column Properties...
Keystroke: None

Launches a dialog box that provides 
information about the column in which 
the cursor is located. In this dialog box 
you can further define the column.

Table Properties Button: None
Menu: Table > Table Properties...
Keystroke: None

Launches a dialog box that provides 
information about the table in which the 
cursor is located. In this dialog box you 
can further define the table.

Show/Hide Grid 
Lines Button: 

Menu: Table > Hide Grid lines
Keystroke: None

Shows or hides the grid lines that make 
up a table.

Design View
Button: 
Menu: View > Design View
Keystroke: None

Switches editor from HTML code view to 
design view.

Code View
Button: 
Menu: View > HTML View
Keystroke: None

Switches editor from design view to 
HTML code view.

Window View
Button: 
Menu: View > Window View
Keystroke: None

Launches the current editor into its own 
window.

Command Access to Command Description
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Document Navigator Button: None
Menu: View > Document Navigator
Keystroke: None 

Similar to Select, this function adds a 
clickable menu bar to the editor when in 
design mode. This lets you to highlight a 
section of text, a table or section of a 
table. The menu is dynamic and the 
selections can change depending on the 
location of the cursor. For example, if the 
cursor is in a table, the menu has the 
following entries: html, body, table, tr, td 
and content.

Show Paragraph 
Markers Button: 

Menu: View Show > Paragraph Markers
Keystroke: None

Shows or hides paragraph markers and 
other special markings related to 
formatting, such as formatting for 
bulleted items.

Style Dropdown List
Button: 

Menu: Format > Style
Keystroke: None

Choose from a predefined list of styles to 
apply to your text.

Font Button: None
Menu: Format > Font
Keystroke: None

Choose from a predefined list of fonts.

Size Button: None
Menu: Format > Size
Keystroke: None

Choose from a predefined list of sizes for 
your font.

 Bold
Button: 
Menu: Format > Bold
Keystroke: Control B

Make the text bold.

Command Access to Command Description
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Italics
Button: 
Menu: Format > Italic
Keystroke: Control I

Make the text italic.

Underline
Button: 
Menu: Format > Underline
Keystroke: Control U

Make the text underlined.

Align Left
Button: 
Menu: Format > Align Left
Keystroke: Control L

Aligns the text to the left of the page. For 
example:
This text is aligned left.

Align Center
Button: 
Menu: Format > Align Center
Keystroke: Control E

Aligns the text to the center of the page. 
For example:

This text is aligned center.

Align Right
Button: 
Menu: Format > Align Right
Keystroke: Control R

Aligns the text to the right of the page or 
table cell. For example:

This text is aligned right.

Unordered List
Button: 
Menu: Format > Unordered List
Keystroke: None

Begin the line on which the cursor rests 
(or all selected lines) with a bullet.

Ordered List
Button: 
Menu: Format > Ordered List
Keystroke: None

Begin the line on which the cursor rests 
with a number. If the line above this line 
is

• not numbered, assign this line 1

• numbered, assign a number one 
more than the line above

Decrease Indent
Button: 
Menu: Format > Decrease Indent
Keystroke: None

Decrease the current line’s indent 
distance from the left margin.

Command Access to Command Description
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Increase Indent
Button: 
Menu: Format > Increase Indent
Keystroke: None

Increase the current line’s indent 
distance from the left margin.

List Properties Button: None
Menu: Format > List Properties...
Keystroke: None

Launches a dialog box that allows you to 
view and edit the properties of an 
ordered or unordered list.

Highlight Color
Button: 
Menu: Format > Highlight Color
Keystroke: None

Adds a color Highlight to text.

Color
Button: 
Menu: Format > Color
Keystroke: None

Choose the color of the text.

Superscript Button: None
Menu: Format > Superscript
Keystroke: None

Make text appear in Superscript

Subscript Button: None
Menu: Format > Subscript
Keystroke: None

Make text appear in Subscript

Strikethrough Button: None
Menu: Format > Strikethrough
Keystroke: None

Make text appear with a Strikethrough.

Remove Formatting Button: None
Menu: Format > Strikethrough
Keystroke: Control Space

Removes the formatting of text and 
returns it to the default color and style.

Command Access to Command Description
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 Format Painter
Button: 
Menu: Format > Format Painter

Keystroke: Control  C

Paint the formatting of selected text to a 
new piece of text. 
Highlight the text that has the formatting 
you want to copy. Next, click the Format 
Painter button. Then, click the text where 
the formatting is to be applied.

Command Access to Command Description
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Appendix A: Content Statuses

The table below describes all possible content statuses. The rest 
of this appendix explains each status in more detail.

Letter Border 
Color

Meaning Content state More Information

A green Approved Through the workflow and 
published on the Web site.

”Active Content” on 
page 541

O red Checked Out Currently being edited. Has 
not been checked in.

”Checked Out 
Content” on 
page 544

I green Checked In Checked in for other users 
to edit.

”Checked-In 
Content” on 
page 542

S yellow Submitted for 
Approval

Saved and submitted into 
the approval chain.

See Also: ”Approving/
Declining Content” on 
page 85

”Submitted Content” 
on page 544

M yellow Marked for Deletion Requested for deletion. ”Marked for Deletion 
Content” on 
page 546

P grey Pending Go Live 
Date

Approved but the Go Live 
date hasn’t occurred yet.

”Pending Start Date 
Content” on 
page 546

T Awaiting Completion 
of Associated Tasks

Task(s) assigned to content 
are not complete
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Active Content
If content has a green border, it is live on the Web site.

When content is active, you can perform the following actions on it, 
depending on your permissions.

The content’s status remains active until it is checked out and 
changes are made to it.

D Pending Deletion Content was created with a 
future start date then 
checked in and deleted.
This status only remains 
until the start date is 
reached. At that point, the 
content is deleted.

Letter Border 
Color

Meaning Content state More Information

Button Name Description For more information, 
see

Edit Check-out the content to 
change it.

”Editing Content” on 
page 49

Edit Summary Edit the brief summary used to 
describe the content.

”Adding a Content 
Summary” on page 73

Edit Metadata Change the content’s metadata. ”Adding or Editing 
Metadata” on page 77
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Checked-In Content
If content has a green border, it could mean that the content is 
checked in. A checked-in content item is one to which changes 
were made, after which it was checked in instead of being 
submitted or published. When content is checked in, it is 
accessible to all users who have permissions to edit it. They can 
check it out and change it.

Keep in mind that the content seen on the template is not the same 
as the content in the editor view.

See Also: ”Example of an Approval Chain” on page 89

Each option you may perform on checked-in content is described 
below.

Delete Submit a request to delete the 
content. If you are the last or 
only approver, the content is 
immediately deleted.

See Also: ”Example of an 
Approval Chain” on page 89

”Adding Content” on 
page 46

Back Go to previous window.

Button Name Description For more information, 
see
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Button Name Description For more information, see

Edit Check-out the content to 
change it.

”Editing Content” on page 49

Edit Summary Edit its summary. ”Adding a Content Summary” 
on page 73

Edit Metadata Edit its metadata. ”Adding or Editing Metadata” on 
page 77

Submit/Publish Submit content into approval 
chain.
If you are last approver in the 
approval chain, the publish 
button appears. If you click it, 
the content is immediately 
posted to Web site.

View Staged/
Published

 View Staged button - displays 
content that hasn’t been 
published yet.
View Published button - 
displays content live on the Web 
site.

”Staged Content” on page 547

Delete Submit a request to delete the 
content into approval chain. If 
you are the last or only 
approver, the content is 
immediately deleted.

”Example of an Approval Chain” 
on page 89

Back Go to previous window.
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Checked Out Content
If content has a red border, it was checked out by a user other than 
you. (If you checked it out, the border is green.) While in this 
status, other users are prevented from editing the content.

The content remains checked out until it is checked in by the user 
who checked it out or your system administrator.

Each option you may perform on checked-out content is described 
below.

Submitted Content
A yellow border shows that a user has submitted the content into 
the approval chain. The border remains yellow until the content is 
published or declined. While the content is in the approval chain, 
no user can check it out.

Button Name Description

Check In Check in content.

View Staged/
Published

Click the View Staged button to view the content that has not 
yet been published. 
Click the View Published button to view the content that is live 
on the Web site.

See Also: ”Staged Content” on page 547

Back Go to previous window.
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See Also: ”Example of an Approval Chain” on page 89

Each toolbar button is described below.

Button Name Description

Submit Submit the content into the approval chain.

See Also: ”Example of an Approval Chain” on page 89

Publish Approve and publish the content to the Web site.

Note: You have this option only if you are the last approver in the 
chain.

See Also: ”Example of an Approval Chain” on page 89

Decline Refuse to publish the submitted content, and change its status 
to checked-in.

Edit Check out the content and make changes to it.

Note: If you edit the content, you need to re-submit it to the 
approval chain.

View Staged/
Published

Click the View Staged button to view the content that has not 
yet been published.
Click the View Published to view the content that is live on the 
Web site.

See Also: ”Staged Content” on page 547
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Marked for Deletion Content
Content that is marked for deletion has been requested to be 
removed from the Web site by a user. When content is marked for 
deletion, it goes through the approval chain like content that is 
submitted for publishing. When the content completes the approval 
chain, it is deleted from the Web site.

See Also: ”Example of an Approval Chain” on page 89

The table below describes the toolbar buttons.

Pending Start Date Content
Content that is pending a Go Live date has been approved, but its 
scheduled “go live” date and time have not occurred yet.

You cannot perform any action on content with a pending start 
date.

Back Go to previous window.

Button Name Description

Button Name Description

Delete Approve the deletion request.

Note: If you are the last user in the approval chain, the content is 
deleted when you click this.

Decline Refuse the deletion request. This sends the content back into a 
checked-in status.

Back Go to previous window.
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Staged Content
A staged version of content is one that is not published. It can be 
content that is checked in, or content that is approved with a 
pending a start date.

Staging lets you make changes to content, while keeping it from 
the Web site until you are ready to publish it.
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Index

508 compliance 515

A
about eWebEditPro box 381
absolute positioning of objects 382
add

button
calendar event 34
library items 34
task 34
workarea toolbar 34

content
block button 34
folder button 34
screen

buttons 47
responding to fields 47
tabs 48

content block 46
address, email, user, editing 360
AddSubMenu 289
alignment

cell 493
image 419
table 474
text 381

Apple, see macintosh
approval chain, example 89
approvals toolbar button 34
approve

all, toolbar button 34
button

floating toolbar 4
workarea toolbar 34

one content block 86
several content blocks 88

approving content 85
from approval report 118

approving file
document management 

system 252
archived content, toolbar button 34
archiving

definition 70
options 70
restoring archived content 71

assign task button, floating toolbar 4
auto hide, feature of Smart Desktop 27

B
background color

applying to text 380
cell

applying 487
deleting 488

removing from text 380
table

applying 476
deleting 477

background image
cell

deleting 490
inserting 489

table
deleting 478
inserting 477

bidirectional editing 383
blur, WebImageFX command 431
bold, toolbar option 380
bookmarks 501
border

image
color 418
thickness 418

border color
cell 486
content block, meaning 540
table 479

border size
cell 483
table 481

brightness, WebImageFX command 432
broken links, finding 53
bullet, toolbar option 380
button text, displaying in title bar 361
buttons

adding to menu 386
rearranging on menu 388
removing from menu 386

C
calendars

add event button 34
authorization for creating 314
button to display in Workarea 36
definition 312
event types 327
events

adding 324
assigning event types 327
button for viewing 36
deleting 333
display times 326
editing 331

end time 326
insert hyperlink 327
location 326
recurring, adding 328
start date 326, 329
start time 326
viewing 329

screen, information on 316
viewing 320

cells
background color 487
background image

deleting 490
inserting 489

border
color 486
invisible 486

deleting 485
inserting 484
merging 497
padding 499
spacing 499
splitting 496
text alignment 493
width 483

check in, toolbar button 35
check out, toolbar button 35
checked in content

definition 542
report 120

checked out content
definition 544
report 120

choose color, WebImageFX 
command 433

choose font, WebImageFX 
command 434

cleaning HTML 513
collaboration, content 525
collections

adding content 264
changing sequence of links 36
compared with menu and List 

Summary 272
creating 260
creating new content block for 266
default template 262
definition 254
deleting 270
editing content blocks 267
finding 255
folder, using to find collection 257
information, editing 269
multi-language 270
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removing content 268
reordering content blocks 268
toolbar button 35
toolbar buttons 260
using default template or 

quicklinks 262
viewing 258

color
background

cell
applying 487
deleting 488

table
applying 476
deleting 477

cell border 486
default 466

content block border, 
meaning 540

depth, specifying 456
font, changing 380
picture border 418
table border 479

default 464
columns

table
adding 469
deleting 469
spanning 491
specifying 468

comments
adding another 527
adding to a task 353
inserting into content 525
updating 528
viewing 527

Compare source code field, eWebDiff 99
Compare visual aspect field, 

eWebDiff 98
comparing content 95

content area explained 100
Diff tab 100
how status affects comparison 96
published tab 100
setup window 98
staged tab 101
toolbar 97
view tabs 100
when available 95
window explanation 96

content
see also content block
active, definition 541
adding as menu option 286
adding to collection 264
approval process 89
archived, toolbar button 34

archiving see archiving
awaiting approval 21
checked in, definition 542
checked out, definition 544
collaboration 525
comparing, see comparing con-

tent
currently checked out 21
declining, see declining content
difference

view, button, floating toolbar 5
viewing 95

editing, toolbar button 35
end date, setting 69
folder

add button 34
screen display 32
View History, Restore 105

history
accessing from Web page 49, 103
accessing via Workarea 49, 103

marked for deletion, definition 546
metadata, see searchable proper-

ties
pending start date 546
previous version, viewing 102
publish see publish
reports

checked in content 120
checked out content 120
content pending start date 123
content to expire 125
expired content 125
new content 121
refresh reminder 124
submitted content 122

restoring previous version 102
scheduling 66
searching for within site 54
start date, setting 66
statuses 540

approved 540
submitted, definition 544
summary see summary
to expire report 125
workflow reports see reports

content area, expanding 44
content block

see also content
add button 34
adding 46
creating 46
definition 1
deleting 51

several at once 35
editing 49

overview 6

finding 6
lifecycle 7
properties 43
translating 50
viewing 40

contrast, WebImageFX command 436
copy

information from other 
applications 397

toolbar and menu option 376
WebImageFX command 437

copyright character, inserting 378
create new, WebImageFX 

command 437
creating

document, document manage-
ment feature 241

Office document, document man-
agement functionality 229

crop, WebImageFX command 437
customizing toolbar 385
cut, toolbar and menu option 376

D
decline

content
from approval report 118
from publishing 88

one content block 86
several content blocks 88

delete
button, floating toolbar 5
content, toolbar button 35
folder, toolbar button 35
toolbar button 35
WebImageFX command 438

deleting
cell 485
folders 65
table 459

Detect All field, eWebDiff 99
difference

content
view, toolbar button 5

dimensions, WebImageFX 
command 438

Do not apply XSLT button 35
document

creating, document management 
functionality 241

importing into DMS 234
importing several into AMS 236
Office, creating, document man-

agement feature 229
document management feature

adding documents to 
collections 252
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adding documents to menus 252
checking in document 233
deleting document 252
document types 226
drag and drop files 247
exit without saving changes 234
file types 226
importing document 234
importing several documents 236
installing on client 16
introduction 225
managed files 227, 241
Office document properties, 

editing 232
Office document, editing 239
Office documents 227
overview 225
reports 252
reports of document by status 252
saving recent changes 234
saving to local computer 234
security 228
submitting for publication 234
viewing documents in CMS 251
work offline 234, 239
work offline option 239
workflow 250

document management functionality
creating managed file 241
creating Office document 229

document management system
approving file 252

documentation, online, accessing 363
drag and drop files using Ektron 

Explorer 223
drag and drop files, document manage-

ment feature 247

E
edit button, floating toolbar 5
editing

content block, overview 6
content, toolbar button 35
HTML 512

email
address, user, editing 360
instant

modifying 30
requirements 29
sending 28
where available 30

notification, disabling 360
emailing workflow reports 115
end date, setting for content 69
end time, calendar event 326
eWebDiff window 98

exit without save, WebImageFX 
command 440

exit, WebImageFX command 439
Explorer, Ektron

changing thumbnail size 220
displaying 218
inserting external files 223
installing 214
introduction 212
search feature 221

extensions
file, allowed in library 192
image, allowed in library 192

F
files

copying to library 195
extensions, library, setting 192
library

inserting into content 204
overwriting 201
viewing 198

library, editing title 200
finding

content block 6
text 398

floating toolbar 4
folders

button for deleting 35
delete 65
information available when 

viewing 38
fonts

background color 380
color 380
heading size 379
size 380
style 379

form elements toolbar 384
forms

adding to content 210
HTML

accessing folder 139
assigning task 170
creating 141
creating content block 144
database 185
deleting 185
editing

content block 184
introduction 183
summary 184

field validation options 155
implementing on Web page 170
inserting fields 147

calendar field 168
checkbox 151

choices 161
hidden text 152
password 157
select list 165
text 153
text area 159

introduction 135
mailto 185
processing overview 137
reports, exporting 177
reports, viewing 173
structure of data 137
toolbar 185
toolbar options 145
validation 150
viewing 177

properties 177
viewing 210

freehand, WebImageFX command 440

G
gray, content border color, meaning 540
green, content border color, 

meaning 540

H
height, work page, customizing for 

user 361
help, online, accessing 363
history

button, view, floating toolbar 5
content

accessing from Web page 49, 103
accessing via Workarea 49, 103
viewing 37
window 104

horizontal flip, WebImageFX 
command 441

horizontal line, inserting 382
HTML

cleaning 513
editing 512
inserting 512
viewing 511

hyperlinks 505
adding as menu option 288
creating 505
definition 188
editing 510
entering manually 507
library

adding 208
adding to content 208
editing 208
viewing 208

preventing 510
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removing 510
testing 508
to a bookmark in another web 

page 509
to content block, finding 36
using a Quicklink 506

I
icon menu 4
Ignore All field, eWebDiff 99
Ignore Case field, eWebDiff 99
Ignore Format Attributes field, 

eWebDiff 99
image extensions, library, setting 192
image info, WebImageFX command 441
image upload

from Microsoft Word 
document 408

inserting picture from 
computer 413

media file selection 411
images

adding space around 421
aligning 419
background

cell, inserting 489
table, inserting 477

border
color 418
thickness 418

deleting 423
deleting from server 413
editing 425
inserting 410

from server into editor 412
inserting from your computer 413
library

adding to content 209
editing titles 209
overwriting 209
uploading 208
viewing 209

locking in position 382
moving to server 423
scanning 453
specifying color depth 456

indent, toolbar option 381
insert library item, toolbar button 35
insert table, toolbar button 461
inserting

cells 484
HTML 512

instant email, see email, instant
Internet addresses, spell checking 405
italic, toolbar option 380

J
jumps, see bookmarks and hyperlinks
justify, toolbar option 381

L
landing page after login, customizing for 

user 361
language, user, editing 360
library

accessing 189
add items button 34
asset, adding as menu item 287
copying files to 195
definition 188
file extensions 192
files

editing 200
inserting into content 204
overwriting 201
viewing 198

folder properties 191
forms

adding to content 210
viewing 210

hyperlinks
adding 208
adding to content 208
editing 208
viewing 208

images
adding to content 209
editing titles 209
extensions 192
overwriting 209
uploading 208
viewing 209

quicklinks
adding to content 210
viewing 210

search results
include images 62, 195
text only 62, 195

searching 192
license keys, viewing 381
lifecycle, content block 7
line, WebImageFX command 442
link check button 36
links, broken, finding 53
ListSummary, compared with collection 

and menu 272
lock table or image in position 382
log in 9
log out 11

button, floating toolbar 5

M
Macintosh support 529

menu items 531
toolbar buttons 531
using editor 529

managed files 241
creating 241
document management 

feature 227
editing 245
importing one 241
importing several 243

manuals, online, accessing 363
marked for deletion content 546
menus

accessing 276
add new content block via naviga-

tion link 290
adding new

via content folder 278
via Menus module 282

adding to toolbar 386
appearance

to content contributor 274
to site visitor 274

changing orientation 391
compared with collection and List 

Summary 272
creating 389

in any language 311
definition 274
deleting 307
editing 291

via content folder 291
via menus module 291
via navigation link 292

icons 4
items

adding content block as 286
adding external hyperlink as 288
adding library asset as 287
adding submenu 288
adding to submenu 289
adding via content folder 283
adding via modules folder 284
adding via navigation link on Web 

page 285
definition 275
deleting

via content folder 308
via menus module 309

editing
content block 296
external hyperlink 300
library asset 300
submenu items 301
via content folder 293
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via menus module 294
via navigation link 295

rearranging 306
moving from toolbar 391
multi-language issues 309
rearranging on toolbar 389
removing from toolbar 386
structure 275
submenu, definition 276
template link field 282
translating 309
URL link field 281
viewing

via content folder 301
via menus module 305
via navigation link 305

merging cells 497
metadata

definition 77
Microsoft Word

editing in 407
editing XML documents 409
uploading image from 408

multi-language menus 309

N
number, toolbar option 380
numbers in words, spell checking 405

O
objects, absolute positioning 382
Office 2000, inserting content from 514
Office documents

creating 229
editing properties 232
importing one 234
importing several 236

Office documents,document manage-
ment feature 227

open, WebImageFX command 443
oval, WebImageFX command 444
overwrite button 36

P
padding, cell 499
password, changing 360
paste

toolbar and menu option 376
paste as new image, WebImageFX 

command 445
paste text

toolbar and menu option 376
pending start date content 546
pictures

inserting see image upload

properties, image upload 411
pixels 417
pointer selection, WebImageFX 

command 445
polygon, WebImageFX command 446
position objects menu 382
prerequisites 9
preview

button 36
floating toolbar 5

feature 11
print editor content 382
profile

users
updating 358
viewing 358

properties
button, floating toolbar 5
content block 43

publish
button 36
content to web site 87

published
content block, viewing 37

Q
quicklinks 506

adding to content 210
broken, finding 53
definition 189
using for a collection 262
viewing 210

R
rectangle, WebImageFX command 447
red, content border color, meaning 540
redisplay toolbars 389
redo, WebImageFX command 447
registered trademark character, 

inserting 379
remove button 36
remove XSLT from XML content 

block 105
reorder button 36
replacing text 398
reports

content
approving content from report 118
awaiting approval 118
checked in content 120
checked out content 120
content to expire 125
declining content from report 118
editing content blocks 115
expired content 125
new 121

pending start date 123
refresh reminder 124
sorting and filtering 113
submitted 122
viewing content blocks 115
workflow 108

emailing 115
selecting content by folder 112

folder, accessing 108
site update activity 127

restore, toolbar button 36
restoring content 105
right to left editing 383
rotate, WebImageFX command 448
rows

table
adding 469
deleting 469
spanning 491
specifying 468

S
save

toolbar button 36
WebImageFX command 449

save as, WebImageFX command 450
scanning an image 453
scheduling content 66
search 398

considering case of search 
term 400

content folder 54
direction 399
library 192
toolbar button 36
whole word match 401

search for content using Ektron 
Explorer 221

search phrase report 132
search screen 55

noise files 57
specifying

kind of content to search 56
match criteria 58
word or phrase 57

searchable properties
creating 82
editing 82

section 508
compliance 515
tables 518

select all, menu option 394
select, WebImageFX command 451
selecting text 374
server, moving picture to 423
sharpen, WebImageFX command 451
shortcuts, keyboard 375
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show calendar, toolbar button 36
Site Update Activity Report 127
Smart Desktop

definition 20
hiding left panel 25
modifying folder display 23
navigating 22
set as start location for user 362

Smart Detect field, eWebDiff 99
space character, inserting 378
spacing, cell 499
spanning

table columns 491
table rows 491

special characters, inserting 379
spelling

check a single word 405
check as you type 402
check on demand 403
check selected text 405
checking file addresses 405
checking Internet addresses 405
checking uppercase words 405
checking words with numbers 405
fix errors 403

splitting a cell 496
staged content block, viewing 37
stale content report 127
start date

content block, setting 66
setting, results 68

start time, event calendar 326
style class, assigning to text 379
submenus

adding as menu item 288
adding items 289
definition 276
deleting 307

submit, toolbar button 36
submitted content, definition 544
summary

adding 73
content

creating for existing content 
block 75

creating for new content block 74
editing 75

T
tables

alignment 474
background color

applying 476
deleting 477

background image
deleting 478
inserting 477

border
color 479
invisible 480
size 481

columns
adding 469
deleting 469
spanning 491
specifying 468

creating 458
deleting 459
inserting within a table 460
locking in position 382
rows

adding 469
deleting 469
spanning 491
specifying 468

section 508 518
width

setting by percentage 471
setting by pixels 473

tasks
add button 34
assign button, floating toolbar 4
assigning

to content block 338
to HTML form 170
to user 338

comments
adding 353
updating 354

creating
via content block 346
via task folder 337

definition 335
deleting 355
due date 340
editing 352
priority, assigning 338
relationship to content blocks 335
start date 339
state, assigning 339
toolbar buttons 357
viewing 347

options 348
sorting options 351

template link
field on Add/Edit Menu screen 282

text
aligning 381

in columns 460
within a cell 493

direction menu 383
indenting 381
remove formatting 380
replacing 398

searching 398
selecting 374
WebImageFX command 452

title bar, displaying button text 361
toolbars

buttons 34, 375
collections 260

customizing 385
floating 4

buttons 4
redisplay 389
restore 389

trademark character, inserting 379
twain acquire, WebImageFX 

command 453
twain source, WebImageFX 

command 454

U
underline, toolbar option 382
undo

toolbar option 376
WebImageFX command 454

uppercase words, spell checking 405
URL link

field on Add/Edit Menu screen 281
user

email address, editing 360
language, editing 360

users
profile

customizing work page height 361
customizing work page size 360
customizing work page width 361
landing page after login 361
see profile
set Smart Desktop as start 

location 362

V
validation

HTML form 150
version number, viewing 381
vertical flip, WebImageFX command 455
View Content Awaiting Approval 118
view content difference 95

button, floating toolbar 5
screen, first use 101

view date, toolbar button 36
view difference, toolbar button 37
view history

button, floating toolbar 5
toolbar button 37

view published, toolbar button 37
view staged, toolbar button 37
viewing HTML 511
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W
WebImageFX

assigning new name to image 427
choosing image 425
commands

blur 431
brightness 432
choose color 433
choose font 434
contrast 436
copy 437
create new 437
crop 437
delete 438
dimensions 438
exit 439
exit without save 440
freehand 440
horizontal flip 441
image info 441
line 442
open 443
oval 444
paste as new image 445
pointer selection 445
polygon 446
rectangle 447
redo 447
rotate 448
save 449
save as 450
select 451
sharpen 451
text 452
twain acquire 453
twain source 454
undo 454
vertical flip 455
zoom in 455
zoom out 456

introduction 425
menu commands 427
saving image 427
specifying color depth 456
toolbar buttons 427

whole word match 401
width, table

setting by percentage 471
setting by pixels 473

width, work page, customizing for 
user 361

word wrap 498
Word, Microsoft

editing in 407
editing XML documents 409
inserting from 514
uploading image from 408

work offline option 239
work offline, document management 

feature 234, 239
work page size, customizing for user 360
workarea

accessing 15
button, floating toolbar 5
definition 15
toolbar buttons 34

add 34
add calendar event 34
add content block 34
add content folder 34
add library items 34
add task 34
approvals 34
approve 34
approve all 34
archived content 34
calendar 35
check in 35
check out 35
collections 35

delete 35
delete content 35
delete folder 35
do not apply XSLT 35
edit 35
insert library item 35
link check 36
overwrite 36
preview 36
publish 36
remove 36
reorder 36
restore 36
save 36
search 36
show calendar 36
submit 36
view date 36
view difference 37
view history 37
view published 37
view staged 37

WYSIWYG, view as 378

X
XSLT, removing from XML content 

block 105

Y
yellow, content border color, 

meaning 540

Z
zoom in, WebImageFX command 455
zoom out, WebImageFX command 456
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